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CERTIFIED ELECTRICAL CONTRACTOR STATEMENT

All electrical installations that are preliminary to positioning of the equipment at the site prepared for the equipment 
shall be performed by licensed electrical contractors. In addition, electrical feeds into the Power Distribution Unit 
shall be performed by licensed electrical contractors. Other connections between pieces of electrical equipment, 
calibration and testing shall be performed by qualified Medical personnel. The products involved (and the 
accompanying electrical installations) are highly sophisticated, and special engineering competence is required. In 
performing all electrical work on these products, GE will use its own specially trained field engineer. All of Vendor’s 
electrical work on these products will comply with the requirements of the applicable electrical codes.

The purchase of equipment shall only utilize qualified personnel (i.e., Vendor’s field engineers, personnel of 
third-party service companies with equivalent training, or licensed electricians) to perform electrical servicing on the 
equipment.

DAMAGE IN TRANSPORTATION

All packages should be closely examined at time of delivery. If damage is apparent write “Damage in Shipment” on 
ALL copies of the freight or express bill BEFORE delivery is accepted or “signed for” by a Vendor’s representative 
or hospital receiving agent. Whether noted or concealed, damage MUST be reported to the carrier immediately upon 
discovery, or in any event, within 14 days after receipt, and the contents and containers held for inspection by the 
carrier. A transportation company will not pay a claim for damage if an inspection is not requested within this 14 day 
period.

Call Vendor’s representative immediately after damage is found. At this time be ready to supply name of carrier, 
delivery date, consignee name, freight or express bill number, item damaged and extend of damage.



THIS SERVICE MANUAL IS AVAILABLE IN ENGLISH ONLY IF A CUSTOMER´S 
SERVICE PROVIDER REQUIRES A LANGUAGE OTHER THAN ENGLISH. IT IS 
THE CUSTOMER´S RESPONSIBILITY TO PROVIDE TRANSLATION SERVICES.
DO NOT ATTEMPT TO SERVICE THE EQUIPMENT UNLESS THIS SERVICE 
MANUAL HAS BEEN CONSULTED AND IS UNDERSTOOD.
FAILURE TO HEED THIS WARNING MAY RESULT IN INJURY TO THE SERVICE 
PROVIDER, OPERATOR OR PATIENT FROM ELECTRIC SHOCK, MECHANICAL 
OR OTHER HAZARDS.

CE MANUEL DE MAINTENANCE N´EST DISPONIBLE QU´EN ANGLAIS.
SI LE TECHNICIEN DU CLIENT A BESOIN DE CE MANUEL DANS UNE AUTRE 
LANGUE QUE L´ANGLAIS, C´EST AU CLIENT QU´IL INCOMBE DE LE FAIRE 
TRADUIRE.
NE PAS TENTER D´INTERVENTION SUR LES EQUIPEMENTS TANT QUE LE 
MANUEL SERVICE N´A PAS ETE CONSULTE ET COMPRIS.
LE NON-RESPECT DE CET AVERTISSEMENT PEUT ENTRAÎNER CHEZ LE 
TECHNICIEN, L´OPERATEUR OU LE PATIENT DES BLESSURES DUES A DES 
DANGERS ELECTRIQUES, MECANIQUES OU AUTRES.

WARNING

AVERTISSEMENT
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DIESES KUNDENDIENST-HANDBUCH EXISTIERT NUR IN ENGLISCHER 
SPRACHE.
FALLS EIN FREMDER KUNDENDIENST EINE ANDERE SPRACHE BENÖTIGT, 
IST ES AUFGABE DES KUNDEN FÜR EINE ENTSPRECHENDE ÜBERSETZUNG 
ZU SORGEN.
VERSUCHEN SIE NICHT, DAS GERÄT ZU REPARIEREN, BEVOR DIESES 
KUNDENDIENST-HANDBUCH NICHT ZU RATE GEZOGEN UND VERSTANDEN 
WURDE.
WIRD DIESE WARNUNG NICHT BEACHTET, SO KANN ES ZU VERLETZUNGEN 
DES KUNDENDIENSTTECHNIKERS, DES BEDIENERS ODER DES PATIENTEN 
DURCH ELEKTRISCHE SCHLÄGE, MECHANISCHE ODER SONSTIGE 
GEFAHREN KOMMEN.

ESTE MANUAL DE SERVIÇO SÓ ÉDISPONÍVEL EM INGLÊS. CASO O 
PROVEDOR DE SERVIÇOS DO USUÁRIO NECESSITE DE UMA TRADUÇÃO, 
ESTA É DE RESPONSABILIDADE DO CLIENTE.
NÃO TENTE UTILIZAR O EQUIPAMENTO ANTES DE CONSULTAR E 
COMPREENDER O MANUAL DE SERVIÇO.
A NÃO OBSERVÂNCIA DESTE PODE ACARRETAR LESÕES AO PROVEDOR 
DE SERVIÇOS, OPERADOR OU PACIENTE CAUSADAS POR CHOQUE 
ELÉTRICO, MECÂNICO OU DE OUTRA NATUREZA.

IL PRESENTE MANUALE DI MANUTENZIONE È DISPONIBILE SOLO IN LINGUA 
INGLESE.
SPETTA ALL´UTENTE PROCURARSI UNA VERSIONE TRADOTTA NEL CASO 
IN CUI L´ADDETTO ALLA MANUTENZIONE DOVESSE RICHIEDERLA.
NON TENTARE DI METTERE IN FUNZIONE L´APPARECCHIATURA PRIMA DI 
AVER CONSULTATO IL MANUALE DI MANUTENZIONE ED AVERNE 
COMPRESO PIENAMENTE IL CONTENUTO.
LA MANCATA OSSERVANZA DI QUESTA AVVERTENZA PUÒ PROVOCARE 
LESIONI AL PERSONALE DI MANUTENZIONE, ALL´OPERATORE O AL 
PAZIENTE, DERIVANTI DA SCOSSE ELETTRICHE, URTI O RISCHI DI ALTRA 
NATURA.

IESTE MANUAL DE SERVICIO SÓLO EXISTE EN INGLÉS.
SI ALGÚN PROVEEDOR DE SERVICIOS AJENO A GEMS SOLICITA UN IDIOMA 
QUE NO SEA EL INGLÉS, ES RESPONSABILIDAD DEL CLIENTE OFRECER UN 
SERVICIO DE TRADUCCIÓN.
NO SE DEBERÁ DAR SERVICIO TÉCNICO AL EQUIPO, SIN HABER 
CONSULTADO Y COMPRENDIDO ESTE MANUAL DE SERVICIO.
LA NO OBSERVANCIA DEL PRESENTE AVISO PUEDE DAR LUGAR A QUE EL 
PROVEEDOR DE SERVICIOS, EL
OPERADOR O EL PACIENTE SUFRAN LESIONES PROVOCADAS POR 
CAUSAS ELÉCTRICAS, MECÁNICAS O DE OTRA NATURALEZA.

WARNUNG

ATENÇÃO

AVVERTENZA

AVISO
eNTEGRA P&R Service Manual Rev. 5
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Chapter 1 -  Safety Guidelines and Regulatory

The safety precautions and regulatory information included in this chapter are 
provided in the following sub-sections:

• General Safety Guidelines on page 1-1 
• Hazards on page 1-3 
• Electrical Precautions on page 1-3 
• Installation Safety Measures on page 1-4 
• Safety Definitions on page 1-4 
• IEC Symbols on page 1-5 
• Regulatory Information on page 1-6 

1.1    General Safety Guidelines
1. The system has been designed and manufactured to ensure maximum 

safety of operation. The equipment should be serviced in strict 
compliance with the safety precautions, warnings and operating 
instructions contained in this Service Manual.

2. The product should be installed, maintained and serviced only by 
qualified service personnel according to procedures laid down in this 
manual. The owner should make certain that only properly trained, fully 
qualified service engineers are authorized to service the equipment.

3. There are no user–serviceable parts inside system components, such as 
workstation cabinet or monitor. Any servicing or adjustments required 
must be carried out by a competent and suitably qualified service person.

4. The system has been designed to meet all the safety requirements 
applicable to medical equipment. However, anyone attempting to operate 
the system must be fully aware of potential safety hazards.

5. The system in whole or in part should not be modified in any way 
without prior written approval by ELGEMS Ltd.

6. No changes, additions or removal of any system accessories are permitted 
without prior written approval of vendor’s local service manager.

7. Only GE approved optional accessories should be connected. Any other 
equipment may cause damage. Installation of any option or peripheral 
must be completed by a GE service representative.
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Safety Guidelines and Regulatory General Safety Guidelines
8. Do not leave the system with problems that may affect the safety of its 
operation. In case you have doubts concerning the system's safe 
operation, call the service office for further instructions and notify the 
customer that the system is not to be used until the problem is resolved.

9. The service engineer must be well acquainted with the Safety and 
Regulation Chapter of the Operator’s Guide.

10. Safe servicing requires that the field engineer has a thorough knowledge 
of all equipment controls and safety devices.

11. Care must be taken when handling liquids around the system in the 
course of maintenance procedures.

12. Smoking should be prohibited around the equipment.

13. The system should be cleaned regularity to prevent the accumulation of 
dust, and the working area should be well ventilated.

14. The maximum allowable ambient temperature is 27oC. The ideal 
environment for the system is 24οC and 40% - 60% relative humidity.

15. Inform the customer about GE’s maintenance procedure and schedule the 
next Planned Maintenance.
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Safety Guidelines and Regulatory Hazards
1.2    Hazards

1.2.1    General Hazards
1. Some repair/replacement procedures require the removal of protective 

covers, exposing parts at high temperatures or with pinch points. Read 
the safety/warning labels and follow the instructions in this Service 
Manual to prevent burns or injuries.

1.2.2    Electrical Hazards
1. Do not remove, or open system covers or plugs, while the unit is powered 

ON. Some internal circuits operate at high voltage, capable of causing 
severe electric shock and/or serious injury.

2. You must be watchful for any short circuits in the system - this is 
especially important if any fuse is blown, or there are circuit breakers that 
won't reset.

1.3    Electrical Precautions
1. Verify with hospital engineering department that the designated power 

line is stable. If any doubt, connect a line recorder for 24 hours at least.

2. Whenever handling electrostatic devices or circuit boards, use a 
grounding strap and wrist band. This grounding strap and wrist band 
must be tested for continuity before use and then connected to the main 
grounding point of the equipment being installed.

3. Floors with epoxy glue generate static discharges.
Advise hospital and use special spray to avoid discharge.

CAUTION
Conductive fluids that seep into the active circuit components of the system 
may cause short circuits, resulting in electrical fires.
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Safety Guidelines and Regulatory Installation Safety Measures
1.4    Installation Safety Measures
1. Read the installation instructions prior to installation.

2. Make sure that the installation area is clean prior to installation.

3. Whenever handling electrostatic devices or circuit boards, use a 
grounding strap and wrist band. This grounding strap and wrist band 
must be tested for continuity before use and then connected to the main 
grounding point of the equipment being installed.

4. Throughout the entire installation you must be careful to correctly 
replace and service all fuse and cable guards. Similarly, you must 
correctly fit all cable covers before installation is completed.

1.5    Safety Definitions
Warnings and Cautions are used throughout this manual. The identified hazards 
are classified as follows:

WARNING
Warnings are used to identify conditions or actions for which a specific 
hazard is known to exist, which may cause severe personal injury, death or 
substantial property damage if the instructions are ignored.

CAUTION
Cautions are used to identify conditions or actions for which a potential 
hazard may exist, which will or can cause minor personal injury, or 
property damage if the instructions are ignored.
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Safety Guidelines and Regulatory IEC Symbols
1.6    IEC Symbols
The system may have labels with one or more of the following symbols. 
These symbols indicate the IEC standards to which the system conforms.

Table 1-1.  IEC Symbols

Symbol IEC Standard

Alternating Current

Protective Earthing Point

ON / Power

OFF / Power OFF

 Input Power

Output Power

Functional Earth Ground

Warning, Caution - consult accompanying documents

Electrical Shock Hazard
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Safety Guidelines and Regulatory Regulatory Information
1.7    Regulatory Information
1.7.1    Standard Compliance

The equipment complies with the following standards:

• IEC 601–1 Medical Electrical Equipment General Requirements for 
Safety

• EN60601–1–2 Medical Electrical Equipment Electro–Magnetic 
Compatibility Requirements and Tests

This equipment generates and can radiate radio frequency energy. The 
equipment may cause radio frequency interference to other medical 
and non-medical devices and to radio communications. To provide 
reasonable protection against such interference, the system complies 
with the emission limits for a Group 1, Class A Medical Devices as 
stated in EN 60601-1-2. However, there is no guarantee that 
interference will not occur in a particular installation.

If the equipment is found to cause interference (which may be 
determined by turning the equipment on and off), the user (or 
qualified service personnel) should attempt to correct the problem by 
one or more of the following measures:
❍ Re-orient or relocate the affected devices(s);
❍ Increase the separation between the equipment and the affected 

device;
❍ Power the equipment from a source different from that of the 

affected device;
and/or

❍ Consult the point of purchase or service representative for further 
suggestions

To comply with the regulations on electromagnetic interference for a 
Group 1, Class A Medical Device, all interconnect cables to 
peripheral devices must be shielded and properly grounded. Use of 
cables not properly shielded and grounded may result in the 
equipment causing radio frequency interference in violation of the 
local regulations.

The manufacturer is not responsible for any interference caused by 
using other than recommended interconnect cables or by unauthorized 
change or modifications to this equipment. 

Due to installation in less favorable environment, this equipment may 
be exposed to electromagnetic and electrostatic interference. To 
ensure a high level of reliability when exposed to such interference, 
this equipment complies with the immunity requirements as stated in 
EN60601-1-2. for immunity Class 1. The operating conditions are 
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Safety Guidelines and Regulatory Regulatory Information
classified on the basis of performance criteria as defined in IEC 801-2.

Do not use devices which intentionally transmit RF signals (cellular 
phones, transceivers, or radio-controlled products) in the vicinity of 
this equipment as it may cause performance outside the published 
specifications. Keep the power to these types of devices turned off 
when near this equipment.

The medical staff in charge of this equipment is required to instruct 
technicians, patients, and other people who may be around this 
equipment to fully comply with the above requirement.

Unauthorized change or modifications of the equipment could void the 
user’s authority to operate the equipment.

1.7.2    CE Conformity

This product conforms with the requirements of council directive 93/42/EEC 
concerning Class IIA medical devices, and therefore bears the CE mark of 
conformity.

The name and address of the CE representative appears on the back of the 
front page of this manual.

1.7.3    USA Regulations

• The system was cleared for sale in the USA by the FDA.

• Caution: Federal US law restricts this device for sale by or on the order of 
a physician.

• In the USA, this system should only be used with FDA approved 
radiopharmaceuticals.
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Chapter 2 -  Introduction

In this chapter you will find the following information:

• Section 2.1 - How to Use this Manual on page 2-1 
❍ Section 2.1.1 - Other Documentation on page 2-1 
❍ Section 2.1.2 - Where to Look on page 2-2 

• Section 2.1.2 - Where to Look on page 2-3 
❍ Section 2.2.1 - Catalog Product Structure on page 2-3 

2.1    How to Use this Manual
This Class A Service documentation set provides:

• eNTEGRA P&R specific service information.

• Direction to appropriate service documentation included with the 
eNTEGRA PC Workstation.

The beginning of each section in this manual contains a steering guide which 
lists the topics covered and where to look for the information. Some of the 
information is found within this manual and other information is found in 
documentation supplied by manufacturers of the eNTEGRA System 
components.

2.1.1    Other Documentation
Each system includes the following manuals:

• PC User’s Guide, containing information on installing and 
troubleshooting the PC. Locate this manual and keep it with this 
manual.

• Microsoft Windows NT Workstation Basics and Installation. Locate 
this manual and keep it with this manual.

• Monitor’s User Guide.

• Modem User’s Guide.
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Introduction How to Use this Manual
2.1.2    Where to Look

Table 2-1.  Where to Look

Topic Source

Workstation Operation • PC User’s Guide
• Microsoft Windows NT Workstation Basics 

and Installation Version 4.0

eNTEGRA Operation • eNTEGRA Operator’s Manual
Direction No. 22666250-100

• This Manual, Chapter 4, Functional Checks 

Site Preparation / pre-Installation Check 
List

• Site Preparation Manual, Direction No. 
2264704-100

Installing the System • PC User’s Guide
• This Manual, Chapter 3, Installation 

System Configuration • This Manual, Section 3.8 

Network Configuration • This Manual, Section 3.9 

Configuring the Hardcopy Devices • This Manual, Section 3.10 

Software Load from Cold • This Manual, Section 6.2 

Software Load from Worm • This Manual, Section 6.3 

Installing the Clinical Application 
Licences

• This Manual, Section 6.4 
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Introduction The eNTEGRA System
2.2    The eNTEGRA System
The eNTEGRA platform is a Pentium based PC. Table 2-2 lists the 
components that make up the eNTEGRA P&R system.

2.2.1    Catalog Product Structure
The basic eNTEGRA system is delivered in several configurations with 
respect to the regulatory kit (one of two available) and an optional 
localization kit, which includes a matching keyboard and Operator’s Manual.

In all delivery options, Windows NT Ver 4.0 and eNTEGRA R1.0 (or current 
version) are pre-loaded.

Table 2-3 summarizes the available basic system configurations by Catalog 
number.

Table 2-4 summarizes the available hardware and software options by 
Catalog number.

Table 2-2.  eNTEGRA System Components

Description Comments

19" or 21" High Resolution Color Monitor

PC Processor Unit Contains Pentium CPU, Hard Disk, Floppy 
Drive, CD-ROM Drive and optional Archive 
Optical Disk.

Keyboard 101 Key IBM PS/2 compatible.

3 Button Mouse IBM PS/2 compatible.

Isolation Transformer 115 V/ 115 V & 220 V/115 V versions.

Modem Country Specific

DASM/LCAM Optional 952 Lasercam Digital Interface.
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Introduction The eNTEGRA System
* Each Manual Package includes:
• Operator Manual - Hardcopy
• CIS - Hardcopy
• eNTEGRA On-line Help CD

Table 2-3.  Basic eNTEGRA System – Catalog Numbers

Description Catalog 
Number Contents

Basic System H3400ZA Pentium Based PC workstation
Windows NT ver. 4.0 Operating System
eNTEGRA R1.0 Application Software
Documentation Kit including Operator’s Manual, 
CD with on-line help for all available applications, 
Release Notes and Service Manual, all in English.

Monitor – either of: H3300TB 19" High Resolution Color Monitor

H3000TA 21" High Resolution Color Monitor

Regulatory Options

American Regulatory Kit H3400LB 3Com Modem
Isolation Transformer – USA version

CE Regulatory Kit
(for Europe)

H3400LC Modem Supplied locally
10 Isolation Transformer

Spanish Localization Kit H3400ZB Spanish Keyboard, Spanish Accessories CD, 
Windows NT Spanish, Spanish Manual Package*.
Pre–requisites – CE Regulatory Kit.

Swedish Localization Kit H3400ZC Swedish Keyboard, Swedish Accessories CD, 
Window NT Swedish, Swedish Manual Package*.
Pre–requisites – CE Regulatory Kit.

Italian Localization Kit H3400ZD Italian Keyboard, Italian Accessories CD, Window 
NT Italian, Italian Manual Package*.
Pre–requisites – CE Regulatory Kit.

German Localization Kit H3400ZE German Keyboard, German Accessories CD, 
Window NT German, German Manual Package*.
Pre–requisites – CE Regulatory Kit.

Portuguese Localization 
Kit

H3400ZF Portuguese Keyboard, Portuguese Accessories 
CD, Window NT Portuguese, Portuguese Manual 
Package*.
Pre–requisites – CE Regulatory Kit.

French Localization Kit H3400ZG French Keyboard, French Accessories CD, 
Window NT French, French Manual Package*.
Pre–requisites – CE Regulatory Kit.
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Introduction The eNTEGRA System
Table 2-4.  eNTEGRA Options – Catalog Numbers

Type Catalog # Description / Contents

Accessories H2508LK SONY, 5,25: re-writable multi functional optical 
disk drive.
Note: does not support reading data archived 
using the PIONEER DE-UH7101 drive.

H2508LG Digital Laser Camera Interface (DASM/
LCAM). Provides host control and digital 3M 
952 interface to supported lasercameras. 
Separate stand alone unit.

H2600NJ 128 MB Memory Upgrade

Software H2600LE ECToolbox – new CEqual processing with 
5 databases, EGS and 3-D PerfSPECTive
(2nd/3rd licence - H2600NC, 4th Licence - 
H2600NE).

H2600LC ECToolbox Light – New CEqual with two 
databases: 1 day MIBI and 2 Day MIBI.
(2nd/3rd licence - H2600ND, 4th Licence - 
H2600NF).

H2600RK Functional Anatomical Mapping – Fusion

H2600LB QuantEM – Emory Renal Quantification (with 
syringe holder and gates adapter - H2600MB).

H2600LK QGS – Quantitative Gated SPECT analysis 
(Cedar Sinai package).

H2600WB QPS – Quantitative Perfusion SPECT (Cedar 
Sinai package).

H2600LM 3–D Volume Rendering and Surface Shading

H2600LP Aladdin Advanced Software

H2600LR Iterative Reconstruction, including MLEM, 
OSEM and COSEM IR algorithms for SPECT 
and CoDe.

H2600WC OSI Connectivity, used to connect StarCam 
and APEX SP systems to the eNTEGRA

H2600LT CT/MR Display – DICOM Import of CT/MR 
Images via LAN

H2600LS Transfer of Interfile and DICOM Part 10 files 
via WAN/LAN
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Chapter 3 -  Installation

This chapter provides detailed instructions for installing the eNTEGRA 
system.

The instructions are provided in the following break down: 

• Section 3.1 - Overview on page 3-2, which includes:
❍ Section 3.1.1 - How to Use This Chapter on page 3-2
❍ Section 3.1.2 - Estimated Cycle Time on page 3-2
❍ Section 3.1.3 - General Requirements on page 3-2
❍ Section 3.1.4 - Installation Flow Chart on page 3-4

• Section 3.2 - Unpacking on page 3-5
• Section 3.3 - Isolation Transformer Installation on page 3-7
• Section 3.4 - PC Installation on page 3-8
• Section 3.5 - Connect Peripheral Tower on page 3-10
• Section 3.6 - DASM/LCAM Option on page 3-11
• Section 3.7 - Initial System Power-up on page 3-12
• Section 3.8 - Site Configuration on page 3-14
• Section 3.9 - Remote LAN Configuration on page 3-28
• Section 3.10 - Hardcopy Options on page 3-33
• Section 3.11 - InSite Entitlement on page 3-88
• Section 3.12 - Backup on page 3-90
• Section 3.13 - Commissioning on page 3-90
• Section 3.14 - Completion on page 3-90
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Installation Overview
3.1    Overview

3.1.1    How to Use This Chapter
The installation procedure is diagramed in a flow chart (Figure 3-1) so that 
specific tasks are completed in the correct order and in an efficient manner. 
The manual itself closely follows the flow chart.

In addition, the manual includes instructions for installing hardware options 
as upgrade. 

3.1.2    Estimated Cycle Time
The installation process should take 1 person approximately 2 hours to 
complete.

3.1.3    General Requirements

3.1.3.1    Special Tools and Fixtures

None.

3.1.3.2    Seismic Anchoring

Systems to be installed in areas of the world subject to earthquakes may 
require seismic anchoring. The Service Representative should check with 
local authorities in the country/region of installation.

3.1.3.3    Pre–Installation Check List Completed

Before commencing with the installation, ensure that the site preparation 
check list (found in the Site Preparation Manual 2264704-100) is completed.

Note The network backbone and node drops should be installed prior to starting the 
eNTEGRA P&R installation.
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Installation Overview
3.1.3.4    Compatible Options

The available options for eNTEGRA are listed in Table 3-1.

3.1.3.5    Recording Installation Time

The standard installation code is 03. Anything not part of a standard 
installation shall be booked against one of the numbers in Table 3-2. It would 
not be uncommon on a NORMAL installation to find time booked to one or 
more of these codes.

Table 3-1. Options

Description Section

DASM–LCAM Section 3.6

General Hardcopy Info Section 3.10

Table 3-2. Non-installation Time Codes

Code Description

04 Site preparation or inspection.

06 Non standard installation

10 Failures during installation.

84 Service incurred because of loss or damage in shipment and filing 
claims.

87 Service training — on site, field office, Education Center

91 Costs incurred when modifying products to make them compliant 
with local country regulatory standards.

94 Sales activity. Service work performed on behalf of sales, includes 
equipment demonstrations and sales assistance.

98 F.M.I. work.

Note Network installation time should be covered by a K1000 catalog number or 06 
Money. It should not be charged directly to the eNTEGRA installation.
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Installation Overview
3.1.4    Installation Flow Chart

Figure 3-1: Installation Flow Chart
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Installation Unpacking
3.2    Unpacking

3.2.1    Packing List
Use Table 3-3 to verify that you have received all items.

Table 3-3. Packing List

Contents Documents

General Documents, Software, Licenses and Activator eNTEGRA Operator Manual
eNTEGRA Service Manual
Release Notes (CIS)

Monitor Monitor
Video Cable
Power Cable

Color Monitor Users Guide

Processor Unit Personal Computer
Accessories Kit:

Keyboard
Mouse
Power Cables

PC User’s Manual

Local Kit
(country dependent)

Isolation Transformer 
Power Cables

OEM Documentation

Modem (for USA only) OEM Documentation

Keyboard (European Options only) Operator’s Guide in relevant 
language, and Installation 
Instructions 

DASM/LCAM (Option) DASM/LCAM Users Guide

WARNING
Do not discard any packing material until installation is complete.
eNTEGRA P&R Service Manual 3-5 Rev. 5
Direction 2263784-100 June 17, 2001



Installation Unpacking
3.2.2    Damage in Transit
At the time of delivery examine all packages for external damage. If damage 
to any package is apparent, notify your installation specialist before 
continuing.

3.2.3    Product Locator Cards
Remove all Product Locator cards, marked INSTALLATION, from each 
package and put in a safe place until installation is complete. Details on 
completing and mailing these cards are given in Section 3.14.3.
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Installation Isolation Transformer Installation
3.3    Isolation Transformer Installation
If an isolation transformer will not be installed, proceed to the Section 3.4.

3.3.1    Mounting Procedure
The isolation transformer can either be mounted on a wall or positioned on 
the floor next to the eNTEGRA P&R

1. Unpack isolation transformer and position near the workstation location.

2. If the transformer will be mounted on the wall, secure using four 11mm x 
76 mm (7/16" x 3") anchor screws.

Note An isolation transformer is required if the eNTEGRA P&R is located in the patient 
scanner area and for CE compliant installations.

Table 3-4. Isolation Transformer Installation

Steps Time (Min.) Reference

Ensure Pre–install 
Complete

10 Pre–Installation Check List in the Pre-
Installation Manual.

Unpack & Install 
Isolation Transformer

15 Section 3.3.1

Connect Isolation 
Transformer to Line 
Supply

In above. Figure 5-1

Total 30

Note
The wall mount must support the weight of the isolation transformer (17.2 kg, 
38 lbs).
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Installation PC Installation
3.4    PC Installation

3.4.1    Installation Overview
Table 3-5 outlines the steps for installing the eNTEGRA PC hardware. Refer 
to the PC User’s Guide for details. 

Table 3-5. Installation Overview

Steps Time 
(Min.) Reference

Unpack PC components. 5 PC User’s Guide

Unpack and Position 
Processor Unit per 
customer’s specifications.

In above. Refer to Site Plan diagram

Unpack Monitor, 
Keyboard, and Mouse

5

Position Monitor, 
Keyboard, and Mouse per 
customer’s specifications.

In above. Refer to Site Plan diagram

Connect PC cables 5 PC User’s Guide.
Figure 5-1

Connect appropriate 
Network Transceiver and/
or Drop Cable.

5 Section 3.4.2
Figure 5-1

Plug–in the Activator In above Section 3.4.3

Total 20

Note
A desk is not provided as part of the standard system. Arrangements should have 
been made during site preparation.
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Installation PC Installation
3.4.2    Network Connection
The eNTEGRA P&R PC includes a 10/100 Base–T IEEE 802.3 Ethernet 
card. This card provides a RJ45 interface to connect into either a 100 Base–T 
or 10 Base–T IEEE802.3 HUB via a category 5 unshielded twisted pair 
(CAT 5) cable. 

The HUB and CAT 5 drop cable should have been installed as part of the site 
preparation process. To interface the PC to the HUB:

• Connect one end of the category 5 UTP cable to the RJ45 plug on the 
PC’s Ethernet card.

• Connect the other end to either the 
❍ Open port on the HUB. 
❍ RJ45 connection provided by LAN installer. This connection 

should be tied back to the HUB.

Figure 3-2 provides an example of the LAN connections.

To connect to another IEEE802.3 topology (10Base2 or 10Base 5), the HUB 
will need to be interfaced to the current network bus via the HUB’s AUI port 
and a topology specific transceiver. This should have been completed during 
the site preparation work. 

• A 10Base2 or ThinNet LAN consists of a 50 ohm RG58 coax cable 
backbone.

• A 10Base5 or ThickNet LAN uses thick 50 ohm coax cable as the 
backbone. The node transceivers are connected to the backbone via a 
vampire tap or a end point connector.

Figure 3-2: eNTEGRA LAN Connection Examples
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Installation Connect Peripheral Tower
3.4.3    Plug–in the Activator
Plug the keyed activator into the parallel port on the rear panel of the 
computer. In case of a local connected printer, you plug the printer into the 
activator. 

3.5    Connect Peripheral Tower

3.5.1    Introduction
In the case of an upgrade from the HP715/100 platform there may be a 
peripheral tower containing the Archive Optical Disk and/or the DASM/
LCAM Digital Lasercam Interface that needs to be interfaced to the system.

If there is no peripheral tower with the system, proceed to the Section 3.6.

3.5.2    Installation Procedure

Table 3-6. Peripheral Tower Option Installation Procedure

Steps Time 
(Min.) Reference

Unpack and Position 
Peripherals Tower per 
customer’s specifications.

5

Open the tower and 
configure the DASM/
LCAM as follows:
• SCSI ID = 4
• D Host Comm = RS422

5

Refer to the DASM/LCAM User Manual. 

Connect SCSI cable 
between the PC and the 
peripheral tower.
Install the SCSI terminator 
on the tower.

10 Figure 5-1 and the PC User’s Guide

Connect power cord to 
Isolation Transformer

In above Figure 5-1

Total 20
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3.6    DASM/LCAM Option

3.6.1    Introduction
The DASM/LCAM is a self–contained unit that provides a digital interface to 
a 3M 952 compatible Lasercamera. 

• The unit is connected to the PC via the SCSI bus. 
• The Lasercamera interface is via a 25 pin RS422 serial 

communication (Host) line and a 37 pin digital (Image) line.

If there is no DASM/LCAM option included, proceed to Section 3.7.

3.6.2    Installation Procedure

Note If the DASM/LCAM option is included, refer to Section 3.10 for complete details on 
interfacing/configuring the DASM/LCAM with the various compatible 
Lasercameras.

   Important The DASM/LCAM can not be used if a MFHD or MF96 is also being used due to 
SCSI bus conflicts.

Table 3-7. DASM-VDB Option Installation Procedure

Steps Time 
(Min.) Reference

Unpack and Position DASM/LCAM 5

Configure the DASM/LCAM as follows:
• SCSI ID = 4
• Host Comm = RS422

5 Refer to the DASM/
LCAM Users Manual.

Connect SCSI cable between the PC and 
DASM/LCAM.
Install the SCSI terminator on the DASM/LCAM

10 DASM/LCAM Users 
Manual and the PC 
User’s Guide

Connect power cord to Isolation 
Transformer

In above Figure 5-1

Total 20

Note Refer to Section 3.8 for details on configuring the eNTEGRA system to use the 
Lasercamera connected to the DASM/LCAM for filming.
Refer to Section 3.10 for complete details on interfacing/configuring the DASM/
LCAM with the various compatible Lasercameras.
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3.7     Initial System Power-up

3.7.1    Procedure

3.7.2    Logging Into the System
1. Turn ON the Computer.

2. When the Windows NT screen is displayed, press the 
<Alt>+<Ctrl>+<Del> keys, concurrently, as prompted in the Begin 
Logon prompt.

3. In the Logon Information dialog, enter:

User name:entegra 

Password: entegra

Click the [OK] button.
The eNTEGRA StartUp window with the version number will be displayed.
When the eNTEGRA application has been loaded, the Main screen is dis-
played, as shown in Figure 3-3. 
When activated, the eNTEGRA application:
• Verifies that the eNTEGRA software and licenses were properly 

loaded in manufacturing.
• Initializes the system drivers for any SCSI peripherals (DASM/

LCAM, MFHD/MF96 or Archive EOD) added during the installation 
process.

• Verifies that all peripherals are alive and not hanging the SCSI bus.

4. Once the eNTEGRA application starts, verify that all licensed options are 
present (such as ECToolbox™, QuantEM™, Aladdin™, 
PerfSPECTive™, IR, QGSPECT, etc.). 

Table 3-8. Initial System Power-up Procedure

Steps Time (Min.) Reference

Apply power to all peripherals and to 
the system.

4

Log into the system 1 Section 3.7.2

Verify no errors occur during boot-up 
and that eNTEGRA application starts.

5 Section 8.2.2

Total 10
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Figure 3-3: eNTEGRA Main Screen
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3.8    Site Configuration

3.8.1    Introduction
The eNTEGRA system comes pre–loaded with the WINDOWS NT operating 
system, eNTEGRA Application software and all licenses. The following local 
parameters will need to be configured for the site:

• Institute ID
• Local IP Address
• Regional Settings
• Site Name
• Starlink Configuration Table
• DICOM Configuration
• Remote Database Option
• Remote Connectivity Option
• Hardcopy Server and Devices
• Archive Server
• GE CARES/MUST ID
• Modem IP Addresses (at least two) 

This section details how to configure these parameters. 

3.8.2    Required Information
Before starting this procedure, you must have the System Assignment 
information collected during site preparation available. This includes:

• Hospital ID that will appear on the eNTEGRA screen (up to 2 lines)
• IP Address of the local eNTEGRA system.
• How customer wants Site Name listed on eNTEGRA.
• Ethernet Addresses of all systems on the Starlink LAN (Starcams,

M–Link system and Starlink agent systems).
• Ethernet Addresses of all SP systems on the ApexNet.
• Host names and IP Addresses of any remote DICOM stations.
• Host name and IP Addresses of any remote eNTEGRA systems for 

remote database.
• Host name and IP Addresses of any network hardcopy device (Helios, 

Codonics, etc.).
• Host name, IP address and phone number for any system to be 

connected via modem.

   Important StarLink on the NT Platform requires the OSI Software Option. StarLink will not 
work without this option. To verify if this option has been loaded on the system:
• Click on the [Start] icon on the Tasks Bar, and select: Settings → Control Panel.
• Double click the Network icon.
• Go to the Protocols tab and check if IMPART ISO 8073 Transport is installed.
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3.8.3    Procedure Overview

Table 3-9. Configuration And Licensing Overview

Steps Time 
(Min.) Reference

Before changing the configuration of 
an existing system, back up the old 
configuration

1 Section 3.12

Changing Institution ID 1 Section 3.8.4.1

Changing the Default Computer name 1 Section 3.8.4.2

Updating the Regional Settings 1 Section 3.8.4.3

Changing Default Host Name 1 Section 3.8.4.4

StarLink and APexNet Configuration 1 Section 3.8.4.5

DICOM Configuration 1 Section 3.8.4.6

Interfile Configuration 1 Section 3.8.4.7

Remote Access Configuration 1 Section 3.8.4.8

Modem Configuration 1 Section 3.8.4.9

Remote Database 1 Section 3.8.4.10

Hardcopy Configuration 25 Section 3.8.4.11

Backup (of new configuration) 1 Section 3.12

Total 39/40
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3.8.4    System Configuration Procedure

3.8.4.1    Changing Institution ID

1. Open the eNTEGRA Application.

2. Click the [Configuration] button on the upper left corner of the Main 
screen, then click [Advanced Configuration...].

3. Click the General tab.

4. Overtype the default Institution ID according to the Site Assignment 
Matrix.

5. Click [OK] to close the eNTEGRA Configuration window.

6. Click [Apply] to exit User Preferences window.

7. Shutdown the eNTEGRA application and restart it.
Verify that the institution ID was updated successfully.

3.8.4.2    Change Default Computer Name

1. Click on the minimize button on the upper left corner of the Main Screen 
to view the system’s Desktop.

2. Right click the Network Neighborhood icon located on the Desktop, 
and select the Properties entry.

3. In the Identification tab, click the [Change] button.

4. Overwrite the default computer name by the new host name and click the 
[OK] button.

Note
1. The name is limited to 17 characters; A – Z, a – z, 0 – 9 and "_"
2. Server licenses depend on the computer name.
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3.8.4.3    Updating the Regional Settings

1. Click left on the [Start] icon on the Task Bar, and select: Setting → 
Control Panel.

2. On the Control Panel window, double click on the Regional Settings 
icon.

3. In the Regional Settings tab, select the relevant language and country.

4. In the Date tab, select the Short Date Style to be used (the options 
shown are those that are relevant to the selected language/country 
combination).

5. Click the [OK] button and close the Control Panel window.

3.8.4.4    Updating/Setting the IP Address

1. Click on the [–] (minimize) button on the Main Screen Header to view 
the system’s Desktop.

2. Right click the Network Neighborhood icon located on the Desktop, 
and select the Properties entry.

3. In the Protocol tab, highlight TCP/IP Protocol, and click the 
[Properties...] button.

4. Change the IP address to address assigned in the pre–installation 
checklist. If relevant, update also the Subnet Mask and Default Gateway.

5. Click the [OK] button

6. Click the [OK] button again. 

Note
These settings affect the date shown in the Patient Selector and also the date 
formats which are accepted by the patient selector filter mechanism.

   Important You must enter in a valid and unique IP Address. Using the default address will 
cause network problems. The system also needs a valid IP Address for DICOM, 
Remote Database, network printing and InSite to work correctly.
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3.8.4.5    StarLink and ApexNet Configuration
(applicable only if the OSI option is installed)

1. Click the [Configuration] button on the upper left corner of the Main 
screen, then click [Advanced Configuration...].

2. Click the OSI tab.

3. Click [Add].

4. Type in the Remote Station Name.

5. Select the type from the drop–down list (Starcam, SP, or 
GENIE+eNTEGRA).

6. Type in the Ethernet address of the remote station.

7. Click [OK] three times to close the eNTEGRA Configuration window.

8. Click [Apply] to exit User Preferences window.

9. For the changes to take affect, shutdown and reactivate the eNTEGRA 
application.
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3.8.4.6    DICOM Configuration

1. Click the [eNTEGRA] icon on the Task Bar.

2. Click the [Configuration] button on the upper left corner of the Main 
screen, then click [Advanced Configuration...].

3. Click the Dicom tab.

4. For each remote station with which the system is to communicate via 
DICOM (refer to Table 3-12 for DICOM configuration parameters):

a. Click the [Add] button.
b. Type in the Host name, Application Entity and IP address of the 

Remote station.
c. Verify that the appropriate flags are checked to enable the correspond-

ing operations.
d. Click the [OK] button.

5. When all remote DICOM stations have been added, click the [OK] button 
to close the eNTEGRA Configuration window. 

6. Click [Apply] to exit User Preferences window.

Note DICOM printers are not configured during this step. The DICOM print Application 
Entity (AE) is separate from the DICOM image transfer AE. DICOM printing is 
configured during the hardcopy configuration.
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Table 3-10. DICOM Configuration Parameters

System Type Station Name IP Address Application 
Entity

Port 
#

Flags 
(Service 
Class)

eNTEGRA Limitations:
• Less than 12 charac-

ters
• Only letters (a-z, A-

Z), Numbers (0-9) or 
underscores (_) are 
allowed.

Per system’s 
TCP/IP 
configuration

Host name in 
upper case 
letters

104 Send, 
Query, 
Fetch

Genie P&R Host name in 
upper case 
letters

2030 Send, 
Query, 
Fetch

XPert As defined by 
the local system 
administrator. 
Case Sensitive

104 Send, 
Query, 
Fetch

Genie Acq Host name in 
upper case 
letters

2030 Query, 
Fetch

Millennium VG As defined by 
the local system 
administrator. 
Case Sensitive

104 Query, 
Fetch

Other Systems Refer to the system’s DICOM 
Conformance statement.
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3.8.4.7    Interfile Configuration

1. Click the [Configuration] button on the upper left corner of the Main 
screen, then click [Advanced Configuration...].

2. Click the Interfile tab.

3. For each remote Interfile station:
a. Click the [Add] button.
b. Type in the Remote station’s Hostname and click [OK].
c. Enter the IP Address of the remote Interfile station and click [OK].

4. When all remote Interfile stations have been added, click the [OK] button 
to close the eNTEGRA Configuration window.

5. Click [Apply] to exit the User Preferences window.
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3.8.4.8    Remote Access Configuration

1. Click right on the Network Neighborhood icon residing on the 
desktop and select the Properties entry in the opened menu.

2. In the opened Network dialog, click on the Services tab.

3. Highlight the Remote Access Service entry.

4. Click the [Properties] button to open the Remote Access Setup dialog.

5. Click the [Configure...] button.

6. In the opened Configure Port Usage dialog, click the radio button next 
to Dial out and Receive calls, then click [OK].

7. In the Remote Access Setup dialog, click [Network...].
8. In the Network Configuration dialog verify that:

a. Under Dial out Protocols: TCP/IP is checked
b. Under Service Settings: TCP/IP is checked.
c. Under the Encryption Settings, click the radio button next to 

Allow any authentication including clear text.
9.  In the Network Configuration dialog, click [Configure...].
10. In the Ras Server TCP/IP Configuration dialog click the radio 

buttons next to This computer only and Use static address pool.
11.  Type in the modem begin and end IP addresses.

12. Check the checkbox next to Allow remote clients to request a 
predetermined IP address.

13. Click [OK] to return to the Network Configuration dialog

14. Click [OK] to return to the Remote Access Setup dialog.

15. Click [Continue] to return to the Network dialog, then click [Close].

16. Wait for the Network Settings Change window, and click [Yes] to 
restart the computer.
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3.8.4.9    Modem Configuration

Configure the modem to enable dialing to other stations through the Dial-Up 
Networking facility.

1. Click left on the [Start] icon on the Task Bar, and select: Programs → 
Accessories → Dial-Up Networking.

2. In the opened Location Information dialog:

a. Select your country/region from the drop-down list.
b. Type in your area code.
c. Type in the number required to access an outside line, if any.
d. Click the radio button next to the local phone system (Tone dialing or 

Pulse dialing).
e. Click [Close]. 

3. If the system notifies you that the phone book is empty, click [OK] to add 
an entry to the phone book and proceed to step 3, below.

Otherwise, skip to Step 10.

4. In the opened New Phonebook Wizard dialog, type in the name of the 
server used to connect to the remote network, and click [Next].

5. In the opened Server dialog click [Next].
6. In the opened Phone Number dialog, type in the phone number of the 

remote dial-up server.

7. If there are alternate numbers to be dialed in case that the primary number 
can not be reached:

a. Click [Alternates...].
A dialog is opened.

b. For each alternate number, type-in an alternate number and click 
[Add].
This number is added to the phone numbers list.

c. When all the alternate numbers have been added, click [OK].
8. Click [Next] until you return to the Dial-Up Networking dialog.

9. For each entry to be added to the phonebook, click the [New] button in 
the Dial-Up Networking dialog and repeat steps 4 through 8.

10. In the Dial-Up Networking dialog, while the first dial-up server is 
highlighted, click the [More] button.

Note You can add, replace or delete alternate phone numbers, as well as sort the list,
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11. In the opened pull-down list select the Edit entry and modem 
properties... entry.

12. In the opened Edit Phonebook Entry dialog, select the Server tab to 
bring forward the Ras Server properties.

13. Pull-down the Dial-up server type list and select the PPP, Windows 
NT, Windows 95 Plus, Internet entry.

14. In the opened Network protocols list, check TCP/IP.

15. Click the [TCP/IP Settings] button.

16. In the opened PPP TCP/IP Settings dialog:

a. Click the radio button next to Server assigned IP address.
b. Click the radio button next to Server assigned name server 

addresses.
c. Uncheck the checkbox next to Use IP header compression.
d. Check the checkbox next to Use default gateway on remote net-

work
e. Click [OK] to return to the Server tab dialog.

17. Click the Security tab.

18. Click the radio button next to Accept any authentication including 
clear text, then click [OK] to return to the main Dial-Up Networking 
dialog

19. Repeat steps 10 through 18 for each dial-up server in the Phonebook 
entry to dial list.

20. When all the dial-up servers have been defined, click [Close] to close the 
Dial-Up Networking dialog.
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3.8.4.10    Remote Database

1. Click the [eNTEGRA] icon on the Task Bar.

2. Click the [Configuration] button on the upper left corner of the Main 
screen, then click [Advanced Configuration...].

3. Click the Database tab.

4. Click on the Down Arrow next to the Default database server field, 
and select the Computer Name of the remote server to whose database 
you want to connect, if any.

5. If you want to connect to a data base that is not included in the data base 
options list, click the [Add] button, type in the name of the remote server, 
and its IP address, and click [OK].

6. Click the [OK] button to close the eNTEGRA Configuration window.
7. Click [Apply] to exit the User Preferences window.
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3.8.4.11    Hardcopy Configuration

1. Click the [Configuration] button on the upper left corner of the Main 
screen, then click [Advanced Configuration...].

2. Click the Printers tab.

3. Click the [Add] button.

4. In the Add/Edit Printer Device window (refer Table 3-11 to for 
supported hardcopy devices):

a. Type in the alias name of the hardcopy device.
b. Select the type of the hardcopy device from the drop–down list.
c. Click [Setup...].
d. Type in or select the required information for the specific hardcopy 

device.
e. Click [OK] to close the Printer Setup window.

5. To define an additional Hardcopy Device, repeat steps 3 & 4.

6. When all the hardcopy devices have been defined, Select the default 
Printer from the Drop–down list.

7. Click [OK] to close the eNTEGRA Configuration window.

8. Click [Apply] to exit the User Preferences window.
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Table 3-11. Valid Device Type Settings

Hardcopy Device Interface Device Type
Additional

Configuration 
Details

Imation (3M) Lasercamera 
(952, 959, 969 or DryView)

DASM/LCAM 3M Section 3.10.2

Kodak Lasercamera 
(XLP100, 1120, 2180) 

DASM/LCAM 3M Section 3.10.3

DuPont Lasercamera DASM/LCAM dupont_3m Section 3.10.4

Fuji Lasercamera DASM/LCAM 3M Section 3.10.5

Konica Lasercamera DASM/LCAM 3M Section 3.10.6

Codonics Color Printer Network np1600m Section 3.10.8

Helios Lasercamera Network helios Section 3.10.7

PostScript compatible 
printer

Network/
Printer Port

postscript Section 3.10.9

DICOM Printers Network DCMI8300,  
DCMI8700, 
DCMA2KCL, 
DCMA2KBW, 
DCMcod

Section 3.10.10

Note The only DICOM printers that have been validated are the Imation 8300 
(DCM8300), Imation 8700 (DCMI8700), AGFA Drystar (DCMA2KCL and 
DCMA2KBW) and the Codonics 1660 (DCMcod).

   Important A maximum of 4 devices can be configured on the hardcopy server.
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3.9    Remote LAN Configuration

3.9.1    Introduction
The eNTEGRA system utilizes two network protocols for communication to 
remote systems.m 

• OSI network protocol used by:
❍ Starlink protocol which is used for communication with Starcam 

systems, M–Link systems and Starlink agent systems.
❍ SP based systems residing on the ApexNet LAN.

• TCP/IP network protocol used for:
❍ DICOM communication with other eNTEGRA P&R systems, 

GENIE ACQ systems, Millennium VG systems and other remote 
DICOM systems. 

❍ Remote Database and Remote Connectivity.

For remote Starlink systems, the eNTEGRA system’s Ethernet Address and 
system name must be added to the Starlink configuration of each system. In 
addition, the Starlink software on each Starcam system must be upgraded to 
Starlink Version 4. See below for details.

For remote SP systems, the eNTEGRA system’s Ethernet Address and system 
name must be added to each system.

For remote DICOM systems, the eNTEGRA system’s hostname, IP Address, 
DICOM AE Title and DICOM port number must be configured.

Note
The default DICOM AE title is the hostname in uppercase. The DICOM port 
number for eNTEGRA is 104.
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3.9.2    Procedure Overview

3.9.3    eNTEGRA Ethernet Address
1. Click on the minimize button on the Main Screen Header to view the 

system’s Desktop.

2. Click left on the [Start] icon on the Tasks Bar, and select Programs → 
Impart 32  → Command Line Manager.

3. Type D <Enter> for full display.

4. Under the DTE column you will find the Ethernet address of the local 
eNTEGRA system (a 12 characters number).
Record the Physical (Ethernet) address displayed in the site log book.

5. Type q <Enter> to quit.

Table 3-12. Communication Configuration

Steps Time (Min.) Reference

Configure all GENIE ACQ and 
Millennium VG Systems for 
DICOM Communication to 
eNTEGRA P&R

5/System • Acquisition System Service Manual
• Use the following parameters:

AE Title = hostname in uppercase
Port No. = 104

Get eNTEGRA P&R’s Ethernet 
Address

5 minutes Section 3.9.3

Upgrade all Polestar and 
Polestar-i systems on network to 
Starlink V4

15/system Section 3.9.4
• eNTEGRA Ethernet (LAN) address

Upgrade all Build Standard 1 & 2 
system on network to Starlink V4

30/system Section 3.9.5
• eNTEGRA Ethernet (LAN) address

Upgrade all Build Standard 0 
systems on network to Starlink 
V3

15/system Section 3.9.6

Configure the SP based systems 
for communication with the 
eNTEGRA system

5/system • Getting Ethernet Addresses and 
names of SP based systems – 
Section 3.9.7

• SP system’s documentation
• eNTEGRA Ethernet (LAN) address
• eNTEGRA computer name

Configure all remote DICOM 
systems

10/system • Remote DICOM system’s documen-
tation

• Use the following parameters:
AE Title = eNTEGRA hostname in 
uppercase
Port No. = 104

Total 80/system
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3.9.4    Starlink Version 4 Upgrade for Polestar and Polestar-i Systems.
1. Shut down the Polestar system by entering shutdown <Sendform>.

2. Reboot the system by pressing the RESET button.

3. When prompted, press <Esc> to Enter Monitor.

4. At the Monitor prompt enter B <Enter> to boot the system into RMX.

5. Enter super <Enter> at the login prompt.

6. Enter passme <Enter> at the password prompt.

7. Insert the Starlink V4 floppy.

8. At the RMX prompt enter LOADSUPP <Enter>.

The system responds with:
With the Startup floppy in the drive type
L to LOAD followed by RETURN
E to Exit followed by RETURN....

9. Enter L <Enter>.

The system responds with:
Not the correct Startup Floppy.
Insert any floppy and enter.
L to LOAD followed by RETURN
E to Exit followed by RETURN....

10. Enter L <Enter>.

The system responds with:
SL4 Starlink Supplement V1
O.K.

11. Remove Starlink V4 floppy.

12. Enter sh <Enter> to shut system down.

13. Reboot the system to Starcam by pressing the RESET button.

14. Enter ZSCF 7 <Sendform> to list software present.

15. Verify that the Starlink option is present and that the version is at 4.0.

16. Add the eNTEGRA workstation to the Starlink Configuration file via the 
NAST command
Refer to Section 3.9.3 to get the eNTEGRA’s Ethernet (LAN) address.)
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3.9.5    Starlink Version 3 Upgrade for Starcam Build Standard 0
1. Shut down the Starcam system by entering shutdown <Sendform>.

2. Reboot the system by pressing the following keys together: 
<Ctrl> RIGHT <Shift> <Q>.

3. When prompted, press <Esc> to Enter Monitor.

4. At the Monitor prompt enter B <Enter> to reboot system into RMX.

5. At the RMX prompt enter LOADOPT <Enter>.

6. Insert STARTUP floppy

7. Enter L <Enter>.

8. When prompted, remove STARTUP floppy and insert Starlink V3 Key 
floppy.

9. Enter L <Enter>.

10. Enter C <Enter>.

11. Remove Key floppy and enter E <Enter> to exit back to RMX.

12. Insert CV system floppy.

13. Enter AF :AFD0: <Enter>.

14. Enter s  r’?’load.csd  <Enter> to update the Starlink files.

15. Enter shutdown <Enter> to shut system down.

16. Reboot the system to Starcam by pressing the following keys together:
<Ctrl> RIGHT <Shift> <Q>.

17. Enter ZSCF 7 <Sendform> to list software present.

18. Verify that the Starlink option is present and that the version is 3.05.

19. Add the eNTEGRA workstation to the Starlink Configuration file via the 
NAST command.
Refer to Section 3.9.3 to get the eNTEGRA’s Ethernet (LAN) address.

3.9.6    Starlink Version 4 Upgrade for Starcam Build Standard 1 & 2
1. Refer to the documentation shipped with the H2508JA catalog to upgrade 

Starlink software to Version 4.

2. Add the eNTEGRA workstation to the Starlink Configuration file via the 
NAST command.
Refer to Section 3.9.3 to get the eNTEGRA’s Ethernet (LAN) address.
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3.9.7    Getting the Ethernet Address and names of SP Based Systems

To get the Ethernet addresses, types and names of all the SP based systems 
residing on the ApexNet, type in the Command Line of a remote SP based 
system ETCONFIG and press <Enter>. This results with the following 
display:

LOCAL COMMUNICATION ADDRESS: 00AA000XXXXX
LOCAL WRITE PROTECT (Y/N) : N
STATION ID TYPE COMMUNICATION ADDRESS STATION 
LABEL

N 0 A 00AA0004460B SP1
N 1 A 00AA00044802 HELIX
N 2 A 00AA00034BBC CardiaL

Where:

• The LOCAL COMMUNICATION ADDRESS is the unique Ethernet Address 
of the system (stored in the system's Ethernet Controller Board), 
which consists of a fixed prefix (00AA000) and five variable 
hexadecimal digits (indicated by XXXXX).

• TYPE A refers to an APEX SP system
TYPE G refers to an APEX 400 system.

• The STATION LABEL is the station’s name. 
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3.10    Hardcopy Options

3.10.1    Overview
The eNTEGRA P&R Hardcopy server provides a high resolution, digital, 
multiformatted (n on 1) image for use on Formatters, Lasercameras and Color 
Printers via the:

• SCSI-2 port
• Network port

Table 3-13 summarizes the hardcopy devices that are compatible with 
eNTEGRA P&R, the type of interface used and the sections that contain the 
installation/configuration information for each device.

Note eNTEGRA will only support one SCSI-2 print device.

Table 3-13. Hardcopy Device Interface Matrix

Hardcopy 
Type Device Name eNTEGRA P&R 

Interface Reference

Laser 
Cameras

Imation (3M) P831, 
M952, 959XL, 969HQ 
and DryView.

SCSI-2 via DASM/LCAM Section 3.10.2

Kodak XLP100, 1120 
and 2180

SCSI-2 via DASM/LCAM Section 3.10.3

Dupont Linx Image Q SCSI-2 via DASM/LCAM Section 3.10.4
Fuji SCSI-2 via DASM/LCAM Section 3.10.5
Konica (Li10A & Li20) SCSI-2 via DASM/LCAM Section 3.10.6
Polaroid Helios Network (TCP/IP) Section 3.10.7

Color 
Printers

Codonics NP1600M Network (TCP/IP) Section 3.10.8

PostScript® 
Printers

PostScript® Compatible 
Printer

Network (TCP/IP) or 
Parallel Port

Section 3.10.9

DICOM DICOM Compatible 
Printers

Network (TCP/IP) Section 3.10.10

Note All hardcopy devices interfaced via the SCSI port or network must be configured in 
eNTEGRA using the Config utility.
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3.10.2    Imation (3M) Lasercameras Configuration

3.10.2.1    Overview

This section provides details on how to connect the Imation (3M) family of 
Lasercameras to the eNTEGRA system using the 952 interface and how to 
configure both the eNTEGRA and Lasercamera to produce good quality 
films. This includes the 952, 959, 969 and DryView Lasercameras.

The eNTEGRA hardcopy server sends commands and high resolution digital 
image data to DASM/LCAM over the SCSI-2 bus using the Analogic DASM 
SCSI command set. The DASM/LCAM converts these commands into 952 
commands and a digital image.

The 952 commands (host control) are sent from the DASM/LCAM’s 25–pin 
(female) RS422 port to a UKEIB (Universal Keyboard External Interface 
Box) and then to the Lasercamera’s input module. The UKEIB converts the 
RS422 signals to a Fiber Optic signal, which is then sent to the Lasercamera’s 
input module. Since the RS422 keypad interface on the UKEIB is a 37–pin 
male connector, a 25–pin male to 37–pin female cable is required
(46-296980G1 can be used). 

The DASM/LCAM sends the high resolution digital image data over a
37–pin, 8-bit parallel RS485 interface to a DEIB (Digital External Interface 
Box) and then to the Lasercamera’s input module. The DEIB converts the 
RS485 signals to a Fiber Optic signal which is then sent to the Lasercamera’s 
input module.

Section 3.10.2.2 provides the basic procedure for interfacing/configuring the 
Imation Lasercameras to eNTEGRA.

Section 3.10.2.3 provides details for finding the SCSI Device Number of the 
DASM/LCAM.

Section 3.10.2.4 provides details on interfacing the Imation lasercameras to 
the eNTEGRA. 

Section 3.10.2.5 provides details on configuring the eNTEGRA and the 
Lasercamera for optimal image quality.

Note Due to image quality issues the DASM/VDB interface is no longer being offered.
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3.10.2.2    Basic Procedure

This section provides the basic procedure to interface and configure an 
Imation Lasercamera with eNTEGRA.

1. Verify that the DASM/LCAM is connected/configured properly, and the 
Lasercamera has been added to the eNTEGRA configuration via the 
Configuration utility (refer to Section 3.6 & Section 3.8.4.11 for 
details).
The selected Type in the Printers tab of the eNTEGRA Configura-
tion window should be 3M.
The SCSI Device Number of the DASM/LCAM can be identified as per 
Section 3.10.2.3.

2. Install and connect the host and image data runs between the 
Lasercamera’s input module and the DASM/LCAM. Refer to 
Section 3.10.2.4.

3. Configure the Lasercamera’s input module, the UKEIB and the DEIB for 
communication with the DASM/LCAM. Refer to Section 3.10.2.4.

4. Power up the systems in the following order to assure proper 
synchronization: Lasercamera, UKEIB and DEIB, DASM/LCAM and 
then the eNTEGRA.

5. Log into eNTEGRA, select the Formatter Static image from the 
Default Patient Calibration study, and click the New icon (located on 
the Patient Selector Control Bar). Click the Camera tool in the Display 
Screen. Click the Down Arrow in the Film dialog, select the Imation 
lasercamera and click [Submit].

6. If:

a. No image is printed, refer to Section 8.2 for details on troubleshoot-
ing.

a. An image is printed, analyze the image and determine if additional 
adjustments are required.

7. If:

a. Adjustments will be made via the HCdefaults.win32 file on the 
eNTEGRA system, then edit the specific parameters and powerdown 
the eNTEGRA application. Refer to Section 3.10.2.5.

b. Adjustments will be made via the Lasercamera’s input module, then 
verify that the HCdefaults.win32 file on the eNTEGRA has the 
Density and Contrast parameter set to D before editing the input mod-
ule’s parameters. Refer to Section 3.10.2.5.

8. Repeat steps 5 through 7 until optimal film quality is achieved.

Note After the HCdefaults.win32 file is edited, the eNTEGRA must be completely 
restored (including servers) in order for the changes to take effect.
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3.10.2.3    Finding the SCSI Device Number of the DASM/LCAM

1. Click [Start] on the Task Bar and select Run... to open the Run Window.

2. In the Open input filed type regedit and click [OK].

3. In the Registry Editor window, select the following directory: 
HKEY_LOCAL_MACHINE\HARDWARE\DEVICEMAP\Scsi

4. Scan the Identifier in each Scsi Port X directory (where X is the Port 
Number) as follows:

a. Select the directory Scsi Bus 0\target Id Y\Logical Unit Id 0 
(where Y is the Target ID Number).

b. Check whether the Identifier is ANALOG-LCAM-3M.
5. The Scsi Port with Indentifier = ANALOG-LCAM-3M is the Port 

Number of the DASM/LCAM to be selected as the Physical Drive in 
the 3M Printer Setup window. See Section 3.8.4.11. 
eNTEGRA P&R Service Manual 3-36 Rev. 5
Direction 2263784-100 June 17, 2001



Installation Hardcopy Options
3.10.2.4    Lasercamera Connection

This section provides details on how to interface the Imation Lasercameras to 
the eNTEGRA system via the DASM/LCAM. 

a. Interface Wiring

Figure 3-4 and Table 3-14 detail the interface between the eNTEGRA and the 
Imation Lasercameras using the DASM/LCAM.

Figure 3-4: eNTEGRA to Imation Lasercamera Interconnection via the DASM/LCAM

Table 3-14. DASM/LCAM to Imation Lasercamera Cable 

Cable Description Part #/Source Length Reference

1 Peripheral Tower SCSI 
Cable.

46-325201P5 1 m Section 5.1.3.

2 37–pin LCAM Image 
Data Cable - RS485

Imation 3–10 m Reference 3M 
Service Manual

3 25–pin Male to 37 Pin 
Female RS422 Stub 
Cable

46-296980G1 30 cm

4 3M Keypad Cable - 37 
Pin RS422

Imation 3–10 m

5 Fiber Optic Line (Tx/
Rx) - Image Data

Imation 30–100 m

6 Fiber Optic Line (Tx/
Rx) - Host 
Communication

Imation 30–100 m

Note The Input Modules available on the DryView Lasercameras provide direct 37–pin 
interface connections for both host and image data.
The 952 Lasercameras with MMU use two 37–pin interface connections for both 
host and image data.
Refer to Chapter 5, Section 5.1.3.1 for pinout details on the DASM/LCAM.

DASM/LCAM
1

2

3 4

5

6

120 VAC

UKEIB

DEIB
FIBER OPTIC

FIBER OPTIC

3 - 100 Meters

Imation (3M)
Laser Camera

Input Module
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b. Interface Configuration

The Imation Lasercamera must be configured to communicate with the 
eNTEGRA. Table 3-15 summarizes the configuration parameters required for 
the components in the DASM/LCAM to Imation Lasercamera interface chain.

Note Refer to the Imation/3M Service Manual or Service Representative for details

Table 3-15. DASM/LCAM–Imation Lasercamera Interface Configuration  

Device Parameter Setting

Input Module (Jumper) Fiber Optic Clock Rate 
(Jumper)

10MHz (E2-E3)

Input Module
(Communication 
Parameters)

Baud Rate 1200

Stop Bits 1

Data Bits 8

Parity Even

Parity Enable Enable

Character Pacing 0

End Of Message CR

Protocol ACK/NACK

Memory Full Resp BSY

Command Set 959

Image Size New

Alarm Mode New

P1-P6 0
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Input Module
(System Parameters)

EIB Type Digital

Parameter Set Set 0

OEM GE

Modality Nuclear

Dual Switch Off

Memory Width 9

Pixel Width 8

Requeue Number 3

Media Destination OM0/OM1

Enlarge Format Yes

Input Module
(Digital EIB Parameters)

Parity Enable Enable

Test Pattern No

Header Mode Header

Prescale On

Timeout 20

Request Hold 200

Request Inactive 255

Retransmit Setup 255

Pixels/Line 1024

Image Lines 1024

Pixel Width 8

Parity Even

Port Port 0

UKEIB RS232/RS422 Select (Jumper) RS422

DEIB Fiber Optic Clock Rate 
(Jumper)

10 MHz

Table 3-15. DASM/LCAM–Imation Lasercamera Interface Configuration (Continued) 

Device Parameter Setting
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3.10.2.5    Image Quality Configuration

The 952 command set provides control over a number of image quality 
parameters for the Imation Lasercameras. These parameters are set by either 
the eNTEGRA hardcopy server via the HCdefaults.win32 file or set at the 
Lasercamera’s input module. Table 3-16 provides a summary of these 
parameters.

In most cases the contrast and density will be set using the input module. 
Refer to the Imation/3M Service Manual or Service Representative for 
details. If the needs to be updated refer to the HCdefaults.win32 section 
below.

a. HCdefaults.win32

The HCdefaults.win32 file is a text file that contains the default print 
device parameters for all hardcopy devices supported by the eNTEGRA 
hardcopy server. It is located in the
D:\Einstein\einstein_project\resources directory. Typically the 
HCdefaults.win32 file contains a section for each print device’s parameters. 
The parameters for the 952 compatible Lasercameras start with Prn3m.952, 
are shown in Figure 3-5, Figure 3-6, Figure 3-7, Figure 3-8, Figure 3-9 and 
Figure 3-10, below.

Note The HCdefaults.win32 setting will over ride the input modules setting. 

Table 3-16. Imation Lasercamera Image Quality Parameters

Parameter Description Name in
HCdefaults.win32 Remarks

Contrast Table Specifies a contrast table to use to produce the 
image. The range of the contrast table settings 
are 1 to 30. Table 1 to 15 represent positive 
tables (white on black) and 16 to 30 negative 
tables (black on white). In HCdefaults.win32 a 
setting of D causes the Lasercamera to use the 
setting on the input module.

Prn3m.952.fmt.n.contrasts Each format and 
each zone has a 
separate contrast 
line.

Density Specifies the film density level. The range is from 
1 to 16. In HCdefaults.win32 a setting of D 
causes the Lasercamera to use the setting on the 
input module.

Prn3m.952.density

Boarder Specifies the boarder level. 0 is dark and 255 is 
clear.

Prn3m.952.bdr

Stage Time Out Specifies the delay between staging and 
exercising an image.

Prn3m.stage.timeout

Note The stage time out needs to be set to 20 for the main interface.
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Figure 3-5: HCdefaults.win32 - 952 Lasercamera Section (Part 1)

! protocol “952”
Prn3m.952.bdr: 0
Prn3m.952.interface: Lcam
Prn3m.952.cmd.timeout: 60
Prn3m.952.stage.timeout: 60
Prn3m.952.expose.timeout: 15
Prn3m.952.density: 1
Prn3m.952.Hcp.code_path: /usr/lib/HCP_RPC.out
Prn3m.952.Hcp.unit: 0
Prn3m.952.Hcp.parity_enable: on
Prn3m.952.Hcp.even_parity:  on
Prn3m.952.Hcp.local_loop:   off
Prn3m.952.Hcp.auto_lf:      off
Prn3m.952.Hcp.data_rate:    1200
Prn3m.952.Hcp.stop_bits:    0
Prn3m.952.Hcp.data_bits:    8
Prn3m.952.Hcp.line_term:    CR
Prn3m.952.Hcp.data_interface: digital
!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!
! protocol “952” with the “Lcam” interface
!
Prn3m.952.Lcam.devname:                 /dev/rdsk/c201d4s0
Prn3m.952.Lcam.debug_file: debug.out
Prn3m.952.Lcam.parity_enable: on
Prn3m.952.Lcam.even_parity: on
! with MMU
Prn3m.952.Lcam.data_rate: 1200
! no MMU
!Prn3m.952.Lcam.data_rate: 9600
Prn3m.952.Lcam.stop_bits: 1
Prn3m.952.Lcam.data_bits: 8
Prn3m.952.Lcam.local_loop: off
Prn3m.952.Lcam.auto_lf: off
Prn3m.952.Lcam.line_term: CR
! Digital data interface
Prn3m.952.Lcam.data_interface: digital
! Analog video interface (in ISG)
!Prn3m.952.Lcam.data_interface: analogue
!
Prn3m.952.formats: 1,2,3,4,6,9,12,16,20
!format 1
Prn3m.952.1.desc:       1 on 1 (1 frame on 1 zone)
Prn3m.952.1.zones:      1
Prn3m.952.1.1.frames:   1
Prn3m.952.1.1.width: 1024
Prn3m.952.1.1.height: 1024
Prn3m.952.1.1.contrasts: D
Prn3m.952.1.1.lines: 4800
Prn3m.952.1.1.bdr.lines: 32
Prn3m.952.1.1.hmag: 0
Prn3m.952.1.1.vmag:     0
Prn3m.952.1.1.hmode: 15
Prn3m.952.1.1.vmode: 15
! format 2
Prn3m.952.2.desc:       2 on 1 (2 frames on 1 zone)
Prn3m.952.2.zones:      1
Prn3m.952.2.1.frames:       2
Prn3m.952.2.1.width:        1024
Prn3m.952.2.1.height:       1024
Prn3m.952.2.1.contrasts:    D,D
Prn3m.952.2.1.lines:        4800
Prn3m.952.2.1.bdr.lines:    32
Prn3m.952.2.1.hmag:     0
Prn3m.952.2.1.vmag:     0
Prn3m.952.2.1.hmode:        15
Prn3m.952.2.1.vmode:        15

Edit to change Border

Edit for MMU Interface
Edit to change Density

Edit to chane Contrast (1x1)

Edit to change Contrast (2x1)
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Figure 3-6: HCdefaults.win32 - 952 Lasercamera Section (Part 2)

format 3
Prn3m.952.3.desc:2 on 1 (2 frames in 2 zones)
Prn3m.952.3.zones: 2
! zone 1
Prn3m.952.3.1.frames:       1
Prn3m.952.3.1.width:        1024
Prn3m.952.3.1.height:       1024
Prn3m.952.3.1.contrasts:    D
Prn3m.952.3.1.lines:        2400
Prn3m.952.3.1.bdr.lines:    32
Prn3m.952.3.1.hmag: 0
Prn3m.952.3.1.vmag:    0
Prn3m.952.3.1.hmode:        15
Prn3m.952.3.1.vmode:        15
! zone 2
Prn3m.952.3.2.frames:       1
Prn3m.952.3.2.width:        1024
Prn3m.952.3.2.height:       1024
Prn3m.952.3.2.contrasts:    D
Prn3m.952.3.2.lines:        2400
Prn3m.952.3.2.bdr.lines:    32
Prn3m.952.3.2.hmag: 0
Prn3m.952.3.2.vmag: 0
Prn3m.952.3.2.hmode:        15
Prn3m.952.3.2.vmode:        15
! format 4
Prn3m.952.4.desc:       4 on 1 (2 frames on each of 2 zones)
Prn3m.952.4.zones:     2
! zone 1
Prn3m.952.4.1.frames:       2
Prn3m.952.4.1.width:        1024
Prn3m.952.4.1.height:       1024
Prn3m.952.4.1.contrasts:    D,D
Prn3m.952.4.1.lines:        2400
Prn3m.952.4.1.bdr.lines:    32
Prn3m.952.4.1.hmag: 0
Prn3m.952.4.1.vmag: 0
Prn3m.952.4.1.hmode:        15
Prn3m.952.4.1.vmode:        15
! zone 2
Prn3m.952.4.2.frames:       2
Prn3m.952.4.2.width:        1024
Prn3m.952.4.2.height:       1024
Prn3m.952.4.2.contrasts:    D,D
Prn3m.952.4.2.lines:        2400
Prn3m.952.4.2.bdr.lines:    32
Prn3m.952.4.2.hmag:0
Prn3m.952.4.2.vmag:0
Prn3m.952.4.2.hmode:        15
Prn3m.952.4.2.vmode:        15
!format 6
Prn3m.952.6.desc: 6 on 1 ( 2frames on each of 3 zones)
Prn3m.952.6.zones: 3
! zone 1
Prn3m.952.6.1.frames: 2
Prn3m.952.6.1.width: 1024
Prn3m.952.6.1.height:       1024
Prn3m.952.6.1.contrasts:    D,D
Prn3m.952.6.1.lines:        1600
Prn3m.952.6.1.bdr.lines:    32
Prn3m.952.6.1.hmag:     0
Prn3m.952.6.1.vmag:     0
Prn3m.952.6.1.hmode:        15
Prn3m.952.6.1.vmode:        15

Edit to change contrast (2x1)

Edit to change Contrast (2x1)

Edit to change Contrast (4x1)

Edit to change Contrast (4x1)

Edit to change Contrast (6x1)
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Figure 3-7: HCdefaults.win32 - 952 Lasercamera Section (Part 3)

! zone 2
Prn3m.952.6.2.frames:       2
Prn3m.952.6.2.width:        1024
Prn3m.952.6.2.height:       1024
Prn3m.952.6.2.contrasts:    D,D
Prn3m.952.6.2.lines:        1600
Prn3m.952.6.2.bdr.lines:    32
Prn3m.952.6.2.hmag:     0
Prn3m.952.6.2.vmag:     0
Prn3m.952.6.2.hmode:        15
Prn3m.952.6.2.vmode:        15
!zone 3
Prn3m.952.6.3.frames:       2
Prn3m.952.6.3.width:        1024
Prn3m.952.6.3.height:       1024
Prn3m.952.6.3.contrasts:    D,D
Prn3m.952.6.3.lines:        1600
Prn3m.952.6.3.bdr.lines:    32
Prn3m.952.6.3.hmag: 0
Prn3m.952.6.3.vmag: 0
Prn3m.952.6.3.hmode:        15
Prn3m.952.6.3.vmode:        15
!format 9
Prn3m.952.9.desc:9 on 1 ( 3 frames on each of 3 zones)
Prn3m.952.9.zones:3
! zone 1
Prn3m.952.9.1.frames:       3
Prn3m.952.9.1.width:        1024
Prn3m.952.9.1.height:       1024
Prn3m.952.9.1.contrasts:    D,D,D
Prn3m.952.9.1.lines:        1600
Prn3m.952.9.1.bdr.lines:    32
Prn3m.952.9.1.hmag: 0
Prn3m.952.9.1.vmag: 0
Prn3m.952.9.1.hmode:        15
Prn3m.952.9.1.vmode:        15
! zone 2
Prn3m.952.9.2.frames:       3
Prn3m.952.9.2.width:        1024
Prn3m.952.9.2.height:       1024
Prn3m.952.9.2.contrasts:    D,D,D
Prn3m.952.9.2.lines:        1600
Prn3m.952.9.2.bdr.lines:    32
Prn3m.952.9.2.hmag:0
Prn3m.952.9.2.vmag:0
Prn3m.952.9.2.hmode:        15
Prn3m.952.9.2.vmode:        15
!zone 3
Prn3m.952.9.3.frames:       3
Prn3m.952.9.3.width:        1024
Prn3m.952.9.3.height:       1024
Prn3m.952.9.3.contrasts:    D,D,D
Prn3m.952.9.3.lines:        1600
Prn3m.952.9.3.bdr.lines:    32
Prn3m.952.9.3.hmag:0
Prn3m.952.9.3.vmag:0
Prn3m.952.9.3.hmode:        15
Prn3m.952.9.3.vmode:        15

Edit to change Contrast (6x1)

Edit to change Contrast (6x1)

Edit to change Contrast (9x1)

Edit to change Contrast (9x1)

Edit to change Contrast (9x1)
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Figure 3-8: HCdefaults.win32 - 952 Lasercamera Section (Part 4)

!format 12
Prn3m.952.12.desc: 12 on 1 ( 3 frames on each of 4 zones)
Prn3m.952.12.zones:4
! zone 1
Prn3m.952.12.1.frames: 3
Prn3m.952.12.1.width: 1024
Prn3m.952.12.1.height: 1024
Prn3m.952.12.1.contrasts: D,D,D
Prn3m.952.12.1.lines: 1200
Prn3m.952.12.1.bdr.lines: 32
Prn3m.952.12.1.hmag: 0
Prn3m.952.12.1.vmag: 0
Prn3m.952.12.1.hmode: 15
Prn3m.952.12.1.vmode: 15
! zone 2
Prn3m.952.12.2.frames: 3
Prn3m.952.12.2.width: 1024
Prn3m.952.12.2.height:1024
Prn3m.952.12.2.contrasts: D,D,D
Prn3m.952.12.2.lines: 1200
Prn3m.952.12.2.bdr.lines: 32
Prn3m.952.12.2.hmag: 0
Prn3m.952.12.2.vmag: 0
Prn3m.952.12.2.hmode: 15
Prn3m.952.12.2.vmode: 15
!zone 3
Prn3m.952.12.3.frames: 3
Prn3m.952.12.3.width: 1024
Prn3m.952.12.3.height: 1024
Prn3m.952.12.3.contrasts: D,D,D
Prn3m.952.12.3.lines: 1200
Prn3m.952.12.3.bdr.lines: 32
Prn3m.952.12.3.hmag: 0
Prn3m.952.12.3.vmag: 0
Prn3m.952.12.3.hmode: 15
Prn3m.952.12.3.vmode: 15
!zone 4
Prn3m.952.12.4.frames: 3
Prn3m.952.12.4.width: 1024
Prn3m.952.12.4.height: 1024
Prn3m.952.12.4.contrasts: D,D,D
Prn3m.952.12.4.lines: 1200
Prn3m.952.12.4.bdr.lines: 32
Prn3m.952.12.4.hmag: 0
Prn3m.952.12.4.vmag: 0
Prn3m.952.12.4.hmode: 15
Prn3m.952.12.4.vmode: 15
!format 16
Prn3m.952.16.desc: 16 on 1 ( 4 frames on each of 4 zones)
Prn3m.952.16.zones: 4
! zone 1
Prn3m.952.16.1.frames: 4
Prn3m.952.16.1.width: 1024
Prn3m.952.16.1.height: 1024
Prn3m.952.16.1.contrasts: D,D,D,D
Prn3m.952.16.1.lines: 1200
Prn3m.952.16.1.bdr.lines: 32
Prn3m.952.16.1.hmag: 0
Prn3m.952.16.1.vmag: 0
Prn3m.952.16.1.hmode: 15
Prn3m.952.16.1.vmode: 15

Edit to change Contrast (12x1)

Edit to change Contrast (16x1)

Edit to change Contrast (12x‘1)

Edit to change Contrast (12x‘1)

Edit to change Contrast (12x‘1)
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Figure 3-9: HCdefaults.win32 - 952 Lasercamera Section (Part 5)

zone 2
Prn3m.952.16.2.frames: 4
Prn3m.952.16.2.width: 1024
Prn3m.952.16.2.height: 1024
Prn3m.952.16.2.contrasts: D,D,D,D
Prn3m.952.16.2.lines: 1200
Prn3m.952.16.2.bdr.lines: 32
Prn3m.952.16.2.hmag: 0
Prn3m.952.16.2.vmag: 0
Prn3m.952.16.2.hmode: 15
Prn3m.952.16.2.vmode: 15
!zone 3
Prn3m.952.16.3.frames: 4
Prn3m.952.16.3.width: 1024
Prn3m.952.16.3.height: 1024
Prn3m.952.16.3.contrasts: D,D,D,D
Prn3m.952.16.3.lines: 1200
Prn3m.952.16.3.bdr.lines: 32
Prn3m.952.16.3.hmag: 0
Prn3m.952.16.3.vmag: 0
Prn3m.952.16.3.hmode: 15
Prn3m.952.16.3.vmode: 15
!zone 4
Prn3m.952.16.4.frames: 4
Prn3m.952.16.4.width: 1024
Prn3m.952.16.4.height: 1024
Prn3m.952.16.4.contrasts: D,D,D,D
Prn3m.952.16.4.lines: 1200
Prn3m.952.16.4.bdr.lines: 32
Prn3m.952.16.4.hmag: 0
Prn3m.952.16.4.vmag: 0
Prn3m.952.16.4.hmode: 15
Prn3m.952.16.4.vmode: 15
!format 20
Prn3m.952.20.desc: 20 on 1 ( 4 frames on each of 5 zones)
Prn3m.952.20.zones: 5
! zone 1
Prn3m.952.20.1.frames: 4
Prn3m.952.20.1.width: 1024
Prn3m.952.20.1.height: 1024
Prn3m.952.20.1.contrasts: D,D,D,D
Prn3m.952.20.1.lines: 960
Prn3m.952.20.1.bdr.lines: 32
Prn3m.952.20.1.hmag: 0
Prn3m.952.20.1.vmag: 0
Prn3m.952.20.1.hmode: 15
Prn3m.952.20.1.vmode: 15
! zone 2
Prn3m.952.20.2.frames: 4
Prn3m.952.20.2.width: 1024
Prn3m.952.20.2.height: 1024
Prn3m.952.20.2.contrasts: D,D,D,D
Prn3m.952.20.2.lines: 960
Prn3m.952.20.2.bdr.lines: 32
Prn3m.952.20.2.hmag: 0
Prn3m.952.20.2.vmag: 0
Prn3m.952.20.2.hmode: 15
Prn3m.952.20.2.vmode: 15
!zone 3
Prn3m.952.20.3.frames: 4
Prn3m.952.20.3.width: 1024
Prn3m.952.20.3.height: 1024
Prn3m.952.20.3.contrasts: D,D,D,D
Prn3m.952.20.3.lines: 960
Prn3m.952.20.3.bdr.lines: 32
Prn3m.952.20.3.hmag: 0
Prn3m.952.20.3.vmag: 0
Prn3m.952.20.3.hmode: 15
Prn3m.952.20.3.vmode: 15

Edit to change Contrast (16x1)

Edit to change Contrast (16x1)

Edit to change Contrast (16x1)

Edit to change Contrast (20x1)

Edit to change Contrast (20x1)

Edit to change Contrast (20x1)
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Figure 3-10: HCdefaults.win32 - 952 Lasercamera Section (Part 6)

!zone 4
Prn3m.952.20.4.frames: 4
Prn3m.952.20.4.width: 1024
Prn3m.952.20.4.height: 1024
Prn3m.952.20.4.contrasts: D,D,D,D
Prn3m.952.20.4.lines:960
Prn3m.952.20.4.bdr.lines: 32
Prn3m.952.20.4.hmag: 0
Prn3m.952.20.4.vmag: 0
Prn3m.952.20.4.hmode: 15
Prn3m.952.20.4.vmode: 15
!zone 5
Prn3m.952.20.5.frames: 4
Prn3m.952.20.5.width: 1024
Prn3m.952.20.5.height: 1024
Prn3m.952.20.5.contrasts: D,D,D,D
Prn3m.952.20.5.lines: 960
Prn3m.952.20.5.bdr.lines: 32
Prn3m.952.20.5.hmag: 0
Prn3m.952.20.5.vmag: 0
Prn3m.952.20.5.hmode: 15
Prn3m.952.20.5.vmode: 15

Edit to change Contrast (20x1)

Edit to change Contrast (20x1)
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3.10.3    Kodak Laser Cameras Configuration

3.10.3.1    Overview

This section provides details on how to connect the Kodak family of 
Lasercameras to the eNTEGRA system using the 952 interface, and how to 
configure both the eNTEGRA and Lasercamera to produce good quality 
films. This includes the XLP100, 1120, 2180 Lasercameras.

The eNTEGRA hardcopy server sends commands and high resolution digital 
image data to DASM/LCAM over the SCSI-2 bus using the Analogic DASM 
SCSI command set. The DASM/LCAM converts these commands into the 
952 commands and a digital image.

The 952 commands (host control) are sent from the DASM/LCAM’s 25–pin 
(female) RS422 port to the 15–pin RS422 host communication port (port 1) 
on the Lasercamera’s input module. A MOD42 cable will be required to 
convert from the 25–pin connection on the DASM unit to the 15–pin 
connector on the input module.

The DASM/LCAM sends the high resolution digital image data over a 37–
pin, 8-bit parallel RS485 interface to the Lasercamera’s input module. 

Section 3.10.3.2 provides the basic procedure for interfacing/configuring the 
Kodak Lasercameras to eNTEGRA.

Section 3.10.3.3 provides details on interfacing the Kodak lasercameras to the 
eNTEGRA. 

Section 3.10.3.4 provides details on configuring the eNTEGRA and the 
Lasercamera for optimal image quality.

Note Due to image quality issues the DASM/VDB interface is no longer being offered.
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3.10.3.2    Basic Procedure

This section provides the basic procedure to interface and configure a Kodak 
Lasercamera with eNTEGRA.

1. Verify that the DASM/LCAM is connected/configured properly and the 
Lasercamera has been added to the eNTEGRA Config utility (refer to 
Section 3.6 and Section 3.8 for details).

The Device Type should be set to ISG3m in the Printers tab of the 
Config utility.

2. Install and connect the host and image data runs between the 
Lasercamera’s input module and the DASM/LCAM. This is typically 
done by the Kodak service engineer. Refer to Section 3.10.3.3.

3. Have the Kodak service engineer configure the Lasercamera’s input 
module for communication with the DASM/LCAM. Refer to 
Section 3.10.3.3.

4. Edit the HCdefaults.win32 to add the Kodak model type and edit the 
contrast settings. Refer to Section 3.10.3.3.

5. Power up the systems in the following order to assure proper 
synchronization: Lasercamera, DASM/LCAM and then the eNTEGRA.

6. Log into eNTEGRA, select the Formatter Static image from the 
Default Patient Calibration study, and click the New icon (located on 
the Patient Selector Control Bar). Click the Camera tool in the Display 
Screen. Click the Down Arrow in the Film dialog, select the Kodak 
Lasercamera and click [Submit].

7. If

a. No image is printed, refer to Section 8.2.5 for details on troubleshoot-
ing.

b. An image is printed, analyze the image and determine if additional 
adjustments are required.

8. If

a. The boarder needs to be changed, the HCdefaults.win32 file will 
need to be edited on the eNTEGRA and the servers to be restarted. 
Refer to Section 3.10.3.4.

b. Any other image quality adjustments need to be made, the Kodak ser-
vice engineer will need to edit the parameters on the input module. 
Refer to Section 3.10.3.4.

9. Repeat steps 6 through 8 until optimal film quality is achieved.
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3.10.3.3    Lasercamera Connection

This section provides details on how to interface the Kodak Lasercameras to 
the eNTEGRA system via the DASM/LCAM. 

a. Interface Wiring

Figure 3-11 and Table 3-17 detail the interface between the eNTEGRA and 
the Kodak Lasercameras using the DASM/LCAM.

Figure 3-11: eNTEGRA to Kodak Lasercamera Interconnection via the DASM/LCAM

Table 3-17. DASM/LCAM to Kodak Lasercamera Cable Summary

Cable 
Run Description Part #/Source Length Reference

1 Peripheral Tower SCSI Cable. 46-325201P5 1m Section 5.1.3

2 37 Pin LCAM Image Data Cable - RS485 Kodak 45m Kodak Service Engineer

3 MOD42 Cable. 25 to 15 pin converter. Kodak <1m

4 15 Pin Host Communication Cable - RS422 Kodak 45m

Note Refer to Section 5.1.3.1 for pinout details on the DASM/LCAM.

1

2

3 4

Kodak
Lasercamera

Input Module

DASM/LCAM
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b. Interface Configuration

The Kodak Lasercamera’s input module must be configured to communicate 
with the eNTEGRA.

Table 3-18 summarizes the configuration parameters that need to be set on 
Kodak Lasercamera for the DASM/LCAM interface.

The Kodak Service Engineer will be responsible for setting these parameters 
on the Lasercamera.

Table 3-18. DASM/LCAM to Kodak Lasercamera Interface Configuration (Part 1)

Interface Parameter Setting

Host Communication Baud Rate 1200

Stop Bits 1

Data Bits 8

Parity Even

Parity Enable Enable

Character Pacing 0

End Of Message CR

Protocol ACK/NACK

Host Protocol Type 952

Image Image Size 1024x1024

Parity Enable Enable

Parity even

Pixel Width 8

Horizontal Pixel 
Aspect

1

Vertical Pixel Aspect 1
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c. HCdefaults.win32 Configuration

The HCdefaults.win32 file must be edited in order for the eNTEGRA 
hardcopy server to properly work with a Kodak Lasercamera. The following 
changes need to be made:

• The ISG3m.version parameter must be changed from 3M to 
KODAK.

• The Kodak model must be defined via the ISG3m.model parameter.
• The contrast parameter, Prn3m.952.fmt.n.contrast must be 

changed from D to 20 for a negative image polarity (black on white) 
for each frame definition. Use a value of 5 for positive image polarity 
(white on black).

The following procedure details how to edit the HCdefaults.win32 file for 
Kodak Lasercameras using the notepad editor.

1. Move to the Main screen and click the minimize button.

2. Double click the eNTEGRA Prompt icon on the desktop and type:

CD config <Enter>

3. Type the following to backup the HCdefaults.win32 file:

copy HCdefaults.win32  HCdefaults.win32.org <Enter>

4. Type the following to open the HCdefaults.win32 file using the 
notepad editor:

notepad HCdefaults.win32 <Enter>

5. Type the following notepad command to go to the line containing the 
ISG3m.version parameter:

<Ctrl>+<F> ISG3m.version <Enter>

The cursor will be placed on the ‘I’ of the following line:
ISG3m.version: 3M 

6. Press the › key until the cursor is over the ‘3m’ then overtype by KODAK 
and press <Enter>.

7. Type the following line to enter the model type (valid model types are 
KODAK_100XLP, KODAK_1120, or KODAK_2180):
ISG3m.model: KODAK_<100XLP or 1120 or 2180>

Note Kodak’s implementation of the 952 protocol uses the Prn3m.952.fmt.n.contrast 
parameter only to set the image polarity. Values from 1-15 and D produce a 
positive image polarity (white on black). Values from 16-30 produce a negative 
image polarity (black on white). The film contrast will need to be set on the 
Lasercamera’s input module.
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8. Type the following notepad command to go to the first line containing 
the Prn3m.952.fmt.n.contrast parameter:

<Ctrl>+<F> Prn3m.952.fmt.n.contrast <Enter>

The cursor will be placed on the ‘p’ of the following line:
Prn3m.952.1.1.contrasts:D

9. Press the › key until the cursor is over the ‘D’ then overtype it by 20.

10. Press <F3> to go to the next line containing the 
Prn3m.952.fmt.n.contrast parameter:

11. Repeat steps 9 and 10 until the contrast setting for each frame in each 
format definition is changed. There are a total of 25 frame definitions.

12. Save the changes and quit the notepad editor by selecting:

File → Save
File → Exit

13. Type the following to copy the modified HCdefaults.win32 file in the 
\config directory:

copy HCdefaults.win32 HCdefaults.win32.bak <Enter>

14. Go back to the eNTEGRA Main Screen, click the [X] button, and in the 
System Shutdown dialog, click the [Full] button.

15. Restart the eNTEGRA.

Note Refer to Figure 3-5, Figure 3-6, Figure 3-7, Figure 3-8, Figure 3-9 and
Figure 3-10 in Section 3.10.2.5 for a listing of this section of the HCdefaults.win32 
file. 
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3.10.3.4    Image Quality Configuration

Kodak’s implementation of the 952 protocol differs from that of the standard 
3M Lasercamera. This result in the following differences in image quality 
configuration:

• The Prn3m.952.fmt.n.contrast parameter in HCdefaults.win32 
is only used to set the image polarity. Values from 1-15 and D produce 
a positive image polarity (white on black). Values from 16-30 produce 
a negative image polarity (black on white). 

• The film contrast is set on the Lasercamera’s input module.
• The Prn3m.952.density parameter in HCdefaults.win32 is 

ignored. The film density is set on the Lasercamera’s input module.

Table 3-19 provides a summary of the key parameters to adjust for film 
quality.

Note Refer to the HCdefaults.win32 Configuration in Section 3.10.2.5 for details on 
setting the Prn3m.952.fmt.n.contrast parameter.

Note To set contrast and density values on the Kodak, a Wyse terminal is required.

Table 3-19. Kodak Lasercamera Image Quality Parameters

Parameter Description Where Set Reference

Contrast Specifies a contrast table to 
use to produce the image.

Lasercamera’s 
input module via a 
Wyse terminal.

Kodak Service 
Engineer.

Density Specifies the density setting 
for the film.

Curve Defines the Gamma 
correction curve.

Boarder Specifies the boarder level. 
0 is dark and 255 is clear.

Prn3m.952.bdr 
parameter in the 
HCdefaults.win32 
file.

0 - Black Boarder
255 - Clear Boarder
See 
Section 3.10.3.3 for 
info on editing the 
HCdefaults.win32 
file.
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3.10.4    DuPont Lasercameras Configuration

3.10.4.1    Overview

This section provides details on how to connect the DuPont (Sterling) 
Lasercameras to the eNTEGRA system and how to configure both the 
eNTEGRA and Lasercamera to produce good quality films.

The eNTEGRA hardcopy server sends commands and high resolution digital 
image data to the DASM/LCAM over the SCSI-2 bus using the Analogic 
DASM SCSI command set. The DASM/LCAM converts these commands 
into the 952 commands and a digital image.

The 952 commands (host control) are sent from the DASM/LCAM’s 25–pin 
(female) RS422 port to the 37–pin RS422 host communication port on the 
DuPont Linx Q interface which is referred to as the SID. Since the RS422 
interface on the SID is a 37–pin male connector, a 25–pin male to 37–pin 
female cable is required. (46-296980G1 can be used.) 

The DASM/LCAM also sends the high resolution digital image data over a 
3– pin, 8–bit parallel RS485 interface to DuPont SID.

Section 3.10.4.2 provides the basic procedure for interfacing/configuring the 
DuPont Lasercameras to eNTEGRA.

Section 3.10.4.3 provides details on interfacing the DuPont lasercameras to 
the eNTEGRA. 

Section 3.10.4.4 provides details on configuring the eNTEGRA and the 
Lasercamera for optimal image quality.

Note The DuPont has only been validated using the DASM/LCAM interface.
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3.10.4.2    Basic Procedure

This section provides the basic procedure to interface and configure a DuPont 
Lasercamera with eNTEGRA.

1. Verify that the DASM/LCAM is connected/configured properly and the 
Lasercamera has been added to the eNTEGRA Config utility (refer to 
Section 3.6 and Section 3.8 for details).

The Device Type should be set to ISGdupont_3m.

2. Install and connect the host and image data runs between the SID and the 
DASM/LCAM. This should be done by the Sterling service engineer. 
Refer to Section 3.10.4.3.

3. Configure the SID for communication with the DASM/LCAM. This 
should be done by the Sterling service engineer. Refer to Section 3.10.4.3.

4. Power up the systems in the following order to assure proper 
synchronization; SID, DASM/LCAM and then the eNTEGRA.

5. Log into eNTEGRA, select the Formatter Static image from the 
Default Patient Calibration study, and click the New icon (located on 
the Patient Selector Control Bar). Click the Camera tool in the Display 
Screen. Click the Down Arrow in the Film dialog, select the DuPont 
Lasercamera and click [Submit].

6. If:

a. No image is printed, refer to Section 8.2.5 for details on troubleshoot-
ing.

b. An image is printed, analyze the image and determine if additional 
adjustments are required.

7. Any adjustments for image quality will be made via the SID by the 
Sterling Service Engineer. Refer to Section 3.10.4.4.

8. Repeat steps 5 through 7 until optimal film quality is achieved.
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3.10.4.3    Lasercamera Connection

This section provides details on how to interface the DuPont Lasercamera to 
the eNTEGRA system via the DASM/LCAM. 

a. Interface Wiring

Figure 3-12 and Table 3-20 detail the interface between the eNTEGRA and 
the DuPont Lasercameras using the DASM/LCAM. 

Figure 3-12: eNTEGRA to Dupont Lasercamera Interconnection via the DASM/LCAM

Table 3-20. DASM/LCAM to DuPont Lasercamera Cable Summary

Cable 
Run Description Part #/Source Length Reference

1 Peripheral Tower SCSI 
Cable.

46-325201P5 1 m Section 5.1.3.

2 37 Pin LCAM Image 
Data Cable - RS485

Sterling Sterling Service Engineer

3 25 Pin Male to 37 Pin 
Female RS422 Stub 
Cable

46-296980G1 30 cm GEMS or Sterling

4 37 Pin RS422 Host 
Communication Cable

Sterling Sterling Service Engineer

5 Lasercamera Interface 
(Network or Serial)

Note Refer to Section 5.1.3.1 for pinout details on the DASM/LCAM.

2

43

120 VAC

DASM/LCAM DuPont
Lasercamera

5
Lasercamera Interface1
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b. Interface Configuration

The SID must be configured to communicate with the eNTEGRA.

Table 3-21 summarizes the configuration parameters that need to be set on the 
SID for the DASM/LCAM interface.

The Sterling Service Engineer will be responsible for configuring and 
interfacing the SID.

3.10.4.4    Image Quality Configuration

The 952 protocol image quality parameters defined in HCdefaults.win32 
file are ignored by the DuPont SID. All image quality adjustment should be 
performed by the Sterling Service Engineer.

Table 3-21. DASM/LCAM to DuPont Lasercamera Interface Configuration

Interface Parameter Setting

Host Communications Baud Rate 1200

Stop Bits 1

Data Bits 8

Parity Even

Parity Enable Enable

Character Pacing 0

End Of Message CR

Protocol ACK/NACK

Host Protocol Type 952

Image Image Size 1024x1024

Pixel Width 8

Parity Even

Parity Enable Enable
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3.10.5    Fuji Laser Cameras Configuration

3.10.5.1    Overview

This section provides details on how to connect the Fuji Lasercameras to the 
eNTEGRA system and how to configure both the eNTEGRA and 
Lasercamera to produce good quality films.

The eNTEGRA hardcopy server sends commands and high resolution digital 
image data to the DASM/LCAM or DASM/VDB over the SCSI-2 bus using 
the Analogic DASM SCSI command set. The DASM/LCAM converts these 
commands into the 952 commands and a digital image.

The 952 commands (host control) are sent from the DASM/LCAM’s 25–pin 
(female) RS422 port to the 37–pin RS422 host communication port on the 
Fuji Multiformatter interface. The Multiformatter interface then converts the 
952 commands into a Fuji compatible command set and sends it to the 
Lasercamera. Since the RS422 interface on the Multiformatter interface is a 
37–pin male connector, a 25–pin male to 37–pin female cable is required
(46-296980G1 can be used). 

The DASM/LCAM sends the high resolution digital image data over a 
37–pin, 8–bit parallel RS485 interface to the Fuji Multiformatter interface. 
The Multiformatter interface then converts the digital image into a Fuji 
compatible image format and sends it to the Lasercamera.

Section 3.10.5.2 provides the basic procedure for interfacing/configuring the 
Fuji Multiformatter to eNTEGRA.

Section 3.10.5.3 provides details on interfacing the Fuji Multiformatter to the 
eNTEGRA. 

Section 3.10.5.5 provides details on configuring the eNTEGRA and the 
Lasercamera for optimal image quality.

Note Due to image quality issues the DASM/VDB interface is no longer being offered.
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3.10.5.2    Basic Procedure

This section provides the basic procedure to interface and configure a DuPont 
Lasercamera with eNTEGRA.

1. Verify that the DASM/LCAM is connected/configured properly and the 
Lasercamera has been added to the eNTEGRA Config utility (refer to 
Section 3.6, and Section 3.8 for details).

The Device Type should be set to ISG3m in the Printers tab in the 
Config utility.

2. Install and connect the host and image data runs between the Fuji 
Multiformatter and the DASM/LCAM. This should be done by the Fuji 
Service Engineer. Refer to Section 3.10.5.3.

3. Configure the Fuji Multiformatter for communication with the DASM/
LCAM. This should be done by the Fuji Service Engineer. Refer to 
Section 3.10.5.3.

4. Power up the systems in the following order to assure proper 
synchronization; Lasercamera, Multiformatter DASM/LCAM and then 
the eNTEGRA.

5. Log into eNTEGRA, select the Formatter Static image from the 
Default Patient Calibration study, and click the New icon (located on 
the Patient Selector Control Bar). Click the Camera tool in the Display 
Screen. Click the Down Arrow in the Film dialog, select the Fuji 
Lasercamera and click [Submit].

6. If:

a. No image is printed, refer to Section 8.2.5 for details on troubleshoot-
ing.

b. An image is printed, analyze the image and determine if additional 
adjustments are required.

7. Any adjustments for image quality will be made on the Multiformatter by 
the Fuji Service Engineer. Refer to Section 3.10.5.5.

8. Repeat steps 5 through 7 until optimal film quality is achieved.
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3.10.5.3    Lasercamera Connection

This section provides details on how to interface the Fuji Lasercamera to the 
eNTEGRA system via the DASM/LCAM. 

a. Interface Wiring

Figure 3-13 and Table 3-22 detail the interface between the eNTEGRA and 
the Fuji Lasercameras using the DASM/LCAM. 

Figure 3-13: eNTEGRA to Fuji Lasercamera Interconnection via the DASM/LCAM

Table 3-22. DASM/LCAM to Fuji Lasercamera Cable Summary

Cable 
Run Description Part # / Source Length Reference

1 SCSI 1 to SCSI 2 Cable 46-269566P104 1 m

2 37 Pin LCAM Image Data 
Cable - RS485

Fuji Fuji Service 
Engineer

3 25 Pin Male to 37 Pin 
Female RS422 Stub Cable

46-296980G1 30 cm GEMS or Fuji

4 37 Pin RS422 Host 
Communication Cable

Fuji Fuji 
Service 
Engineer

5 Lasercamera Interface

Note Refer to Section 5.1.3.1 for pin out details on the DASM/LCAM.

1

2

3 4

5
Multiformatter

DASM/LCAM Fuji

120VAC

Lasercamera
 Interface Lasercamera
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3.10.5.4    Interface Configuration

The Fuji Multiformatter must be configured to communicate with the 
eNTEGRA.

Table 3-23 summarizes the configuration parameters that need to be set on the 
Fuji Multiformatter for the DASM/LCAM interface.

The Fuji Service Engineer will be responsible for configuring and interfacing 
the Multiformatter.

3.10.5.5    Image Quality Configuration

The 952 protocol image quality parameters defined in HCdefaults.win32 
file are ignored by the Fuji Multiformatter. All image quality adjustment 
should be performed by the Fuji Service Engineer.

Table 3-23. DASM/LCAM to Fuji Multiformatter Interface Configuration

Interface Parameter Setting

Host Communications Baud Rate 1200

Stop Bits 1

Data Bits 8

Parity Even

Parity Enable Enable

Character Pacing 0

End Of Message CR

Protocol ACK/NACK

Host Protocol Type 952

Image Image Size 1024x1024

Pixel Width 8

Parity Even

Parity Enable Enable
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3.10.6    Konica Lasercameras Configuration

3.10.6.1    Overview

This section provides details on how to connect the Konica Lasercameras to 
the eNTEGRA system and how to configure both the eNTEGRA and 
Lasercamera to produce good quality films.

The eNTEGRA hardcopy server sends commands and high resolution digital 
image data to the DASM/LCAM over the SCSI-2 bus using the Analogic 
DASM SCSI command set. The DASM/LCAM converts these commands 
into the 952 commands and a digital image.

The 952 commands (host control) are sent from the DASM/LCAM’s 25–pin 
(female) RS422 port to the RS422 host communication port on the Konica 
Lasercamera’s input module. Konica’s Service Engineer will need to provide 
any hardware required to interface the 25–pin RS422 line into their input 
module.

The DASM/LCAM also sends the high resolution digital image data over a 
37–pin, 8–bit parallel RS485 interface to the input module.

Section 3.10.6.2 provides the basic procedure for interfacing/configuring the 
Konica Lasercameras to eNTEGRA.

Section 3.10.6.3 provides details on interfacing the Konica Lasercameras to 
the eNTEGRA. 

Section 3.10.6.4 provides details on configuring the eNTEGRA and the 
Lasercamera for optimal image quality.
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3.10.6.2    Basic Procedure

This section provides the basic procedure to interface and configure a Konica 
Lasercamera with eNTEGRA.

1. Verify that the DASM/LCAM is connected/configured properly, the SCSI 
Device Driver has been initialized, the permission for the SCSI Device 
Driver are set properly and the Lasercamera has been added to the 
eNTEGRA configuration (refer to Section 3.6 and Section 3.8 for details).

The Device Type should have been set to ISG3m in the Printers tab in 
the Config utility.

2. Install and connect the host and image data runs between the Konica’s 
input module and the DASM/LCAM. This should be done by the Konica 
service engineer. Refer to Section 3.10.6.3.

3. Configure Konica’s input module for communication with the DASM/
LCAM. This should be done by the Konica service engineer. Refer to 
Section 3.10.6.3.

4. Power up the systems in the following order to assure proper 
synchronization; Konica Lasercamera, DASM/LCAM and then the 
eNTEGRA.

5. Log into eNTEGRA, select the Formatter Static image from the 
Default Patient Calibration study, and click the New icon (located on 
the Patient Selector Control Bar). Click the Camera tool in the Display 
Screen. Click the Down Arrow in the Film dialog, select the Konica 
Lasercamera and click [Submit].

6. If

a. No image is printed, refer to Section 8.2 for details on troubleshoot-
ing.

b. An image is printed, analyze the image and determine if additional 
adjustments are required.

7. Any adjustments for image quality will be made via the input module by 
the Konica Service Engineer. Refer to Section 3.10.6.4.

8. Repeat steps 5 through 7 until optimal film quality is achieved.
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3.10.6.3    Lasercamera Connection

This section provides details on how to interface the Konica Lasercamera to 
the eNTEGRA system via the DASM/LCAM. 

a. Interface Wiring

Figure 3-14 and Table 3-24 detail the interface between the eNTEGRA and 
the Konica Lasercameras using the DASM/LCAM.

Figure 3-14: eNTEGRA to Konica Lasercamera Interconnection via the DASM/LCAM

Table 3-24. DASM/LCAM to Konica Lasercamera Cable Summary

Cable 
Run Description Part #/

Source Length Reference

1 Peripheral Tower SCSI 
Cable.

46-325201P5 1 m Section 5.1.3

2 37 Pin LCAM Image 
Data Cable - RS485

Konica 3–10 m Konica Service 
Engineer

3 25 Pin Male to 37 Pin 
Female RS422 Stub 
Cable

Konica

4 37 Pin RS422 Host 
Communication cable

Konica

Note Refer to Section 5.1.3.1 for pinout details on the DASM/LCAM.

1

2

3 4

DASM/LCAM
Konica

Lasercamera
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b. Interface Configuration

The Konica Lasercamera’s input module must be configured to communicate 
with the eNTEGRA.

Table 3-25 summarizes the configuration parameters that need to be set on the 
input module for the DASM/LCAM interface.

The Konica Service Engineer will be responsible for configuring and 
interfacing Lasercamera.

3.10.6.4    Image Quality Configuration

The 952 protocol image quality parameters defined in HCdefaults.win32 
file are ignored by the Konica Lasercamera. All image quality adjustment 
should be performed by the Konica Service Engineer.

Table 3-25. DASM/LCAM to Konica Lasercamera Interface Configuration

Interface Parameter Setting

Host Communications Baud Rate 1200

Stop Bits 1

Data Bits 8

Parity Even

Parity Enable Enable

Character Pacing 0

End Of Message CR

Protocol ACK/NACK

Host Protocol 
Type

952

Image Image Size 1024x1024

Pixel Width 8

Parity Even

Parity Enable Enable
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3.10.7    Polaroid Helios Lasercamera Installation/Configuration

3.10.7.1    Overview

This section provides details on how to connect the Polaroid (Sterling) Helios 
Lasercameras to the eNTEGRA system and how to configure both the 
eNTEGRA and Lasercamera to produce good quality films.

The eNTEGRA hardcopy server sends commands and high resolution digital 
image data to the Helios via the Nuclear Local Area Network (LAN) using 
the lp command over the TCP/IP network protocol.

Section 3.10.7.2 provides the basic procedure for interfacing/configuring the 
Helios Lasercameras to eNTEGRA.

Section 3.10.7.3 provides details on interfacing the Helios Lasercameras to 
the eNTEGRA. 

Section 3.10.7.4 provides details on configuring the eNTEGRA and the 
Lasercamera for optimal image quality.

Note The Helios Lasercamera requires at a minimum the Primary Ethernet Module. In 
addition, if more the one device will print to the Helios via the network interface, the 
Multiple Ethernet Image Manager software will need to be activated. Contact your 
Helios representative for details.
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3.10.7.2    Basic Procedure

This section provides the basic procedure to interface and configure the 
Helios Lasercamera with eNTEGRA.

1. Obtain an IP Address for the Helios.

2. Verify that the Helios was configured correctly on the eNTEGRA. Refer 
to Section 3.6 for details. 

The Device Type should be set to helios. The IP Address of the Helios 
will also need to be entered.

3. Install and connect the Helios to the Nuclear LAN. This should be done 
by the Sterling Service Engineer. Refer to Section 3.10.7.3.

4. Configure the Helios for communication with the eNTEGRA. This 
includes assigning the Helios’s IP Address, Subnetmask (optional) and 
adding the eNTEGRA’s IP Address to the Helios. This should be done by 
the Sterling Service Engineer. Refer to Section 3.10.7.3.

5. Power up the Helios.

6. Log into eNTEGRA, select the Formatter Static image from the 
Default Patient Calibration study, and click the New icon (located on 
the Patient Selector Control Bar). Click the Camera tool in the Display 
Screen. Click the Down Arrow in the Film dialog, select the Helios 
Lasercamera and click [Submit].

7. If

a. No image is printed, refer to Section 8.2.5 for details on troubleshoot-
ing.

b. An image is printed, analyze the image and determine if additional 
adjustments are required.

8. Any adjustments for image quality will be made via the 
HCdefaults.win32 file. Refer to Section 3.10.7.4.

9. Repeat steps 6 and 7 until optimal film quality is achieved.
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3.10.7.3    Lasercamera Connection

This section provides details on how to interface the Helios Lasercamera to 
the eNTEGRA system via the LAN.

a. Interface Wiring

Figure 3-15 and Table 3-26 detail the interface between the eNTEGRA and 
the Helios.

Figure 3-15: eNTEGRA to Helios Interconnection

b. Interface Configuration

The Helios must be configured to communicate with the eNTEGRA.

Table 3-27 summarizes the configuration parameters that need to be set on the 
Helios. The Helios (Sterling) Service Engineer will be responsible for 
configuring and interfacing Lasercamera. Details can also be found in the 
Helios Service Manual.

Table 3-26. Helios Network Interface Cable Summary

Cable 
Run Description Part #/

Source Reference

1 eNTEGRA CAT 5 cable GEMS Section 5.1.4

2 10 Base–T Transceiver for the Helios Sterling Helios (Sterling) Service Engineer

3 Helios CAT 5 Cable

4 10 Base–T Hub GEMS

1
4

3 2 Helios

10/100 Baste-T
HUB

Table 3-27. Helios Lasercamera Interface Configuration Summary

Parameter Setting

IP Address for Helios IP Address assigned to Helios

Netmask (Optional) Subnet Mask assigned to LAN

Host IP Address eNTEGRA’s IP Address
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3.10.7.4    Image Quality Configuration

The image quality parameters for the Helios are set via the 
HCdefaults.win32 file on eNTEGRA. The HCdefaults.win32 file is a 
text file that contains the default print device parameters for all hardcopy 
devices supported by the eNTEGRA hardcopy server. It is located in the 
D:\einstein\einstein_project\resources directory. Typically the 
HCdefaults.win32 file contains a section for each print device’s parameters.

Figure 3-16 lists the Helios settings in the HCdefaults.win32 file.
Table 3-28 provides a summary of the parameters that can be adjusted. 

The basic procedure for editing the HCdefaults.win32 file along with an 
example can be found in Section 3.10.2.5.

Note Refer to the Helios Service Manual for details on the effect of each parameter on 
image quality.

Table 3-28. Helios Print Device Parameters

Parameter Description Default 
Setting

PrnHelios.curve This parameter defines the gamma curve the Helios uses to produce the 
image. Range is 0 to 40.

17

PrnHelios.brightness This parameter adjusts brightness of the image on the film. Range is -16 to 16. 1

PrnHelios.contrast This parameter adjusts contrast of the image on the film. Range is -16 to 16. 1

PrnHelios.dmin This parameter sets the lower density value. 0.02

PrnHelios.dmax This parameter sets the upper density value. 2.01

PrnHelios.margin These two parameter set the boarder. Choices are ”clear” or ”black”. clear

PrnHelios.seperator clear

PrnHelios.exposure This parameter sets the polarity of the image printed on the film. 
Choices are ”negative” or ”positive”.

negative

CAUTION
Only edit the parameter listed in Table 3-28. Changing other parameters in 
HCdefaults.win32 may cause errors in the hardcopy server.
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Figure 3-16: HCdefaults.win32 – Helios Settings

!-------------------------------------------------------------------
! defaults for “HELIOS” print device
!
PrnHelios.ip_addr: polaroid
!
! Change “clear” to “black” for black borders
!
PrnHelios.margin: clear
PrnHelios.separator: clear
PrnHelios.timeout: 120
PrnHelios.queue: lpHelios
PrnHelios.formats: 1,2,4,6,9
PrnHelios.curve: 17
PrnHelios.brightness: 1
PrnHelios.contrast: 1
PrnHelios.dmin: 0.02
PrnHelios.dmax: 2.01
PrnHelios*orientation: landscape
!
! Change “negative” to “positive” for white on black imaging
!
PrnHelios.exposure: negative
PrnHelios.1.desc: 1-up
PrnHelios.1.orientation: landscape
PrnHelios.1.max_width: 2068
PrnHelios.1.max_height: 2068
PrnHelios.1.min_width: 8
PrnHelios.1.min_height: 8
PrnHelios.1.num: 1
PrnHelios.2.desc: 2-up
PrnHelios.2.orientation: landscape
PrnHelios.2.max_width: 1265
PrnHelios.2.max_height: 1265
PrnHelios.2.min_width: 8
PrnHelios.2.min_height: 8
PrnHelios.2.num: 2
PrnHelios.4.desc: 4-up
PrnHelios.4.orientation: landscape
PrnHelios.4.max_width: 1023
PrnHelios.4.max_height: 1023
PrnHelios.4.min_width: 8
PrnHelios.4.min_height: 8
PrnHelios.4.num: 4
PrnHelios.6.desc: 6-up
PrnHelios.6.orientation: landscape
PrnHelios.6.max_width: 836
PrnHelios.6.max_height: 836
PrnHelios.6.min_width: 8
PrnHelios.6.min_height: 8
PrnHelios.6.num: 6
PrnHelios.9.desc: 9-up
PrnHelios.9.orientation: landscape
PrnHelios.9.max_height: 682
PrnHelios.9.max_width: 682
PrnHelios.9.min_height: 8
PrnHelios.9.min_width: 8
PrnHelios.9.num: 9

Edit to change Border

Edit to change Curve
Edit to change Brightness
Edit to change Constrast

Edit to change Image Polarity

Edit to change Density
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3.10.8    Codonics NP1600M Color Printer Installation/Configuration

3.10.8.1    Overview

This section provides details on how to connect the Codonics Color printer to 
the eNTEGRA system and how to configure both the eNTEGRA and the 
Codonics to produce good quality films.

The eNTEGRA hardcopy server sends commands and high resolution digital 
image data to the Codonics via the Nuclear Local Area Network (LAN) using 
the lP command over the TCP/IP network protocol.

The Codonics Printer requires the following items to communicate with 
eNTEGRA:

• ISG_1 license - 10 character license key (supplied by the vendor).
• snmpd software patch - 3.5" floppy.
• lpd software patch - 3.5" floppy.

Section 3.10.8.2 provides the basic procedure for interfacing/configuring the 
Codonics Printer to eNTEGRA.

Section 3.10.8.3 provides details on interfacing the Codonics to the 
eNTEGRA. 

Section 3.10.8.5 provides details on configuring the eNTEGRA and the 
Codonics for optimal image quality.

Note These items should be provided with the Codonics software. If not, contact 
Codonics.
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3.10.8.2    Basic Procedure

This section provides the basic procedure to interface and configure the 
Codonics Printer with eNTEGRA.

1. Obtain an IP Address for the Codonics.

2. Verify that the Codonics was configured correctly on the eNTEGRA via 
the Config utility. Refer to Section 3.8 for details.

The Device Type should be set to ISGnp1600m. The IP Address of the 
Codonics will also need to be entered.

3. Install Codonics printer per the Codonics Users Manual instructions and 
connect it to the Nuclear LAN. Refer to Section 3.10.8.3.

4. Configure the Codonics for communication with the eNTEGRA. This 
includes assigning the Codonics’s IP Address and Subnetmask to the 
printer. Refer to the Codonics Users Manual and Section 3.10.8.3.

5. Upgrade the Codonics as per Section 3.10.8.4.

6. Log into eNTEGRA, select the Formatter Static image from the 
Default Patient Calibration study, and click the New icon (located on 
the Patient Selector Control Bar). Click the Camera tool in the Display 
Screen. Click the Down Arrow in the Film dialog, select the Codonics 
Lasercamera and click [Submit].

7. If

a. No image is printed, refer to Section 8.2 for details on troubleshoot-
ing.

b. An image is printed, analyze the image and determine if additional 
adjustments are required.

8. Create a text file that contains the Codonics image parameters on the 
eNTEGRA, then send it to the Codonics. Refer to the Codonics Users 
Manual and Section 3.10.8.5.

9. Repeat steps 5 through 7 until optimal film quality is achieved.
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3.10.8.3    Printer Interface

This section provides details on how to interface the Codonics Printer to the 
eNTEGRA system via the LAN.

a. Interface Wiring

Figure 3-17 and Table 3-29 detail the interface between the eNTEGRA and 
the Codonics. 

Figure 3-17: eNTEGRA to Codonics Interconnection

b. Interface Configuration

The Codonics must be configured to communicate with the eNTEGRA. Refer 
to the Codonics Users Manual for details on setting these parameters. Table 3-
30 summarizes the configuration parameters that need to be set on the 
Codonics.

Table 3-29. Codonics Network Interface Cable 

Cable 
Run Description Part #/Source Reference

1 eNTEGRA CAT 5 Cable GEMS Section 5.1.3

2 10 Base–T Transceiver for Codonics Codonics or GEMS Codonics Users Manual

3 Codonics CAT 5 Cable

4 10 Base–T HUB GEMS

1
4

3 2

10/100 Base-T
HUB

Codonics

Table 3-30. Codonics Interface Configuration

Parameter Setting

IP Address for Codonics IP Address assigned to Codonics

Netmask (Optional) Subnet Mask assigned to LAN
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3.10.8.4    Codonics Upgrade

To enable proper communication with the eNTEGRA, the Codonics must be 
upgraded as follows:

1. Ensure that no one is suing the printer.

1. Make sure no-one is using the printer

2. Open a command line window (Start → Programs → Command 
Prompt).

3. Type E: <Enter>, where E: stands for your CD Drive.

4. Type cd \Drivers\Printers\codonics\Patch1.6 <Enter>.

5. Type ftp codonics_IP_Address <Enter> 

6. When prompted, enter:
User Name: your first name
Password: 300

7. Type bin <Enter>. The system responds: 200 Type set to I
8. Type hash <Enter>. The system responds: Hash mark printing On.

9. Type put snmp2-v1.0B1.tar.gz <Enter>. The system responds:
200 PORT command successful.
150 Opening BINARY mode data connection for snmp2-v1.0B1.tar.gz.
################################
226- Installing update
x ., 0 bytes, 0 tape blocks
x ./Install.NP1600, 240 bytes, 1 tape blocks
x ./Reboot.NP1600, 40 bytes, 1 tape blocks
x ./Title.NP1600, 40 bytes, 1 tape blocks
x ./Undo.NP1600, 247 bytes, 1 tape blocks
x ./Verify.NP1600, 11 bytes, 1 tape blocks
x ./snmp2.tar, 642560 bytes, 1255 tape blocks

10. The printer reboots.
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3.10.8.5    Image Quality Configuration

The image quality parameters for the Codonics are set via a User Preference 
file that is associated with the eNTEGRA hostname. The User Preference file 
is a text file that contains the parameter name and the setting. This file can be 
created directly on the Codonics or on the eNTEGRA and then sent to the 
Codonics via the ftp command.

Table 3-31 provides a summary of the key parameters that can be adjusted. 
Refer to the Codonics Users Manual for details on the effect of each 
parameter on image quality.

The procedure for creating the User Preference file on the eNTEGRA and 
sending it to the Codonics is detailed below. Additional information is also 
provided in the Setting User Preferences chapter of the Codonics Users 
Manual.

a. Creating the Codonics User Preference File

The User Preference file can be created using the Notepad editor on the 
eNTEGRA. This file is then sent to the Codonics using the ftp command. The 
following procedure details this process using the Notepad editor and ftp.

1. Click on the minimize icon on the eNTEGRA Main screen.

2. Click Start on the Task bar, select Run, type cmd and click [OK].

3. In the opened Command Line window, type:

 notepad codon.set <Enter>

4. Type the following string and data to enter the GAMMA and MCM 
values:

GAMMA 1.5<Enter>

MCM 12 <Enter>

Table 3-31. Codonics Image Quality Parameters Print Device Parameters

Parameter Description Default 
Setting

GAMMA This parameter allows the user to adjust the lightness/
darkness level of the images. The amount of correction 
is specified by a single value ranging from 0.0 to 10.0.

1.0

MCM MCM stands for Medical Color Matching. It is a set of 
look up tables that adjust the printed output colors to 
more accurately match the output of the CRT monitor. 
LUTs assigned to GEMS are 8, 10, 12 and 14.

N/A
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5. Save the changes and quit the notepad editor by selecting:

File → Save
File → Exit

6. Type the following command string to open an ftp session:

ftp codonics <Enter>

The system responds with:
Name (codonics:username):

7. Type in the eNTEGRA’s hostname for the Name (for example eNTEGRA):

entegra <Enter>

The system responds with:
Name (codonics:username): entegra
331 Use printer #{0-2, 8, 9, 10, 11-99, 100-104 for password.
Password:

8. Type in 0 for the password. The password will not be echoed.

0 <Enter>

The system responds with:
230 User entegra logged in on System Device
ftp>

9. At the ftp> prompt type the following to set file transfer to binary:

bin <Enter>

The system responds with:
200 Type set to I.
ftp>

10. Type the following to transfer the codon.set file to the Codonics:

put codon.set <Enter>

The system should respond with a message indicating the file was trans-
ferred.

11. Type the following to quit the ftp session:

quit <Enter>

12. Open the eNTEGRA icon and send an image to the Codonics.

13. Analyze the image. If further adjustments are required, change the 
GAMMA and MCM values in the codon.set file on eNTEGRA and resent 
it to the Codonics. Repeat as necessary.
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3.10.9    PostScript™ Compatible Printer Installation/Configuration

3.10.9.1    Overview

This section provides general information on interfacing a PostScript™ 
compatible printer to the eNTEGRA system.

The eNTEGRA application utilizes the Window NT system services to send 
printouts to any supported printer device. Although any windows compatible 
printer will work, the best results are achieved using a PostScript compatible 
printer.

The eNTEGRA system interfaces the PostScript printer either through its 
parallel port or the network port, using TCP/IP network protocol.

Section 3.10.9.2 provides the basic procedure for installing a Windows 
PostScript printer to be interfaced to eNTEGRA.

Section 3.10.9.3 provides details on the physical interface between the 
PostScript printer and the eNTEGRA. 

3.10.9.2    Basic Procedure 

The procedure below provides guidelines and an example of installation 
sequence for a windows PostScript compatible printer. There may be some 
variations in the instructions depending on the printer manufacturer. For 
additional information and troubleshooting, refer to the manufacturer’s 
printer documentation.

1. Connect the printer to eNTEGRA (refer to Section 3.10.9.3):

a. If the parallel port interface will be used, connect the printer parallel 
port cable to the eNTEGRA parallel port.

b. If the network interface will be used, connect the printer to the local 
network (refer to the printer documentation). An IP Address will also 
be need for the printer.

2. Install the printer software according to the interface use, as follows:

• Section 3.10.9.2.1 - Software Installation for a Printer Interfaced via 
the Parallel Port on page 3-78.

• Section 3.10.9.2.2 - Software Installation for a Printer Interfaced via 
the Network Port on page 3-78.
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3.10.9.2.1    Software Installation for a Printer Interfaced via the Parallel Port

1. Power down the eNTEGRA.

2. Click on [Start] in the Task Bar, select Setting → Printers.

3. In the opened Printers window, double click on Add Printer.
4. Click on [Next].
5. Check the box next to LPT1 and click on [Next].
6. Insert the printer manufacturer CD into the CD drive and click [Have 

Disk].

7. Click on [Browse], select the appropriate installation file on the CD and 
click on [Open].

8. Click [OK].

9. Select the printer model and click on [Next] three times

10. Check the radio button next to No to avoid printout of test page, and click 
on [Finish] to start the driver installation.

3.10.9.2.2    Software Installation for a Printer Interfaced via the Network Port

1. Power down the eNTEGRA.

2. Click on [Start] in the Task Bar, select Setting → Printers.

3. In the opened Printers window, double click on Add Printer.
4. Click on [Next].
5. Check the box next to LPT1 and click on [Next] (the port will be 

changed later).

6. Insert the printer manufacturer CD into the CD drive and click [Have 
Disk].

7. Click on [Browse], select the appropriate installation file on the CD and 
click on [Open].

8. Click [OK].

9. Select the printer model and click on [Next] three times

10. Check the radio button next to No to avoid printing of test page, and click 
on [Finish] to start the driver installation.

11. When driver installation has been completed, click on [Start] in the Task 
Bar, select Setting → Control Panel.

12. Double click on [Network] and go to the Service tab.
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13. Check that Microsoft TCP/IP Printing service is present. 
If so, skip to Step 22.
Otherwise, proceed to Step 14.

14.  Insert the Window NT CD into the CD drive.

15. Click on [Start] in the Task Bar, and select Setting → Control Panel.
16. Double click on [Network] and go to the Service tab.

17. Click [Add].

18. Select Microsoft TCP/IP Printing and click [OK].

19. Set the path as E:\i386 and click [Continue] to begin installation (E: 
stands for the CD drive).

20. Click [Close].

21. Click [Yes] to restart the system.

22. Click on [Start] in the Task Bar, and select Setting → Printers.

23. Highlight the PostScript printer, press the right mouse button and select 
the Properties entry.

24. Click on the Ports tab.

25. Click [Add Port].
26. Highlight LPR Port and click on [New Port].
27. Type the printer IP address (recorded in the pre–installation checklist) 

as the Server Address.

28. Type PS as the Printer Name and click [OK].

29. Click [Close].

30. Click [OK].
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3.10.9.3    Physical Interface

This section provides details on how to physically interface the PostScript 
Printer to the eNTEGRA system either via the LAN or parallel port.

a. LAN Interface

Figure 3-18 and Table 3-32 detail the interface between the eNTEGRA and 
the PostScript® printer via the LAN. 

Figure 3-18: eNTEGRA to PostScript Printer LAN Interface

b. Parallel Port Interface

Figure 3-19 and Table 3-33 details the interface between the eNTEGRA and 
the PostScript® printer via the eNTEGRA’s parallel port.

Figure 3-19: eNTEGRA to Postscript® Printer Parallel Port Interface

1
4

3 2

10/100 Base-T
HUB

PostScript®
Printer

Table 3-32. PostScript® Printer Network Interface Cable

Cable Run Description Part #/Source Reference
1 eNTEGRA CAT 5 Cable GEMS Section 5.1.3
2 10 Base–T Transceiver for the Printer Customer or GEMS
3 Printer CAT 5 Cable
4 10 Base–T Hub GEMS

Note Refer to PC User’s Guide for information on the location of the eNTEGRA’s parallel port.

1 PostScript®
Printer

To eNTEGRA’s 
Parallel Port

To Printer’s
Parallel Port

Table 3-33. PostScript® Printer Parallel Port Interface Cable Summary

Cable Run Description Part #/Source Reference
1 DB25 to Printer’s Parallel Port Customer Printer’s Documentation
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3.10.10    DICOM Print

3.10.10.1    Overview

This section provides details on how to connect and configure the various 
DICOM printers that eNTEGRA P&R supports. 

The eNTEGRA P&R hardcopy server now supports printing to a DICOM 
Printer (DICOM Print Management SCP) via the local network using the 
TCP/IP network protocol. The hardcopy server represents a single 
Application Entity (AE) that is separate from the one used for image transfer. 
It provides standard conformance to the following DICOM 3.0 SOP Classes 
as a SCU:

• Basic Grayscale Print Management SOP Class.
• Basic ColorPrint Management SOP Class.

DICOM printers are configured in the Printers tab of the eNTEGRA 
Configuration window and the HCdefaults.win32 file in the 
D:\einstein\einstein_project\resources directory. The following 
DICOM printers are validated:

• Imation 8300 (DCMI8300)
• Imation 8700 Print Server (DCMI8700)
• AGFA Drystar 2000 - Colour and Black and White (DCMA2KCL & 

DCMA2KBW)
• Codonics 1660m (DCMcod)

Other DICOM printers may be compatible with eNTEGRA but will need to 
be manually configured. Refer to section Section 3.10.10.5 for details.

Section 3.10.10.2 provides the basic procedure for interfacing/configuring the 
printers to eNTEGRA.

Section 3.10.10.3 provides details on the physical interface between the 
DICOM printers and the eNTEGRA. 

Section 3.10.10.4 provides details on configuring the eNTEGRA and the 
DICOM printer.
eNTEGRA P&R Service Manual 3-81 Rev. 5
Direction 2263784-100 June 17, 2001



Installation Hardcopy Options
3.10.10.2    Basic Procedure

This section provides the basic procedure to interface and configure DICOM 
Printers with eNTEGRA.

1. If necessary, connect the printer to the Nuclear LAN. Refer to 
Section 3.10.10.3.

2. Obtain the following information for the DICOM printer:
a. AE Title (HOSTNAME in upper case)
b. TCP/IP Port # (=104).
c. IP Address

3. Verify that the printer was configured correctly on the eNTEGRA via the 
eNTEGRA Configuration window (Section 3.8.4.11), as follows:

a. The selected Type in the Add\Edit Printer Device window is 
Dicom.

b. The correct Sub Type was selected in the Dicom Printer Setup 
window (either of Imation 8300, Imation 8700, Agfa 2000 color, 
Agfa 2000 B&W or Codonics). 

4. Log into eNTEGRA, select the Formatter Static image from the 
Default Patient Calibration study, and click the Load icon (located on 
the Patient Selector Control Bar). Click the Camera tool in the Display 
Screen. Click the Down Arrow in the Film dialog, select the Dicom 
printer and click [Submit].

5. If

a. No image is printed, refer to Section 8.2.6 for details on troubleshoot-
ing.

b. An image is printed, analyze the image and determine if additional 
adjustments are required.

6. Any adjustments for image quality will be made via the 
HCdefaults.win32 file. Refer to Section 3.10.10.4.

7. Repeat steps 5 through 7 until optimal film quality is achieved.
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3.10.10.3    Printer Interface

This section provides details on how to interface the DICOM Printers to the 
eNTEGRA system via the LAN.

Figure 3-20 and Table 3-34 detail the interface between the eNTEGRA and 
the DICOM Printer. 

Figure 3-20: eNTEGRA to DICOM Printer Interconnection

Table 3-34. DICOM Printer Network Interface Cables

Cable 
Run Description Part #/Source Reference

1 eNTEGRA CAT 5 Cable GEMS Section 5.1.3

2 10 Base–T Transceiver fro printer. Printer Vendor or GEMS Printer User’s Manual

3 Printer’s CAT 5 Cable

4 10 Base–T Hub GEMS

1
4

3 2 DICOM
Printer

10/100 Base-T
HUB
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3.10.10.4    Configuration

The Basic Grayscale and Color Management SOP Classes provide a number 
of configurable parameters for image quality. These parameters are either set 
by the printer or sent by the eNTEGRA. The parameters sent by the 
eNTEGRA are configured in the HCdefaults.win32 file and can be edited 
using the Notepad. In addition to the image quality parameters, the 
HCdefaults.win32 file also contains the settings for the printers AE Title 
and Port #.

Table 3-35 defines the main DICOM parameters that can be edited in the 
HCdefaults.win32 file. Table 3-36 lists the default setting for each of the 
validated printers.

Table 3-35. DICOM Print Parameter Definition

DICOM 
Parameter

eNTEGRA P&R
Hardcopy Server

Parameter
Definition

IP Address ip_address Host name assigned to printer’s IP address on the Hosts Tab of 
the Config utility.

AE Title scp_ae_title DICOM SCP AE Title -The printer’s AE Title
Port # port The printer’s TCP listening port #.
Medium Type medium Hardcopy Medium - PAPER, CLEAR FILM, BLUE FILM
Film Destination destination Destination of Film - MAGAZINE, PROCESSOR
Film Orientation <fmt_num>.orientation LANDSCAPE, PORTRAIT
Film Size ID <fmt_num>.size_id 8INX10IN, 14INX17IN, 10INX14IN, 24CMX24CM, 24CMX30CM
Mag Type <fmt_num>.magnification Magnification Type - REPLICATE, BILINEAR, CUBIC, NONE
Max Density <fmt_num>.max_density Max density - Defined in printer documentation.
Min Density <fmt_num>.min_density Min density - Defined in printer documentation.
Border Density <fmt_num>.boarder_density Density of Boarder - Defined in printer documentation.
Polarity <fmt_num>.polarity NORMAL, REVERSE
Photometric 
Interpretation

<fmt_num>.photmetric_in... RGB - Color, MONOCHROME1 - Black on White (0 pix=white),
MONOCHROME2 - White on Black (0 pix=black)
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Table 3-36. DICOM Print Parameters Default Settings

DICOM 
Parameter

Default Settings

Imation 8300
(DCMI8300)

Imation 8700
(DCMI8700)

Codonics
(DCMcod)

AGFA - Color
(DCMA2KCl)

AGFA - B&W
(DCMA2KBW)

IP Address 
(See Note)

imation imat8700 codicom agfa2k agfa2k

AE Title 3M_8300 3M_PrintServer PRINT_SCP Drystar Drystar
Port # 104 1024 104 104 104
Medium Type CURRENT CURRENT PAPER CLEAR CLEAR
Film 
Destination

PROCESSOR CURRENT PROCESSOR PROCESSOR PROCESSOR

Film Orientation LANDSCAPE PORTRAIT LANDSCAPE LANDSCAPE LANDSCAPE
Film Size ID 8INX10IN 14INX17IN 8INX10IN 8INX10IN 8INX10IN
Mag Type CUBIC CUBIC BILINEAR CUBIC CUBIC
Max Density 300 300 64000 Default Default
Min Density 0 0 0 Default Default
Border Density BLACK BLACK WHITE 200 200
Empty Image 
Dens

BLACK BLACK WHITE 200 200

Polarity REVERSE NORMAL NORMAL NORMAL NORMAL
Photometric 
Interp

MONOCHROME1 MONOCHROME1 RGB RGB MONOCHROME1

Note The IP Address is associated with the host name listed in Table 3-35. The host 
name and IP Address are added to the Hosts Tab of the Config Utility.
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If any parameter needs to be edited use the following steps:

1. Move to the Main screen and click the minimize button on the top–right 
corner of the screen.

2. To enter the Config directory, double click the eNTEGRA Command 
Prompt on the desktop and type:

CD  Config

3. Type the following to backup the HCdefaults.win32 file:

copy HCdefaults.win32  HCdefaults.win32.org <Enter>

4. Type the following to open the HCdefaults.win32 file using the 
notepad editor:

notepad HCdefaults.win32 <Enter>

5. Type the following to go to the line containing the xxxxx parameter:

<Ctrl>+<F> xxxxx <Enter>

The cursor will be set on the first character of the desired line. e.g.,

ISGmfhd.white_set:              0

6. Press the › key until the cursor is over the first character to be changed. 
overtype this character.

7. Save the changes and quit the notepad editor by selecting:

File → Save
File → Exit

8. Type the following to copy the modified HCdefaults.win32 file in the 
\config directory:

copy HCdefaults.win32  HCdefaults.win32.bak <Enter>

9. Go back to the eNTEGRA Main Screen, click the [X] button, and in the 
System Shutdown dialog, click the [Full] button.

10. Restart the eNTEGRA.

Note The AE Title for these printers will most likely need to be changed to match what 
the printer’s local service engineer has set.
To find a specific printers parameters, search on the DCM field for that printer. For 
example, to find the parameters for the Imation8300, search for DCMI8300.
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3.10.10.5    Adding a New Printer

To add a printer that is not currently defined:

1. Add the new printer under the Printers tab in the Config utility, as 
follows:

a. For the Printer Name enter a descriptive name for the printer (no 
Spaces).

b. For the Device Type, enter one of the defined DICOM device types. 
Refer to Table 3-37 for which device type to use.

c. Enter the IP Address of the printer.
2. Open the HCdefaults.win32 file using the Notepad editor as explained 

in Section 3.10.10.4, above. Go to the parameter for the device type 
defined in the step 1.

3. Set the DICOM parameters per the printer’s DICOM conformance 
statement. At a minimum the AE Title and Port # must match the 
printer’s SCP definition. The max and min height/width may also need to 
be changed based on the printer’s conformance statement.

4. Save the changes and quit the notepad editor by selecting:

File → Save
File → Exit

5. Go back to the eNTEGRA Main Screen, click the [X] button, and in the 
System Shutdown dialog, click the [Full] button.

6. Restart the eNTEGRA.

Table 3-37. Default Hardcopy Server Device Type for DICOM Printing

Printer Type
eNTEGRA P&R

Hardcopy Server
Device Type

Monochrome Printer - 8x10 Film DCMI8300

Monochrome Printer - 14x17 Film DCMI8700

Color Printer - 8x10 Media DCMA2KCl
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3.11    InSite Entitlement
1. Double click the iLinq Shell icon residing on the desktop.

2. In the opened window, type configlink –p –v <Enter>. If the following 
error message is displayed, ignore it:

C:/insite/.insiteINFO' does not exist or is empty

3. In the opened window, type iipadmin config <Enter>

Note: should a message window titled NT Type? appear, click [OK] to 
continue.

4. In the opened InSite Interactive Platform Configuration window click 
[ACCEPT] 3 times.

5. Click on the ProDiags tab (all other tabs will automatically come forward 
after necessary confirmation) and set the parameters as follows:

a. On the ProDiags tab, click [DEFAULT]. The system will advance to 
the Device Connection Tab automatically.

b. On the Device Connection tab, select the options applicable to the 
installed modem from the following pull-down lists: 
• Dial Out Prefix: what the customer will have to dial to place a 

call.
• Modem Type: select the currently installed modem from the list. 
• CPU Serial Port Name: select the Port the modem is installed on.
• Dialling Mode: normally Tone.
• Country: the default country is US (Canada). For any other 

country, select from the list. 
• CPU Serial Port Speed: select 57600.
Click [APPLY].

Note: ignore the status bar message: No response from modem. Please 
check hardware installtion.

c. If the Modem Readme window appears, proceed according to your 
modem type, as follows:
• For U.S. Robotics modem, verify that the DIP switch settings 

match the display and click [OK].
• For Motorola, follow the displayed instructions and click [OK].

d. In the Modem Properties window that appears, click [Close].
e. In the Install Modem window click [OK]. 

6. On the InSite Checkout tab:

a. Type in the InSite IP address – the Modem IP address as defined by 
the OLC for the local system.

b. Type in the Router IP address – the SIR IP address which belongs to 
the same subnet as the local system. This is obtained from the network 
administrator or the OLC.

c. Click [CHECKOUT NOW].
eNTEGRA P&R Service Manual 3-88 Rev. 5
Direction 2263784-100 June 17, 2001



Installation InSite Entitlement
d. In the Reboot Needed window, click [OK].
e. Click [Exit] at the bottom right of the InSite Interactive Platform Con-

figuration window.
f. In the Exit Confirmation window, click [OK].

7. Type exit <Enter> in the opened iLinq Shell window.

8. Only for systems with Multitech MT5634ZBA modem, turn OFF the 
modem, wait 5 seconds and then turn it ON.

9. Reboot the System for the changes to take affect.

10. Call the OLC to verify InSite functionality. 
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3.12    Backup
1. Click the [Configuration] button at the left upper corner of the Main 

screen.

2. In the opened User Preferences window, click [Advanced 
Configuration].

3. Click the Archive tab.

4. Click the [Backup...] button.

5. In the Backup destination dialog, click [Backup].

6. When prompted, insert a formatted diskette labeled eNTEGRA 
Configuration Backup into the floppy drive and click [OK].

3.13    Commissioning

3.14    Completion

Table 3-38. System Commissioning Procedure

Steps Time 
(Min.) Reference

Check the Grounding on the 
Isolation Transformer

10

Perform the functional checks 35 Chapter 4
Review Customer Information 
Letter for current Release 
Notes.

Total 45

Table 3-39. Completion Overview

Steps Time (Min.) Reference

Mount Rating Plate(s) 5 Section 3.14.1

Clean Area 5 Section 3.14.2.

Complete Product Locators 5 Section 3.14.3

Total 15
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3.14.1    Rating Plates

3.14.1.1    Description

Each eNTEGRA workstation is delivered with all software and licenses 
loaded onto the workstation. Since software can change independent of any 
hardware modification, the software is serialized with its own rating plate and 
tracked by the Product Locator. This process allows for software only field 
modifications and preserves traceability of software revisions and options at 
each site.

3.14.1.2    Procedure for Units with an Isolation Transformer

For units with an Isolation Transformer, attach the rating plate for the 
eNTEGRA Base Application Software Set Software Option to the side of the 
isolation transformer. See Locating Rating Plate, Figure 3-21.

Figure 3-21: Locating Rating Plate

3.14.1.3    Procedure for Units Without an Isolation Transformer

For units without an Isolation transformer, attach the rating plate for the Basic 
eNTEGRA Application Software Set to the eNTEGRA CD-ROM software 
jewel case.

eNTEGRA Rating
Plate Location
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3.14.2    Cabling
Tidy up all cables paying particular attention to the rear of the Workstation, 
particularly the rear interconnection panel.

External cabling should also receive attention and be neatly finished, using 
cable ties as necessary.

3.14.3    Completing the Paperwork
Complete all Product Locator Cards supplied with the system and options.

Please complete the Installation Audit Form supplied with the unit.

Return together with Installation Card to:

Locator File W-523
General Electric Medical Systems
P O Box 414 
Milwaukee, Wisconsin 53201 USA

   Important If all the Product Locator cards are not returned, then the system will not be 
configured correctly in the Product Locator database. This will result in the manual 
distribution of any software upgrades.
eNTEGRA P&R Service Manual 3-92 Rev. 5
Direction 2263784-100 June 17, 2001



Chapter 4 -   Functional Checks

To verify that the Einstein system is working properly perform the following 
checks:

• Section 4.1 - Checking the Color Maps - on page 4-2
• Section 4.2 - Processing Validation - on page 4-3
• Section 4.3 - Review Template Test - on page 4-5
• Section 4.4 - Checking the Default Hardcopy Device - on page 4-6
• Section 4.5 - Accessing the Optical Drive Archive - on page 4-6, if 

installed
• Section 4.6 - Accessing a Remote Database - on page 4-7, if available
• Section 4.7 - Checking DICOM Transfer - on page 4-7
• Section 4.8 - Checking the OSI Connectivity - on page 4-8
• Section 4.9 - Modem Connectivity Check - on page 4-8 
• Section 4.10 - InSite Operation Check - on page 4-9 
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4.1    Checking the Color Maps
1. Click on the down arrow next to Sort in the control bar of the Patient 

Selector and click the Study Name entry.

2. Select a WB Bone study.

3. Click on the Load icon below the Patient Selector page.

4. Drop down the View menu and select the Screen Format entry.

5. Select a format for displaying 2 whole bodies with 3 static images. 

6. On the Color Maps panel, click the [...] button.

7. In the opened window, select the INVERSE entry to replace map No. 5, 
and click [OK].

8. Apply a different color map to each image.

9. On the Color Maps panel, turn OFF the Color Bar.

10. Click the down arrow on the Color Maps panel and select the All entry.

11. Click the [...] button on the Color Maps panel, select the Hot Iron entry 
and click [OK].

12. Select an image and apply the Hot Iron map.

13.  Click the down arrow on the Color Maps panel and select the Current 
entry.

14. Apply the Default map (GE Colors) to each image

15. Drop down the File menu and select the Exit Card entry.
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4.2    Processing Validation
4.2.1    Checking the Availability of Licensed Options 

1. For each licensed option recorded in the pre-installation check list except 
ECToolbox, select an appropriate dataset(s) from the patient database, 
then verify that the relevant protocol icon is available in the Processing 
tab.

2. For the ECToolbox application, select rest and stress datasets, one of 
which must be gated, click on the ECToolbox icon within the Cardiac 
Category, then click the [Start ECToolbox] button.

3. Click the [Both Rest and Stress Data] button on the Recon tab.

4. If necessary, adjust the Windowing tool for better view of the heart in 
the Rest planar image displayed. If necessary, move the central marker to 
display the left ventricle in the Rest Live Image. Set the reconstruction 
limits on the Rest Planar Image displayed.

5. Click [Proceed] on the control area.
The VLA, HLA and SA obliques for the rest data are created. 

6. When the Stress Planar Image appears in the upper left corner of the 
screen, set the reconstruction limits for the stress data as described in step 
4 above for the rest data. Then click [Proceed] on the control area.

7. When the VLA, HLA and SA obliques for the stress data are created., 
click the [Back] button on the control area.

8. Click the [Stress Gated Data Only] or [Rest Gated Data Only], 
whichever applies to the input data.

9. When the control area displays the prompt Proceed with Current 
Gated Recon Filters?, click [Proceed].

10. When the VLA, HLA and SA obliques are created for the eight gates, 
click on the Process Tab.

11. Click the Process tab and verify the available licenses, as follows:

For the complete ECToolbox license:
a. Verify that both [CEqual Quantification] and [Functional Anal-

ysis] buttons are enabled.
b. Click the [CEqual Quantification] button.
c. Click [Proceed].
d. In the Normal Database window opened, click the gender corre-

sponding to the input data, then click [OK]. 
e. Verify that [Generate 3–D] is enabled.

For CEqual Light licence - verify that the [CEqual Quantification] 
button is enabled.

12. Drop down the File menu and select the Quit entry to quit the protocol.
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4.2.2    Running an Application
For systems with ECToolbox or Cequal Light license, the application has 
been run above.

Only for systems that do not have an ECToolbox or CEqual Light license, run 
the Cardiac SPECT application, as follows:

1. Select a gated rest or stress planar dataset form the patient database.

2. Click the Cardiac SPECT icon residing in the Cardiac Category on the 
Processing tab.

3. Click the [Start Cardiac SPECT] button.

4. Click the available button on the Recon tab, [Rest Data Only] or 
[Stress Data Only], whichever matches your selected input data.

5. If necessary, adjust the Windowing tool for better view of the heart in 
the Rest/Stress Planar Image displayed.
If necessary, move the central marker to display the left ventricle in the 
Rest/Stress Live Image.
Set the reconstruction limits on the Planar Image displayed.

6. Click [Proceed] on the control area.

7. When the VLA, HAL and SA obliques have been created, click the 
[Back] button on the control area.

8. Click the [Stress Gated Data Only] or [Rest Gated Data Only], 
whichever applies to the input data.

9. When the control area displays the prompt Proceed with Current 
Gated Recon Filters?, click [Proceed].

10. When the VLA, HLA and SA obliques are created for the eight gates, 
click on the Process Tab.

11. When the VLA, HLA and SA obliques are created for the eight gates, 
click on the Review Tab.

12. Click on the [Review Obliques] on the Review tab.

The three–planes Rest/Stress obliques are displayed and the Beating 
Slices screen is created in the background.

A progress slider displayed on the control area advanced as the 
generation of the Beating Slices screen progresses. When the Beating 
Slices screen has been generated, the progress slider is replaced by a 
Beating on Click check box.

13. Drop down the File menu and select the Quit entry to quit the protocol.
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4.3    Review Template Test 
1. Select a study.

2. Click on the Load icon below the Patient Selector page.

The screen switches to the Processing & Review screen.

3. On the green Processing card, drop-down the View menu and select the 
Screen Format entry.

4. Click the black square icon in the Screen Format and on the [1x1] 
button in the Multiple Image Format. 
Verify that a single image now fills the screen.

5. Click LINEAR on the Color Maps tool.

6. Drop down the File menu and select the Save Review Template entry.

7. Type-in Test for Template name and click [OK]. 

8. Drop down the File menu and select the Exit Card entry.

9. Click on the Review Template tab in the bottom right part of the screen.

10. Verify that Test appears in the opened Review panel, and is highlighted 
in blue.

11. Click [Start Review Template] and verify that the display is restored as 
saved above (a single image fills the screen with linear color table).

12. Drop down the File menu and select the Exit Card entry.

The screen returns to the Patient Selector.
13. Click the [Delete Template] button in the bottom right corner of the 

Review panel.
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4.4    Checking the Default Hardcopy Device
1. Select a WB Bone study.

2. Click on the Load icon below the Patient Selector page.

3. Click the Printer icon (the 2nd left most icon in the upper left corner of the 
screen).

4. Click the [Submit] button.

5. Check the printout and verify that the processing screen was printed 
correctly.

4.5    Accessing the Optical Drive Archive
1. Click the Archive tab.

2. Click the [Directory] button on the EOD tab (Sony or Pioneer, 
whichever apples).

The list of the optical drive studies is displayed. 

3. Select a study from the local Patient Selector page and click on the 
[Archive] button on the EOD tab.

4. Verify that the selected study was copied from the local archive to the EOD archive.
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4.6    Accessing a Remote Database
To be able to access a remote database for processing and review: 

1. Click on the [Configuration] button in the upper left corner of the Main 
screen.

2. In the opened User Preferences window, click [Advanced 
Configuration...] to open the eNTEGRA Configuration window.

3. Form the Data Base tab, select an on-line remote station and click [OK].

4. At system message You need to restart eNTEGRA for changes to 
take effects, click [OK].

5. Click [Apply] in the User Preferences window.

6. Click [X] icon (the upper left most button on the Main screen).

7. Click [Partial] to exit the eNTEGRA application. 

8. Restart the application by double clicking the eNTEGRA icon on the Desktop.

9. When eNTEGRA is reloaded, select the remote station from the Data 
Source drop-down list on the Patient Selector and verify that the remote 
station’s Patient Selector page is opened.

4.7    Checking DICOM Transfer
1. Click the Network tab.

2. Click on the Search/Fetch tab.

3. Click on [Search/Fetch] Template button.

4. In the opened Search Template window, check the Dicom radio button.

5. Check the desired remote DICOM station.

6. Click the [Search] button.

The local data base of the remote station is displayed.

7. Highlight a study, record its patient name, type and patient ID. Then click 
the [Fetch] button.

8. Verify that the study was copied successfully to your local archive.

9. Highlight this study on the local archive and click the [Delete] button.

10. In the Patient Data Delete dialog, click [Delete Selection] to 
confirm.
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4.8    Checking the OSI Connectivity
1. Click on the Network Tab from the Einstein Main screen.

2. Click on the Search Fetch tab.

3. Click on the [Search/Fetch Template...] button.

4. In the Search Template, check the relevant Search/Fetch type and the 
remote station name.

5. Click the [Search] button.
Verify that the remote station’s studies are displayed in the Search/
Fetch tab.

4.9    Modem Connectivity Check
1. Double click on My Computer icon on the desktop.

2. Double click the Dial-up Networking icon.

3. Click [Dial].
4. In the Connect to Server_Name dialog, type in the user name and 

password for accessing this remote server, and click [OK]

5. The Dialing remote_number message appears.

6. When the connection is established a pop up notifying Verifying user 
name and password appears.

7. If the connection is successful, a Telephone icon appears at the right 
corner of the Task Bar.

8. To end the connection, double click the Telephone icon, and in the 
opened dialog click [Hangup].
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Functional Checks InSite Operation Check
4.10    InSite Operation Check 
1. Double click the iLinq Shell icon on the desktop.

2. At the system prompt, type insite_brouser <Enter>.

3. If the Netscape Navigator window appears, click [No].

The InSite home page application will be displayed, provided that licenses 
were downloaded during checkout. This screen is the launching point for 
InSite Applications for customers.

4. In the Main Screen (HOME), click [Contact GE].
The Contact GE screen is displayed.

5. Type in the problem encountered at the appropriate type-in fields and 
click [SUBMIT].

If all the connections are OK and the On Line Center (OLC) recognizes 
the licenses (sometimes a delay in license processing occurs for in-house 
systems), within 4 minutes a successful screen will be displayed.
Otherwise an error screen will be seen.

In either case, a Customer Message will be seen as a new message on the 
Main Screen Application.
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Chapter 5 -  System Description

The eNTEGRA system is described according to the following breakdown:

• Section 5.1 - Hardware Description on page 5-2 
❍ Section 5.1.1  - System Block Diagram on page 5-2 
❍ Section 5.1.2  - Hardware Components on page 5-3 
❍ Section 5.1.3  - Cabling and Linking on page 5-4
❍ Section 5.1.4  - Sony EOD on page 5-7
❍ Section 5.1.5  - DASM/LCAM on page 5-9

• Section 5.2 - Software Description on page 5-10 
❍ Section 5.2.1  - Software Structure on page 5-10
❍ Section 5.2.2  - License Keys on page 5-12
❍ Section 5.2.3  - Database on page 5-13
❍ Section 5.2.4  - System Accounts on page 5-13
❍ Section 5.2.5  - eNTEGRA Supported Networks on page 5-14
❍ Section 5.2.6  - DICOM on page 5-15
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5.1    Hardware Description

5.1.1    System Block Diagram
The eNTEGRA Processing & Review Station is based on a high performance 
PC, a Sony 21" Color Monitor and Accessories such as a Modem and an 
Erasable Optical Disk (EOD).

The eNTEGRA system supports the DASM and LCAM Digital Lasercam 
Interfaces and the black/white Formatters MFHD and MF96.

Figure 5-1 shows the system’s block diagram.

Table 5-7 lists the hardware components.

Figure 5-1: System Block Diagram
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5.1.2    Hardware Components  

Table 5-1.  Hardware Components

Unit Component Specification

PC Tower Motherboard Pentium III™ Processor

512 Mb RAM

512 Kb Cache

Ultra 2 SCSI Controller 

SCSI-III to SCSI-II Adapter Cable

Enhanced IDE Controller

Soundblaster 16 Audio Interface

25 Pin Parallel Port

Two 9–pin serial ports

Five 32–bit PCI expansion slots

NVIDIA TNT2, 16 MB on-board 
Video 

3Com 905C on-board LAN 
Controller

Hard Drive 18 Gb Ultra 2 SCSI drive

Flexible Disk 1.44 Mb IDE Floppy drive

CD–ROM x48 IDE CDROM

EOD (optional) Sony 4.1 GB

Monitor Type: 19" Color Monitor

Resolution: 1280 x 1024

User Interface Keyboard 101 Key PS/2

Mouse 3-button PS/2

Modem 3Com Currier 
V.Everything

For North America only

Motorola Codex For Europe

Isolation 
Transformer

As per the local Regulatory Kit.

DASM/LCAM Adaptor for old Laser hardcopy 
devices (Kodak, DuPont, Fuji, 
and Konica laser cameras). 
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5.1.3    Cabling and Linking
The cables used with the eNTEGRA system are listed in Table 5-2. The 
numbers in the table refer to the cable numbers in Figure 5-1. 

5.1.3.1    DASM/LCAM Connectors Pin Out

This section provides the pin outs for the connectors and cables used to 
interface the eNTEGRA to a laser printer through the DASM/LCAM.

The pin outs of the 25–pin Connector on the DASM/LCAM Communication 
Cable RS-422 are listed in Table 5-3.

The pin outs of the 37–pin Connector on the DASM/LCAM Image Data 
Cable RS485 are listed in Table 5-4.

The pin assignments of the 25-pin to 37-pin Communication Stub Cable are 
listed in Table 5-5.

Table 5-2.  Cables Listing

# In
Figure 5-1 Description Vendor Part 

No.
GEMS part 

No.
FRU 
Code Length

1 Isolator Transformer Power 
Cable

Supplied with the isolation 
Transformer

1 1.8 m (5.8 ft)

2 Computer Power Cable Supplied with the Computer 1 1.8 m (5.8 ft)

3 Monitor Power Cable Supplied with the Monitor 1 1.8 m (5.8 ft

4 VGA Video Cable Supplied with the Monitor 1 1 m (3.3 ft)

5 Peripheral SCSI Cable 
(SCSI-1 to SCSI-2)

Supplied with DASM/LCAM 
or
Supplied with MFHD

2 1 m (3.3 ft)
1.5 m (4.9 ft)

6

DASM/LCAM Adapter 
Cable terminated by 25-pin 
and 37-pin Connectors 
(Stub Cable)

N/A 46-296980G1 1 0.3 M (1ft)

7 DASM/
LCAMCommunication 
Cable RS-422 (25 pin) 

Supplied with the 
Laserprinter. Refer to the 
Laserprinter’s service manual

N/A N/A

8 DASM/LCAM Image Data 
Cable

Supplied with the 
Laserprinter. Refer to the 
Laserprinter’s service manual

N/A N/A

9 Modem Cable RS-323 Supplied by with the Modem. N/A 2.8 m (9.2 ft)

10 Modem Power Cable Supplied by with the Modem. N/A 3 m (9.6 ft)

11 Modem Phone Cable Customer Supplied N/A N/A

12 Category 5 UTP Cable 2215028-4 1 2 m (6.6 ft)
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Table 5-3.  Pin Outs of the DASM/LCAM Communication RS-422 Cable

25–pin Connector

Pin # Signal

1 Case Ground

2 – 7 No connection

7 Signal Ground

8 RX (+) – Serial Input to DASM (+ diff)

9 TX (+) – Serial output from DASM (+ diff)

10 – 20 No connection

21 RX (-) – Serial Input to DASM (- diff)

22 TX (-) – Serial output from DASM (- diff)

23 – 25 No connection

Table 5-4.  Pin Outs of the DASM/LCAM Image Data RS485 Cable
37–pin Connector

Pin # Signal Pin # Signal

1 – 2 No connection 20 – 21 No connection

3 DGREP (+) – Transmit 22 DGREP (-) – Retransmit

4 DGDAREQ (+) – Data Request 23 DGDAREQ (-) – Data Request

5 DGMODESEL (+) – Mode Select 24 DGMODESEL (-) – Mode Select

6 DGCLK (+)  – Strobe / Clock 25 DGCLK (-)  – Strobe / Clock

7 DGPAR (+) – Parity 26 DGPAR (-) – Parity

8 DATA7 (+) 27 DATA7 (-)

9 DATA6 (+) 28 DATA6 (-)

10 DATA5 (+) 29 DATA5 (-)

11 DATA4 (+) 30 DATA4 (-)

12 DATA3 (+) 31 DATA3 (-)

13 DATA2 (+) 32 DATA2 (-)

14 DATA1 (+) 33 DATA1 (-)

15 DATA0 (+) 34 DATA0 (-)

16 – 19 No connection 35 – 37 No connection
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5.1.3.2    SCSI Address Assignment

Table 5-6 lists the assigned SCSI Addresses for the eNTEGRA Workstation.

Table 5-5.  Pin Assignment of the 25-pin to 37-pin Communication Stub Cable

25–Pin 
Connector 

Pin #

37–Pin 
Connector 

Pin #
Signal

1 – 6 1, 4 – 6 No connection

7 7 Signal Ground

8 20 RX (+) – Serial input to DASM (+ diff)

9 21 TX (+) – Serial output from DASM (+ diff)

10 – 12 8 – 12 No connection

13 13 Signal Ground

14 – 20 14 – 19 No connection

21 2 RX (-) – Serial input to DASM (- diff)

22 3 TX (-) – Serial output from DASM (- diff)

23 – 25 22 – 37 No connection

Table 5-6.  SCSI IDs

SCSI Bus Device SCSI ID

Ultra 2–Wide Internal Hard Drive (System) 0

Ultra–Narrow
(SCSI Adapter)

Optical Disk 1

DASM/LCAM or MFHD or MF96 4
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5.1.4    Sony EOD

5.1.4.1    Jumpers Setting

Before installing the Sony EOD, verify the following jumper settings (see the 
Jumpers Block located on the EOD rear panel, each Jumper consists of two 
pins - Figure 5-2).

• SCSI ID (1 - 3) - from the three jumper pairs used to set the SCSI 
ID, the left most pair should be jumpered, while the two other pairs 
should be empty.

• Termination (11) - Jumpered if the EOD is the last device on the 
SCSI chain

Empty if the EOD is not the last device on the 
SCSI chain

Figure 5-2: Sony EOD - Rear Panel
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5.1.4.2    DIP Switch Setting

Before installing the Sony EOD, ensure that all DIP Switch settings are OFF.

Figure 5-3: Sony EOD DIP Switches
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5.1.5    DASM/LCAM
The DASM/LCAM is an intelligent device that interfaces a 3M laser camera 
to a SCSI bus. The stand alone DASM/LCAM unit attaches to the workstation 
SCSI bus and emulates a SCSI disk drive in both function and form. The 
LCAM takes high-level commands sent from the workstation over the SCSI 
bus and interfaces them to the laser camera RS-485 digital image serial 
interface and RS-422 serial communication interface. In addition, the LCAM 
includes a 12-bit in and 8-bit out Look Up Table, Byte Swap Function, and 
text and outline annotation capabilities. Refer to Figure 5-1.

Figure 5-4: LCAM Block Diagram
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appears to the workstation as a SCSI disk drive responding the SCSI 
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5.2    Software Description
Software Description includes the following 

5.2.1    Software Structure
Figure 5-5 provides a visual view of how the eNTEGRA software is 
structured. 

Figure 5-5: Software Structure
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• Archive Log Server (ArchiveLog), assigned to port 8099, which 
manages the Archive Log Index on the disk.

• Optical Disk Server (Gemod), assigned to port 7070, which manages 
the Optical Disk.

Table 5-7 lists the software contents. 

Table 5-7.  Software Contents

Function Specification

Operating System Microsoft NT 4.0

Application eNTEGRA Processing & 
Review

Networking

DICOM Stations, 
Remote Database, 
Network Printing

TCP/IP over Ethernet 
(IEE802.3)

Starcam Systems
OSI package

SP Systems
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5.2.2    License Keys
There are two main software license keys for the basic eNTEGRA system. 
These are referred to as the Node Locked Licenses:

• iap.base - Main server license.
• pr.3d - Reconstruction server license.

These license keys control access to the proprietary servers in the eNTEGRA 
software. The license keys restrict the use of the eNTEGRA software to a 
specific workstation. This is done by using the license in conjunction with an 
activator plugged into the parallel port.

In addition to the Node Locked licenses, there are nine option license keys 
assigned per Activator ID:

• CEqual™ or CEqual™ Light
• ECToolbox™ or ECToolbox™ Upgrade
• QGS™ (Quantitative Gated SPECT)
• QPS™ (Quantitative Perfusion SPECT)
• Tl201 Database Upgrade 
• QuantEM™
• Aladdin™ Compose and Edit
• PefrSPECTive™ (3D Volume Rendering)
• Remote Connectivity
• CT/MR DICOM Storage
• Interactive Reconstruction 
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5.2.3    Database
The eNTEGRA system uses a custom database. Currently there are no simple 
tools available to access the database outside the eNTEGRA application.

The database resides in the D:\Database directory and has a capacity of 2.3 
GB.

The eNTEGRA application accesses the database via the database server. 

5.2.3.1    Database Structure

• Patient
• Study
• Series
• Data Set
• Multiframe Image
• Curves
• ROI
• Templates

5.2.4    System Accounts
Table 5-8 lists the accounts and associated passwords defined on the system.

Table 5-8.  Default Passwords

Account Definition Password

administrator eNTEGRA Super User account.
Used for maintaining the system.

Customer defined

eNTEGRA The eNTEGRA P&R user account. default: eNTEGRA

insite Insite account. Used by OLC to remotely 
log in to system.

TBD
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5.2.5    eNTEGRA Supported Networks
There are two separate network protocols provided:

• TCP/IP - a standard network protocol suite included with the NT 
workstation used for:
❍ DICOM communication
❍ eNTEGRA Remote Database
❍ Interfile file transfers
❍ Insite remote connectivity
❍ Network printing.

• Starlink - a customized network protocol suite based on the OSI 
model. It allows the eNTEGRA system to communicate over the 
Starlink network. This is now a purchased option for the system.

Compatibility

StarLink is only compatible with Starcam systems running Starlink 
Version 4. This is a new version of Starlink that was developed 
specifically to interface Starcam system to eNTEGRA. The following 
systems are compatible: 
❍ Starcam/Star 2000, 3000, 3200, 4000, 3200i, and 4000i.
❍ Camstar 2000, 3200, 3200i, and 4000i.
❍ Maxxus/Optima (4000i)
❍ Starcam/Star II - Build Standard 1 and 2 only.
❍ M-link Version 2.0 from MedImage.
❍ GE Starlink Agent from Evergreen Technologies.

StarLink provides the following communication actions over the 
Starlink network:
❍ Search, fetch and send patient data from Starcam based systems 

running Starlink Version 4.
❍ Receive patient data sent from Starcam based systems running 

Starlink Version 4.
❍ Send patient data to a Starcam based systems running Starlink 

Version 4.

The following are the know compatibility issues and limitations of 
StarLink for the eNTEGRA system:

❍ Due to hardware limitations Starlink Version 4 is not compatible 
with Build Standard 0 Starcam systems or Starport systems. 
Therefore these system will not be directly compatible with either 
the eNTEGRA system or Starcam systems upgraded to Starlink 
Version 4. A Starport Gateway was developed to address this 
problem.

❍ P-Link systems can not send data directly to eNTEGRA. P-Link 
data must first be sent to a Starcam system and then to the 
eNTEGRA.
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5.2.6    DICOM
The eNTEGRA system contains a DICOM server. To describe the 
functionality of the DICOM server the following terms will be used:

• Application Entity (AE): This is a networking term used to define a 
program that provides a specific application. In DICOM, this is the 
server or servers that provide the DICOM services. The server name is 
referred to as the AE Title.

• Service Object Pair (SOP) Class: This defines the functionality of the 
AE. The SOP Class is a combination of a Information Object (i.e. 
Nuclear Image) and a DICOM Message Service Element (DIMSE). 
For example the Nuclear Storage SOP Class combines the Nuclear 
Image Object and the C-Store DIMSE. This SOP Class allows the 
DICOM server to send or receive a Nuclear image depending on it 
service role.

• Service Class User (SCU): This is the client role definition for the AE. 
If a system supports the Nuclear Storage SOP Class in the SCU role, it 
can send a Nuclear Image to a remote system.

• Service Class Provider (SCP): This is the server role definition for the 
AE. If a system supports the Nuclear Storage SOP Class in the SCP 
role, it can receive a Nuclear Image sent from a remote system.
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The Service Object Pair (SOP) Classes which the eNTEGRA P & R's 
DICOM Application Entity (AE) supports for both the SCU and SCP role are 
listed in Table 5-9.

Table 5-9.  SOP Classes Supported for the SCU and SCP Role 

AE ROLE SUPPORTED SOP CLASS FUNCTIONALITY

SCU Nuclear Storage SOP Class Images from the database can be 
sent to a system that supports the 
Nuclear Storage SOP Class in the 
SCP role.

Secondary Capture Storage 
SOP Class

Images created by the screen save 
tool can be sent to a systems that 
supports the Secondary Capture 
Storage SOP Class in the SCP role.

Patient/Study Root Query 
SOP Class

Allows eNTEGRA to query the 
database of a remote systems that 
supports the Patient/Study Root 
Query SOP Class in the SCP role.

Patient/Study Root Fetch 
SOP Class

Allows eNTEGRA to Fetch images 
from a remote systems that supports 
the Patient/Study Root Fetch SOP 
Class in the SCP role. The only 
images types eNTEGRA can fetch 
are ones that are defined by in it's 
SCP role. These include Nuclear, Ct, 
MR and Secondary Capture.
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SCP Nuclear Storage SOP Class Nuclear images can be received and 
stored in the database from a system 
that supports the Nuclear Storage 
SOP Class in the SCU role.

Secondary Capture Storage 
SOP Class

Secondary Capture images can be 
received and stored in the database 
from a system that supports the 
Secondary Capture Storage SOP 
Class in the SCU role.

CT Storage SOP Class CT images can be received and 
stored in the database from a system 
that supports the CT Storage SOP 
Class in the SCU role.

MR Storage SOP Class MR images can be received and 
stored in the database from a system 
that supports the MR Storage SOP 
Class in the SCU role.

Patient/Study Root Query 
SOP Class

Allows remote systems that supports 
the Patient/Study Root Query SOP 
Class in the SCU role to query the 
database.

Patient/Study Root Fetch 
SOP Class

Allows remote systems that supports 
the Patient/Study Root Fetch SOP 
Class in the SCU role and the Nuclear 
Storage SOP Class or Secondary 
Capture Storage SOP Class in the 
SCP role to retrieve image data from 
the database.

Table 5-9.  SOP Classes Supported for the SCU and SCP Role  (Continued)

AE ROLE SUPPORTED SOP CLASS FUNCTIONALITY

Note
DICOM is now the preferred communication protocol between the cameras GENIE 
Acquisition and Millennium VG and the eNTEGRA P&R system. 

Note
Processing and review of data on remote eNTEGRA/Genie P&R systems is carried 
out directly in the remote data base.
On the other hand, transfer of data between eNTEGRA P&R systems or between 
eNTEGRA and GENIE P&R systems is carried out via DICOM.
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In order for the eNTEGRA P&R to send data via DICOM, the AE parameters 
for that system must be configured on the sending eNTEGRA P&R.
Table 5-10 provides a list and description of the required AE parameters.

To enable the local eNTEGRA system to query and fetch from a remote 
system via DICOM, the above AE parameters for the local system must be 
configured on the remote system. 

DICOM configuration on the local eNTEGRA P&R activated using the 
[Config] button on the Patient Selector.

Table 5-10.  AE Parameters

AE PARAMETER DESCRIPTION

System Name This is the name that identifies the system at the user 
level (aui). Typically the host name is used but a more 
descriptive name can be used. The system name can 
contain a maximum of 12 characters using only a-z, A-
Z, 0-9, or "_".

AE Title This defines the system at the DICOM server level. 
Check the system's DICOM Conformance statement for 
this parameter.

IP Address This is the IP Address of the remote system.

Port # This is the TCP listening port of the system. It is used 
by the DICOM server to establish the TCP connection. 
Check the system's DICOM Conformance statement for 
this parameter.
eNTEGRA P&R Service Manual 5-18 Rev. 5
Direction 2263784-100 June 17, 2001



System Description Software Description
Table 5-11 lists the settings of these AE parameters for GENIE Acquisition, 
Millennium VG and eNTEGRA P&R.

Table 5-11.  DICOM AE Parameters for eNTEGRA, Millennium VG, Genie P&R and 
Genie Acq. 

DICOM Field eNTEGRA P&R Millennium VG Genie 
Acquisition Genie P&R

Station Name Host name or 
descriptive 
name contain 
max 12 
characters 
using only a-z, 
A-Z, 0-9, or "_".

Host name 
containing max 
10 characters 
without spaces 
between them. 
The first 
character must 
be an a - z 
letter.

Host name or 
descriptive 
name contain 
max 12 
characters 
using only a-z, 
A-Z, 0-9, or "_".

Host name or 
descriptive 
name contain 
max 12 
characters 
using only a-z, 
A-Z, 0-9, or "_".

AE Title Host name in 
upper case. 
(ENTEGRA)

As assigned by 
the network 
administrator 
Case Sensitive

Host name in 
upper case. 
(GENIEACQ)

Host name in 
upper case. 
(GENIE)

IP Address System's 
assigned IP 
Address

System's 
assigned IP 
Address

System's 
assigned IP 
Address

System's 
assigned IP 
Address

Port # 104 104 2030 2030
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Chapter 6 - Software Installation

6.1    Overview
This chapter provides detailed instructions for installing the basic software of 
the eNTEGRA system as well as its available options. The instructions 
contained herein are provided in three sections as follows:

• Software Load From Cold For Dell OptiPlex GX200 on page 6-2 – 
includes instructions for installing the basic eNTEGRA software on 
the Dell OptiPlex GX200 computer.

All data currently on the system will be lost, including the eNTEGRA 
database and all configuration parameters.

For installing the software on the HP Kayak, refer to 
Appendix B.

For installing the software on the Dell 610, refer to  
Appendix C.

• Software Load from Warm on page 6-26 – provides instructions for 
re–installing the eNTEGRA application. It preserves the installed 
database and all the configuration parameters. It is mainly used for 
software upgrade purposes.

• Installing eNTEGRA Software Options and Licenses on page 6-27 – 
provides instructions for installing various eNTEGRA options, as 
well as licences for eNTEGRA applications.
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6.2    Software Load From Cold For Dell OptiPlex GX200

6.2.1    Overview
This chapter provides detailed instructions for installing the basic software of 
the eNTEGRA system on the Dell OptiPlex GX200 computer, referred to as 
software load from cold.

Software load from cold is used when the hard disk is corrupted or replaced, 
and the entire package must be installed from scratch.

6.2.1.1    Time Required

The time required to complete the installation of the basic software is 
1.5 hours (about 90 minutes).

CAUTION
Load from cold is a destructive procedure and all the data on the disk will 
be lost.
Verify that all patient data is backed up.
Back up the Archive Log Index directory (C:\ArcLog) before starting the 
software load from cold procedure.
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6.2.1.2    Procedure Overview

The load from cold procedure consists of the following steps, to be performed 
in the given order:

The load from cold procedure consists of the following steps, to be performed 
in the given order:

1. Disconnecting Existing Optical Disk Drives (if Applicable) on page 6-4 

2. Setting the System BIOS on page 6-4 

3. Installing the Windows NT Operating System on page 6-5, including disk 
partitioning and formatting Drive C:

4. Installing Windows NT Networking on page 6-7 

5. Installing Service Pack 6a on page 6-10 

6. Installing the Display Driver on page 6-11 

7. Adjusting the Display Properties on page 6-12 

8. Installing the Sound Driver on page 6-13 

9. Setting System Options on page 6-13 

10. Installing Internet Explorer 5 on page 6-15 

11. Installing RAS, Modem and TCP/IP Printing on page 6-16 

12. Installing the FTP Service on page 6-18 

13. Formatting Drive D: as NTFS on page 6-19 

14. Installing the eNTEGRA Application and Its Accessory Components on 
page 6-20 

15. InSite Installation on page 6-21 

16. Installing eNTEGRA Software Options and Licenses on page 6-27 

17. Configuring the system, as per Section 3.8 on page 3-14.

18. Configuring the Network, as per Section 3.9 on page 3-28.

19. Configuring the Hardcopy Devices, as per Section 3.10 on page 3-33.

20. Performing the Functional Checks detailed in Chapter 4.
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6.2.2    Disconnecting Existing Optical Disk Drives (if Applicable)
1. Shutdown eNTEGRA and the computer, if needed.

2. Remove the computer cover, referring to your PC Guide.

3. Disconnect the DC power cable and the SCSI flat cable from the optical 
drive.

4. Reassemble the computer cover.

6.2.3    Setting the System BIOS 
1. Turn ON the computer.

2. When the Dell screen appears, press <F2> as prompted on the upper right 
corner of the screen.

3. Scroll to the Boot Sequence entry and press <Enter>.

4. Use the down arrow key to highlight IDE CD-ROM Device and then 
move it to the first line in the dialog, using the <–> /<+> key on the 
numeric keypad.

5. Press <Esc> to close the dialog.

6. Verify:

Primary Drive 0 – OFF
Primary Drive 1 – OFF
Secondary Device 0 – ON
Secondary Device 1 – OFF

7. Press <Esc>.

8. Select Save Changes and Exit and press <Enter>.

9. Proceed to Installing the Windows NT Operating System on page 6-5.
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6.2.4    Installing the Windows NT Operating System
1. Turn ON the system and immediately insert the NT Installation CD.
2. When the words Windows NT Setup appear at the top of the screen, 

press <F6> repeatedly until the full Windows NT Setup screen appears 
and the white line at the bottom of the screen shows the option 
S=Specify Additional Device.

3. Press <S>. The SCSI Adapter list appears with Other selected.
4. Press <Enter> and insert the diskette labeled SCSI Driver 294xU2 for 

NT 4.0 into the floppy drive.
5. Press <Enter> again. The list of SCSI Adaptec AHA adapters appear 

with the last item selected (Adaptec-294xU2/295xU2/395xU2/AIC-
789x PCI SCSI Controller).

6. Press <Enter> once again. The system loads the driver and it is added to 
the list of mass storage devices whose support is to be loaded.

7. Press <Enter> to initiate file loading. 
8. When the ’Welcome to Setup’ screen appears, press <Enter> to continue.
9. When prompted, press <Enter> twice to continue.
10. In the opened licence Agreement page, scroll down to the bottom 

using the <PgDw> key, and press <F8>.
11. If the disk does not have NT installed, a message is displayed; press <Enter>.

Otherwise (the disk already has NT installed) a message is displayed. 
a. Press <N> = New, to reinstall NT. 
b. Press <Enter>
c. Press <D> = Delete to delete the current partition.
d. Press <Enter>
e. Press <L> = Delete.
f. If there is an additional partition, press the <↓> key to highlight it and 

repeat the procedure to delete this partition (press D then press 
<Enter> and press L).

12. Upon the message Create the following partitions in the (whole 
disk) unpartitioned space:
If any partitions exist, delete them as follows:

a. Select the partition and press <D>, <Enter>, <L>.
b. If there is an additional partition, press the <↓> key to highlight it and 

repeat the procedure to delete this partition (press D then press 
<Enter> and press L).

Otherwise:
a. Press <C> to create a new partition.
b. Delete the number displayed by pressing <Backspace>.
c. Type 3000 and press <Enter>. 
d. While the 1st partition is highlighted, press <Enter> to install Win-

dows NT on drive C:
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13. Install Windows NT as follows:

a. In the opened dialog, use the <↓> key to highlight the line Format 
using NTFS and press <Enter>.

Drive C: will be formatted. It may take several minutes.
b. When prompted, press <Enter> twice to start copying the NT files.
c. Upon system prompt, remove the Windows NT CD and the floppy.
d. When prompted, press <Enter> to reboot.

14. After reboot, the installation continues followed by another automatic 
reboot.

15. When prompted, insert the NT installation CD into the CD drive and 
click [OK].

16. Proceed to Installing Windows NT Networking on page 6-7.
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6.2.5    Installing Windows NT Networking
1. In the Windows NT Setup window, click [Next] to continue.

2. In the opened Setup Options window, select Typical and click [Next].
3. In the opened Name and Organization window, type–in your 

site_name and organization_name and click [Next].
4. In the Registration window, type–in your product_ID (recorded on the 

provided manual) and click [Next].
5. When prompted, type–in your computer name, as defined in the pre–

installation checklist, and click [Next].
6. When prompted, type–in your password, as defined in the pre–

installation checklist (the following description will use the password 
elgems).

7. Retype the password and click [Next].
8. When prompted, select no, do not create an emergency repair 

disk, and click [Next].
9. In the opened Windows NT Components dialog, select “Install the 

most common components” and click [Next].
10. Upon the message “Installing Windows NT networking”, click 

[Next].
11. Check  “Do not connect this computer to a network at this time” 

and click [Next].
12. Click [Finish] to finish setup.
13. In the opened Date/Time Properties window:

a. Set the appropriate date and time in the Date & Time page.
b. Click the Time Zone tab, click on the down arrow to display the 

Time Zone list, select the appropriate Time Zone and click [OK].
c. Click [Close]. 

14. If the system finds the video adapter, click [OK], then click [Cancel] for 
Video card driver installation, which will be installed later. 

15. When asked to restart the computer, remove the Windows NT CD and 
press the [Restart] button.

16. When prompted, press <Alt> + <Ctrl> + <Del> and login into the system with:
User Name: Administrator
Password: elgems

17. Click <OK>.
18. In the Welcome screen that is opened, click [Close].

19. Insert the eNTEGRA Application CD into the CD-ROM drive.

Note
As long as the display driver is not installed, an Invalid Display Settings error 
message will be displayed after each reboot. Click [OK] and ignore the message. 
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20. Double click: My computer → (D:) drive (CD-ROM Drive) → Drivers 
→ DELLGX200_DRIVERS.exe.

21. When the system prompts Extracting completed, click [OK]

22. Click with the right mouse button on the Network Neighborhood icon 
on the desktop.

23. Click on the Properties entry.

24. Click [Yes] to confirm that networking is to be installed. 

25. Click [Next] 
26. Click on [Select From List...].
27. In the Select Network Adapter window, click on [Have Disk...]
28. Type–in the path C:\Drivers\3Com.

29. Click [OK] twice.

30. Click [Next] 4 times. 

31. Remove the eNTEGRA CD and insert the Windows NT CD. 

32. wait for the Windows NT CD to open and close it.

33. In the Windows NT Setup window, type in the path: D: and click 
[Continue]. 

34. Upon the message “If there is a DHCP...” click [NO].

35. In the opened Microsoft TCP/IP Properties window, click the IP 
Address tab, and:

a. Type–in your IP address (as defined in the pre–installation 
checklist).

b. If relevant, type–in your Subnet Mask.
c. If relevant, type–in your Default Gateway address (as defined in 

the pre–installation checklist)
36. If relevant, click the DNS tab, and type–in the DNS IP address (defined 

in the pre–installation checklist)
37. If relevant, click the WINS tab, type–in the Windows Server primary and 

secondary IP addresses (defined in the pre–installation checklist)
38. Click [OK] at the bottom of the page.

39. Upon system prompts, click [Next], [Next], [Next] and [Finish].

40. When queried to shutdown, remove the Windows NT CD from the drive 
and click [Yes].

41. When prompted, press <Alt> + <Ctrl> + <Del> and login as follows:
User Name: Administrator
Password: elgems

42. Click [OK].
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43. Define the users as follows:

a. Click the [Start] button on the Task Bar at the bottom of the screen 
and select Programs → Administrative Tools → User Manager.

b. In the User Manager window, click on User in the Menu Bar and 
select the New User entry.

c. Uncheck “User Must Change Password at Next Logon”.
d. Click the checkbox next to “Password Never Expires”.
e. Click the [Groups] button.
f. In the Group Memberships window, click Administrators (if not 

already highlighted) and then click the [<Add] button. The    Admin-
istrators entry moves from the Not member of list to the Member 
of list.

g. Click [OK]. 
h. In the New User window enter:

Username: entegra
Password: entegra
Confirm Password: entegra

i. Click [OK] again.
j. Close the User Manager window. 

44. Click the [Start] button on the Task Bar at the bottom of the screen and 
select Shutdown the system.

45. In the Shut Down window, select “Close all programs and log as a 
different user?”, then click [Yes]. 

46. When prompted, press <Alt> + <Ctrl> + <Del> and login into the system 
with:

Username: entegra
Password: entegra

47. Click [OK].

48. In the opened Welcome window click [Close].

49. Proceed to Installing Service Pack 6a on page 6-10.
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6.2.6    Installing Service Pack 6a
This installation depends on the language being used.

1. For English version: Insert the eNTEGRA Application CD into the CD 
Drive and double click the My Computer icon located on the desktop.

For other languages: Insert the eNTEGRA Accessories Software CD 
into the CD Drive and double click the My Computer icon located on 
the desktop.

2. Double click the (D:) drive (CD–ROM Drive).

3. Double click the SP6 directory.

4. For the English version, skip to step 5, below.
For other languages, double click the applicable language directory.

5. Double click SP6ai386.exe.

6. Check the Accept License Agreement box, if requested.

7. Uncheck “Backup files necessary to uninstall service pack...”.

8. Click [Install].
9. When prompted, click on [Restart] to reboot the system and logon as before.
10. Proceed to Installing the Display Driver on page 6-11.
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6.2.7     Installing the Display Driver
1. When prompted, press <Alt> + <Ctrl> + <Del> and login into the system with:

Username: entegra
Password: entegra

2. Click [OK].

3. In the opened Welcome window, click on the checkbox for "Show this 
Welcome..." to deselect it and click [Close].

4. Double click the My Computer icon on the Desktop.

5. Double-click Control Panel.
6. Double click Display.

7. In the opened Display Properties window, click the Settings tab.

8. Click the [Display Type] button.

9. Click the [Change...] button.

10. In the Change Display dialog, click on the [Have Disk...] button.

11. Type in the Copy Manufacturer’s files from: input field:

C:\drivers\nvidia and click [OK].

12. From the opened nvidia drivers list, select NVIDIA RIVA TNT2 Model 
64 and click [OK].

13. In the confirmation window, click [Yes] and [OK].

14. Close the Display Types window by clicking [Close].

15. Close the Display Properties window by clicking [OK].

16. Click [OK] to reboot the computer.

17. Proceed to Adjusting the Display Properties on page 6-12.
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6.2.8    Adjusting the Display Properties
1. When the system comes up, press <Alt> + <Ctrl> + <Del> and login into 

the system with:

Username: entegra
Password: entegra

2. Click [OK].

3. If the Invalid Display Settings window is opened, click [OK].

4. The Display Properties window is opened to the Settings tab.

5. Click the down arrow under the Color Palette, and select True Color.
6. Move the slider in the Desktop Area to display a resolution of 

1280 by 1024 pixels.

7. Click the down arrow under Font Size and select Small Fonts. 

8. Click the down arrow under Refresh frequency and select 85 Hertz.

9. Click the [Test] button.

10. Click [OK] to display the test screen.

11. In the testing Mode window, click [Yes] if you have seen the bitmap 
properly. 

12. In the Display Properties window, click the [OK] button.

13. Proceed to Installing the Sound Driver on page 6-13.
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6.2.9    Installing the Sound Driver
1. If necessary, insert the eNTEGRA CD-ROM to the CD-ROM drive.
2. Double click the My Computer icon on the Desktop.
3. Double-click Control Panel.
4. Double click Multimedia and click the Devices tab.
5. Click, [Add], select Unlisted or Updated Driver and click [OK].
6. Type in the path C:\Drivers\Audio for the driver installation files and 

click [OK].
7. A dialogue box “Add Unlisted or Updated Drivers” appears. Click 

[OK].
8. If the “Driver Exists” window appears, click on the [New] button.
9. Click [OK] in the “About Soundmax Integrated Digital Audio” 

Window.
10. Click [OK] to close the Multimedia Properties window.
11. Proceed to Setting System Options on page 6-13. 

6.2.10    Setting System Options
Set the following operating system configurations in the given order:

1. Setting the Date Format on page 6-13 
2. Setting the Application Event Viewer Loggings on page 6-14 
3. Setting the Task Bar Properties on page 6-14 
4. Setting the View Options on page 6-14 
5. When done, proceed to Installing Internet Explorer 5 on page 6-15.

6.2.10.1    Setting the Date Format

1. Click left on the [Start] icon on the Tasks Bar, and select: Setting → 
Control Panel.

2. On the Control Panel window, double click on the Regional Settings 
icon.

3. Click on the Date tab.

4. Click the down arrow at the Short data style field, select the format:
M/d/yyyy and click [OK].
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6.2.10.2    Setting the Application Event Viewer Loggings

1. Click left on the [Start] icon on the Tasks Bar, and select: Programs › 
Administrative Tools (common) › Event Viewer.

2. Click the Log option in the Menu Bar, and select the Application entry.

3. Click the Log option in the Menu Bar, and select the Log settings... 
entry.

4. In the Event Log Settings window, check the Overwrite Events as 
Needed field Logs.

5. Click [OK].

6. Close the Event Viewer window.

6.2.10.3    Setting the Task Bar Properties

1. Click right on an empty place of the Task Bar and select the Properties 
entry.

2. In the opened Task Bar Properties window, uncheck the Always on 
top option.

3. Click [OK] to close the Task Bar Properties window.

6.2.10.4    Setting the View Options

1. Double click My Computer icon.

2. In the opened My Computer window, click the View option in the Menu 
Bar and select the Options entry.

3. In the Options window, click the Folder tab.

4. Click the radio button next to Browse folder by using a single 
window that changes as you open each folder, then click the 
[Apply] button.

5. Click the View tab in the Options window.

6. Click the radio button next to Show all files option.

7. Uncheck the option Hide file extensions for known file types, click 
[OK] to close the Options window.

8. Close My Computer window.
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6.2.11    Installing Internet Explorer 5
1. For the English version, skip to Step 2, below.

For other languages, replace the eNTEGRA application CD with the 
eNTEGRA Accessories Software CD.

2. Double click on My Computer icon located on the desktop.

3. Double click the D:\ drive (CD–ROM Drive).

4. For the English version, skip to Step 5, below.
For other languages, double click the applicable language.

5. Double click the IE5 directory.

6. Double click install.bat.
7. When installation has been completed, the system will reboot.

8. Proceed to Installing RAS, Modem and TCP/IP Printing on page 6-16.
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6.2.12    Installing RAS, Modem and TCP/IP Printing
1. When the system comes up, press <Alt> + <Ctrl> + <Del> and login into 

the system with:
Username: entegra
Password: entegra

2. Click [OK] and wait for the Windows desktop.

3. Insert the Windows NT Workstation CD-ROM and close the opened 
Windows CD window.

4. Click right on the Network Neighborhood icon on the desktop and 
select the Properties entry.

5. In the opened Network window, select the Services tab to display the 
currently installed services.

6. In the Services tab click [Add], select Microsoft TCP/IP Printing .

7. Click [OK], type D:\i386 <Enter>, where D: is your CD-ROM drive and 
click [Continue].

8. In the Services tab click [Add], select the Remote Access Service 
entry and click [OK].

9. If needed, change the path displayed to D:\i386 where D is your
CD-ROM drive, and click [Continue]. 

10. The Remote Access Service files will be copied. 
11. When the following message appears: There are no RAS...., click 

[Yes] to invoke Modem Installer.
12. In the opened Install New Modem dialog, check the Don’t detect my 

modem... and click [Next].
13. Proceed according to the installed modem, as follows:

a. Installing a US Robotics Modem
1) In the Install New Modem dialog, select U.S. Robotics, Inc from 

the Manufacturers column.
2) Select your modem from the Models list (Courier V.Everything 

External, Courier V.34 Data Fax Modem, etc…).
3) Click on [Next] and proceed to Step 14.

b. Installing a Motorola modem
1) In the Install New Modem dialog, select Motorola (Ger) from the 

Manufacturers column.
2) Select your modem from the Models list (Motorola Codex 

3265FAST, etc…).
3) Click on [Next] and proceed to Step 14.

c. Installing the Multitech Modem
1) Insert the eNTEGRA application CD into the CD-ROM drive.
2) In the Install New Modem dialog, click on [Have Disk...].
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3) Type G:\Drivers\Multitech (Where G: is the CD-ROM drive) and 
Click [OK].

4) Select MultiTech Systems MT5634ZBA and click [Next].
14. Select the port your modem is connected to: COM1 if your modem is con-

nected to Com1/Serial A or COM2 if your modem is connected to Com2/
Serial B.

15. Click on [Next]. The system will now install your selected modem.
16. Click [Finish] in the Install New Modem window.
17. Click [OK].
18. Click [Comfigure].

19. Select Dial out and receive calls and click [OK].

20. Click [Comtinue] in the Remote Access Setup.

21. Click [OK] twice.

22. Click [Close].

23. Click [Yes] to restart the system.

24. Remove the Windows NT CD from the drive.

25. Proceed to Installing the FTP Service on page 6-18.
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6.2.13    Installing the FTP Service
1. Insert the Windows NT CD into the CD drive.

2. Right click the Network Neighborhood icon on the desktop, and select 
Properties to display the Network dialog.

3. Click the Service tab and click the [Add] button.

4. From the opened Select Network Service list, select Microsoft Peer 
Web Server and click [OK].

5. In the Installed from: input field, enter D:\i386 (where D: is your CD 
drive), and click [OK].

6. On the opened Microsoft Peer Web Services Setup dialog, click 
[OK].

7. In the opened Options list, deselect all options except FTP Service and 
Internet Service Manager, then click [OK].

8. Click [Yes] to create the prompted directory.

9. In the FTP Publishing Directories input field type C:\Insite and click 
[OK]. If required, acknowledge by clicking [Yes] to create the Insite 
directory.

10.  When the installation has been complete successfully, click [OK].

11. Click [Close] in the Network dialog.

12. Click [Start] on the task bar and select Programs → Microsoft Peer 
Web Services → Internet Service Manager. 

13. Double click the Computer Name entry to open the FTP Service 
properties for entegra dialog.

14. On the Service tab, uncheck Allow only anonymous connections, 
and confirm by clicking [Yes].

15. Click the Directories tab, select the displayed entry, click [Edit 
Properties...], check (click) the Write property, then click [OK].

16. Click [Add], enter C: in the Directory field, enter /C in the Alias field, 
click the Write checkbox located at the bottom of the screen, and click 
[OK].

17. Click [Add], enter D: in the Directory field, enter /D in the Alias field, 
click the Write checkbox located at the bottom of the screen, and click 
[OK].

18. Click [OK] and close the Microsoft Internet Service Manager 
dialog.

19. Proceed to Formatting Drive D: as NTFS on page 6-19.
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6.2.14    Formatting Drive D: as NTFS
1. Double click on the [Start] button in the Task Bar, and select: Programs 

→ Administrative Tools (common) → Disk Administrator.
2. Click [OK].

3. In the Disk Administrator dialog, click right on the letter assigned to 
the CD-ROM, and select Assign Driver Letter... 

4. From the Assign drive letter drop-down list, select E: and click [OK].

5. In the confirm window, click [Yes].

6. In the Disk Administrator dialog, click right on Free Space., and in 
the pop-up window click [Create].

7. When asked, click [Yes], [OK] and [Yes].

8. In the Disk Administrator dialog, select Exit from the Partition drop-
down menu.

9. When asked, click [Yes] to save the partition, then click [OK] twice.

10. Double click on My Computer icon located on the desktop.

11. Right click on D: drive icon.

12. Select the Format... entry.

13. Click the down arrow in the File System field and select NTFS entry.

14. Click the [Start] button.

15. The following warning will be displayed:

WARNING: formatting will erase all data on this disk. Select 
OK to format the disk, Cancel to abort.

Click OK.
The disk will be formatted.

16. Upon system prompt Format Complete, click [OK].

17. Click [Close].

18. Proceed to Installing the eNTEGRA Application and Its Accessory 
Components on page 6-20.
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6.2.15    Installing the eNTEGRA Application and Its Accessory 
Components

1. Insert the eNTEGRA CD-ROM to the CD-ROM drive.

2. Double click on My computer icon located on the desktop.

3. Double click the (E:) drive (CD–ROM Drive).

4. Double click Install.vbs.

5. Click on [OK].

6. When prompted, insert the licences diskette into the floppy drive, and 
click [OK].

7. Click [Yes] and wait for the installation of the HASP Device Driver 
Setup program to complete.

8. On the Warning window displayed, click [Yes] to continue with the 
setup program.

9. In the HASP Device Driver status dialog, click [Next].
10. In the Setup Option window, click [Typical].
11. In the Confirm Your Selection window, click [Next].
12. When the message The HASP Device Driver has been 

successfully installed appears, click [OK], [Finish].

13. In the Acrobat installation, click [Next], [Next].
14. Select [No] when asked to reboot.

15. From the eNTEGRA CD, double click eNTEGRA_LFC.vbs.

16. In the QGS installation, click [Next], [Finish].

17. In the Demo Database installation, click [Next], [Next], [Next] and 
then [Finish].

18. In the eNTEGRA Application installation, click [Next], [Next], 
[Next].

19. When asked, click the radio button next to the applicable language, then 
click [Next], [Next].

20. If requested, replace the eNTEGRA Application CD with the eNTEGRA 
On-line Help CD.
Otherwise, skip to step 22, below.

21. Click [Next], [Next] and then [Finish].

22. If the system includes an optical drive, reconnect it as per Adding an 
Optical Drive on page 7-1.

23. Proceed to InSite Installation on page 6-21.
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6.2.16    InSite Installation
InSite installation consists of the following steps to be performed in theh 
given irder:

• Installation of the Command Line Telnet on page 6-21 
• Configuring ATAMAN Telnet to include eNTEGRA as user on page 

6-22 
• Verifying InSite user accounts and passwords on page 6-23 
• Re-installation of Service Pack 6a on page 6-24 
• Installation of VNC Server on page 6-25 

6.2.16.1     Installation of the Command Line Telnet

1. Insert the eNTEGRA Software Disk CD-ROM into the CD-ROM drive.

2. Double click on the My Computer icon on the Desktop.

3. Double-click on the CD-ROM icon.

4. Double click on the Options folder.

5. Double click on the cmdtelnet folder.

6. Double click on the Setup.exe icon.

7. Click [Next] in the Welcome window.

8. Click [Yes] in the License Agreement window.

9. Click [Next] in the Readme Information window.

10. Click [Browse] in the Choose Destination Directory window.

11. Select the C:\insite directory as follows:

a. Double click on the C:\ folder.
b. Double click on the Insite folder (this should update the top field to 

read C:\insite\).
12. Click [OK].

13. Click [Next] in the Choose Destination Directory window.

14. Click [Next] in the Select Program Folder window.

15. Click [Next] in the Start Copying Files window.

16. Uncheck [View Readme] and click [Finish] in the Setup Complete 
window.

Note
Currently InSite does not work on systems with Windows NT Operating 
Systems in Portuguese.
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6.2.16.2    Configuring ATAMAN Telnet to include eNTEGRA as user

1. Double click on My Computer (minify eNTEGRA application if 
necessary).

2. Double click on Control Panel.

3. Double click on Ataman TCP R.L. Services.

4. Select the Users tab in the opened Ataman TCP Remote Login 
Services window.

5. Click [Add User…].

6. To create an eNTEGRA user for telnet purposes:

a. In the User Name field type: entegra
b. In the NT User Name field type: entegra
c. In the NT User Domain field type: .                  (only put a period)

7. Click [OK].

8. Click [OK] in the Ataman TCP Remote Login Services window.

9. Close the Control Panel.
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6.2.16.3    Verifying InSite user accounts and passwords

1. Click left on the [Start] icon on the Tasks Bar, and select Programs → 
Administrative Tools (common) → User Manager.

2. In the opened User Manager window, double click on the [insite] entry.

3. In the opened User Properties:

a. Click the checkbox next to Password Never Expires.
b. If necessary, uncheck the box next to User Must Change Password 

at Next Logon.
4. Verify that all other boxes are unchecked then click [OK].

5. In the opened User Manager window, double click on the Pinsite entry.

6. In the opened User Properties:

a. Click the checkbox next to Password Never Expires.
b. If necessary, uncheck the box next to User Must Change Password 

at Next Logon.
7. Verify that all other boxes are unchecked then click [OK].

8. Close the User Manager window.
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6.2.16.4    Re-installation of Service Pack 6a

This installation depends on the language being used.

1. For English version: Insert the eNTEGRA Application CD into the CD 
Drive and double click the My Computer icon located on the desktop.

For other languages: Insert the eNTEGRA Accessories Software CD 
into the CD Drive and double click the My Computer icon located on 
the desktop.

2. Double click the (D:) drive (CD–ROM Drive).

3. Double click the SP6 directory.

4. For the English version, skip to step 5, below.
For other languages, double click the applicable language directory.

5. Double click SP6ai386.exe.

Note: if an Incorrect Service Pack version message appears, browse to 
C:\WINTN\system32, rename Schannel.dll to Schannel.dl2, and 
double click SP6ai386.exe again.

6. Check the Accept License Agreement box, if requested.

7. Uncheck “Backup files necessary to uninstall service pack...”.

8. Click [Install].
9. When prompted, click on [Restart] to reboot the system and logon as before.
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6.2.16.5    Installation of VNC Server

1. Click left on the [Start] icon on the Tasks Bar, and select: Programs → 
Command Prompt.

2. In the opened Command Prompt window:
a. Type cd\insite\vnc <Enter>.
b. Type gzip –d vnc* <Enter>.
c. Type tar –xvf vnc* <Enter>. This will extract some files.
d. Type exit <Enter> to close the Command Prompt window.

3. Double click on My Computer.

4. Double click on the (C:) icon.

5. Double click on the insite folder.

6. Double click on the vnc folder.

7. Double click on the vnc_x86_win32 folder.

8. Double click on the winvnc folder.

9. Double click on the Setup.exe icon.

10. Click [OK] in the opened WARNING… window.

11. Click [Next] in the opened Welcome window.

12. Click [Yes] in the opened Software License Agreement window.

13. Click [Next] in the opened Choose Destination Location window.

14. Click [Next] in the opened Select Program Folder window.

15. When the Setup Complete window appears:

If prompted to restart the computer, select ‘No, I will restart my 
computer later’.

Then or otherwise, click [Finish].

16. Click the [Start] button on the Task Bar at the bottom of the screen and 
select the Run... entry.

17. Type winvnc <Enter> in the command line.

18. If the WinVNC: Current User Properties window appears, type insite in 
the password field then click [OK].

Note: when typing insite, be sure that the <Caps Lock> button is OFF.

19. Click on Start → Find → Files or Folders... and type in the named field 
winvnc.exe 

20.  Click on [Find Now].

21. Click right on the winvnc.exe icon and select Create Shortcut.

22.  Click [Yes] to create a shortcut on the desktop.
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6.3    Software Load from Warm

6.3.1    Overview
Software load from warm is mainly used for software upgrade.

6.3.1.1    Time Required

Since upgrade of the eNTEGRA application does not affect the database, and 
the various settings (system settings, the network settings and the printer 
settings), it requires 5 minutes only.

6.3.1.2    Procedure

Software upgrade consists of the following steps, to be performed in the given 
order:

1. Full Shut Down of the eNTEGRA Application on page 6-26

2. Software Upgrade on page 6-26.

6.3.2    Full Shut Down of the eNTEGRA Application
1. From the Main eNTEGRA screen, click the [X] (shutdown) button in the 

upper right corner of the screen.

2. In the opened dialog, click the [Full] button.

3. Wait until the eNTEGRA application and its servers are closed.

6.3.3    Software Upgrade
1. Double click on My Computer icon located on the desktop.

2. Double click the (E:) drive (CD–ROM Drive).

3. Double click on the eNTEGRA directory.

4. Double click setup.exe.

5. Click [Next].
6. When prompted to define the database location, type D:\DataBase and 

click [Next].
7. Click [Finish].
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6.4    Installing eNTEGRA Software Options and Licenses
This section explains how to install additional software options and the 
required licences, as follows:

• Installing the licenses – Section 6.4.1 on page 6-27.

• Installing OSI Software, required for communication with StarCam 
and SPX systems – Section 6.4.2 on page 6-29.

6.4.1    Installing the Licences
Application licences are generated per each unique activator ID. 

eNTEGRA Release 1.0 includes individual licence for each licensed option.

To install licences:

1. Insert the Licences diskette (supplied with the system) into the floppy 
drive and attach the Activator onto the parallel port on the back panel of 
the computer.

2. Double click My Computer icon on the Desktop.

3. Double click 3½ Floppy (A:).
4. Select all the files by pressing <Ctrl> + <A> simultaneously.

5. Drop down the Edit menu and select the Copy entry.

6. Double click on My Computer icon on the desktop.

7. Browse to D:\Einstein\Licences.

8. Drop–down the Edit menu and select the Paste entry.
eNTEGRA P&R Service Manual 6-27 Rev. 5
Direction 2263784-100 June 17, 2001



Software Installation Installing eNTEGRA Software Options and Licenses
Table 6-1 lists the software options available on eNTEGRA Release 1.0X 
along with the license file names.

Table 6-1.  eNTEGRA P&R Options

Option license File Name

Basic System ar.base, db.base, dc.base, hc.base, 
iap.base, pr.base, rec.base, pr.3d.

CEqual™ cequal

CEqual Light cequalite

ECToolbox™ cequal, perfspect3degs, tetrofosmin

ECToolbox Upgrade perfspect3degs, tetrofosmin

Functional Anatomical Mapping – Fusion fam

Tl201 database upgrade TL201

QuantEM™ quantem

Quantitative Gated SPECT™ qgspect

Aladdin Compose and Edit™ qcard

3D Volume Rendering – PerfSPECTive™ render3d

CT/MR DICOM Storage ctmrdicomscp

Remote Connectivity remoteconn

Iterative Reconstruction rec.ir

Quantitative Perfusion SPECT qps

OSI (required for connection to SP and 
StarCam systems)

osi
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6.4.2    Installing the OSI Option

6.4.2.1    Overview

The OSI option is required for any NT based eNTEGRA P&R system that 
needs to communicate with other systems that do not support TCP/IP. These 
systems include Starcam systems running Starlink V4 protocol and SPX 
systems residing on the ApexNet.

The Starlink protocol and the SPX systems use the OSI network stack as it’s 
transport software. The standard eNTEGRA Operating System loaded on the 
eNTEGRA P&R PC platform does not contain this OSI network software. A 
separate OSI software package must be loaded in addition to Windows NT.

Installing the OSI shareware package requires the following steps:

1. Installing the IMPART ISO 8073 Network Driver – Section 6.4.2.2.

2. Installing the Boldon James ADI program – Chapter 6.4.2.3.

3. Installing patch for ADI – Chapter 6.4.2.4.

4. Configuring the Remote OSI Stations on the eNTEGRA system – refer to 
Section 3.8.4.5.

5. Configuring the Starlink and OSI accessed systems on the local 
eNTEGRA system – Section 3.8.4.5.

6. Configuring the eNTEGRA on the Remote Starlink/SP systems – 
Section 6.4.2.5.
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6.4.2.2    Installing the IMPART ISO 8073 Network Driver

The following instructions relate to installation from the CD-ROM where the 
files are in the directory \OSI\IsoTspNT.

1. Log into your system as before with the username entegra.

2. Close down the eNTEGRA application and double-click the Stop Servers 
icon to shutdown all servers.

3. Click on the [Start] icon on the Tasks Bar, and select: Settings → 
Control Panel.

4. Double click the Network icon.

5. Go to the Protocols tab and click [Add].

6. Click the [Have Disk] button.

7. In the Insert Disk window, type-in the path for the installation files on 
the CD-ROM E:\OSI\IsoTspNt where E: is the CD-ROM drive.
Click [OK].

8. When the product name (IMPART ISO 8073 Transport) is displayed in the 
Select OEM Option window, click [OK].

9. The licences agreement will be displayed. Click [Yes] to confirm.

10. A dialog box will be displayed requesting the directory in which to install 
the Transport files. Click OK to confirm the default directory.

11. In the next dialog, click [Yes] to confirm the creation of the specified 
directory.

12. In the Bolden James Installation window, click [OK].

13. Wait for the installation to complete. Upon the message IMPART ISO 
8073 Transport installed successfully click [OK].

14. In the open Network window, click [Close].

15. After the network settings have been updated, you will need to reboot for 
the changes to become affective.
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6.4.2.3    Installing the Boldon James ADI Program

1. Close down the eNTEGRA application and double-click the Stop Servers 
icon to shutdown all servers.

2. Double click My Computer icon on the Desktop.

3. Double click the CD drive letter (E:).
4. Navigate to E:\OSI\Impart5\disk1.

5. Run the Setup.exe installation program located in Click [Yes] in the 
Licence Agreement dialog.

6. In the License File Location window, click [Continue] to use the 
default license.

7. Click [Continue] to use the default path.
8. In the Select Components to Install dialog, verify that ONLY the 

ADI component is checked and click [OK].
9. In the Type of Addressing window, click [OK] to use the default 

ICAD format.
10. In IMPART 32 Installation Complete, click [OK].
11. Click [No] to avoid rebooting the system.

12. Close all windows

6.4.2.4    Installing a Patch for ADI

1. Move to the patch installation directory E:\OSI\BJ_Patch.

2. Run BJ_Patch.bat.
3. Reboot the system (If necessary, shut down the eNTEGRA application 

and stop the servers).

6.4.2.5    Configuring the eNTEGRA on Remote OSI Stations

Refer to Section 3.9.

After the eNTEGRA system has been configured on all the remote OSI 
stations, log into eNTEGRA and verify communication with the StarLink and 
SP based systems. 
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Chapter 7 -  System Upgrade

This chapter provides instruction for hardware upgrades, as follows:

• Section 7.1 - Adding an Optical Drive on page 7-1 

For upgrading eNTEGRA software version, please refer to Section 6.3 - 
Software Load from Warm on page 6-26.

For adding clinical application licences, please refer to the procedure 
described in 6.4.1 - Installing the Licences on page 6-27.

7.1    Adding an Optical Drive
7.1.1    Installing Archive Optical Disk in PC Tower

1. Power down the PC.

2. Remove the PC cover. Refer to the PC User’s Guide.

3. Set SCSI ID of the Optical Disk to 1. Refer to the OEM documentation 
sent with the drive.

4. Insert the Optical Disk into the empty slot in the PC Tower and fasten in 
place using the screws from the slot cover. Refer to the PC User’s Guide.

5. Connect the internal power cable and Narrow SCSI cable to the 
connectors on the back of the drive. All connectors are keyed to ensure 
that they are inserted correctly.

6. Reassemble the PC Tower and reconnect all cables.

Note Use proper ESD procedures when handling the Optical Drive and working in the 
PC Tower.
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7.1.2    System Configuration and Test
1. Power ON the computer.

The Green LED on the drive should illuminate during it’s power-up test.

Verify that the optical disk is identified during the Boot–up sequence.

2. Open the eNTEGRA application.

3. Click on the [Configuration] button.

4. In the opened User Preferences window, click [Advanded 
Configuration].

5. In th opened eNTEGRA Configuration window, click the Archive 
tab.

6. In the Archive tab, check Enable Archive Functionality and SONY/
Pioneer MOD Drive, and click [OK].

7. Click [Shutdown...].
8. In the opened System Shutdown window click [Powerdown].

9. Restart the eNTEGRA application.

10. Verify peripheral operation. Refer to Chapter 4.
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8.1    Philosophy
The general repair philosophy for the eNTEGRA workstation and its Field 
Replaceable Unit (FRU) is to repair at a UNIT level for both hardware and 
software. The product has been configured and structured to conform to 
standard FRU policies and to utilize as many common parts as possible. A 
troubleshooting guide, embedded InSite, and internal diagnostics allow fault 
isolation to the FRU level.

In the Workstation, no internal components are exchanged with all repairs 
being performed by the OEM vendor. 

Training is structured to support this philosophy and develop a basic working 
knowledge of the Windows NT environment as required for software and 
Network troubleshooting.

This chapter is divided in to two main areas.

• Troubleshooting – Section 8.2 
• Replacement Procedures – Section 8.3 
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8.2    Troubleshooting
This section provides instructions for:

• Operating System Installation Problems on page 8-3 
• eNTEGRA Installation Problems on page 8-3 
• Post Installation Problems on page 8-4 
• Communication Problems on page 8-4 
• Communication Problems on page 8-4 
• Printing Problems on page 8-5 
• Codonics Status Check on page 8-6 
• Releasing the System When it Gets Stuck on page 8-7 
• Restoring Pervious Configuration on page 8-7 
• Creating Problem Reports on page 8-8 
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8.2.1    Operating System Installation Problems 

8.2.2    eNTEGRA Installation Problems

Note Refer to “Microsoft Windows NT Workstation” booklet provided with the system.

Symptom Possible Cause Corrective Action

During system start-up, 
the EOD is assigned 
drive D: instead of 
drive E:

A new archive device 
was added to the system.

1. Disconnect the EOD.
2. Click [Start] in the task bar and select 

Programs → Administrative Tools → 
Disk Administrator.

3. Assign F: as the CD-ROM drive as 
follows:
a. Click right on the CD-ROM Drive 

and select Assign Drive Letter.
b. Click the down arrow next to the 

Assign Drive Letter radio button, 
select F: and click [OK].

4. Assign the Archive to drive E: as 
described above, then re-assign it to 
drive D:.

5. Reconnect the EOD to the SCSI Narrow 
slot.

After first time installation 
of eNTEGRA, the 
application doesn’t start, 
and the following error 
message is displayed:

“Error while initializing 
eNTEGRA, check 
servers”

Missing or wrong system 
license.

1. Open the file einstein.error.log located 
in D:\Einstein\Einstein_Project/exe 
using Notepad. 

2. Scroll to the end of the file and check for 
the message:

No node locking license: 4! 
Meaning that the basic eNTEGRA license 
is incorrect or missing.

1. If the above message appears, reinstall 
the iap.base license as per Section 6.4.1 
on page 6-27.
eNTEGRA P&R Service Manual 8-3 Rev. 5
Direction 2263784-100 June 17, 2001



Troubleshooting and Repair Troubleshooting
8.2.3    Post Installation Problems

8.2.4    Communication Problems

Symptom Possible Cause Corrective Action

During Load From Warm 
(LFW) the following message 
appears:

“An error occurred during the 
move of data process: 115”

One or more of the 
eNTEGRA Servers are 
still active.

Close all eNTEGRA Servers by clicking the 
Stop Servers icon on the desktop and 
restart LFW.

eNTEGRA environment does 
not open successfully.

Files on hard disk are 
corrupted.

Reload eNTEGRA application (perform 
LFW).

Table 8-1.  Communication Problems

Symptom Possible Cause Corrective Action

After configuring the network 
settings, the eNTEGRA 
application will not re–open.

Wrong settings in the 
eNTEGRA Config. utility.

1. Double click the eNTEGRA Prompt icon 
on the desktop.

2. Type Econf <Enter>.
The Econf will open. Review it and 
correct the network settings.

No communication with 
configured stations.

Remote station failure or 
OFF.

1. Double click the eNTEGRA Prompt icon 
on the desktop.

2. Type ping Hostname <Enter>, 
where Hostname refers to the 
hostname of the remote station.

3. If the remote station does not replay, it is 
not available.

While trying to export to 
Interfile or DICOM Part 10, the 
following message appears:

“Can’t find RAS.dll”

RAS Installation was 
skipped.

Install the RAS as per Section 6.2.12 on page 
6-16.
eNTEGRA P&R Service Manual 8-4 Rev. 5
Direction 2263784-100 June 17, 2001



Troubleshooting and Repair Troubleshooting
8.2.5    Printing Problems

Table 8-2.  Printing Problems

Symptom Possible Cause Corrective Action

TCP/IP printers printing 
problems.

Wrong Configuration on 
local system

1. Open Config from the eNTEGRA 
Main screen.

2. Check the printer settings in the 
Printer tab, and correct if 
necessary.

Printer disconnected 1. Double click the eNTEGRA 
Prompt icon on the desktop.

2. Type ping Hostname <Enter>, 
where Hostname refers to the 
hostname of the remote station.

3. If the remote station does not 
replay, it is not available.

Codonics printing 
problems (in addition to 
TCP/IP problems)

Wrong configuration on 
the Codonics

Connect to Codonics using telnet and 
check the printer status, as per 
Section 8.2.6. If not, contact Codonics 
service.

Missing Codonics 
software patches

1. Connect to Codonics using telnet, 
as per Section 8.2.6 steps 1 – 4.
The telnet session will display any 
communication between the 
eNTEGRA and the Codonics.

2. At the UNIX prompt, type
more /etc /updates <Enter>.

3. Verify that the ’lpd’ and ’snnpd’ 
patches are loaded. If not, contact 
Codonics service.
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8.2.6    Codonics Status Check
1. Click on the [–] (minimize) button on the Main Screen Header to view 

the system’s Desktop.
2. Click the [Start] button on the Task Bar at the bottom of the screen and 

select Programs → Command Prompt.
3. Type:   telnet codonics <Enter>

The telnet session will display any communication between the 
eNTEGRA and the Codonics.
The system responds with:

Connected to codonics.
Escape character is '^]'.
UNIX(r) System V Release 4.0 (np1600)
login:

4. Type:   root <Enter> 
The system responds with:

Last login: Wed Apr 2 12:11:25 from 3.28.127.70
Sun Microsystems Inc.   SunOS 5.3       Generic September 1993
#

5. To to look at the configuration parameters, type at the UNIX prompt:
stat eNTEGRA hostname 

The system responds with the following information:
Status: Ready Date: 16-Apr-1997 09:04

Media: A-Size Paper Printer ID: 8033-d354
Ribbon: CMY E-net Addr: 08:00:20:1f:65:55

Mem Config: 16MB RAM
Queue: 0 jobs in image queue Hard Drive: 270MB Quantum

0 jobs in image queue SW Version: 1.3.2

Caption: none
Keys: POSTSCRIPT Key=00QIEKQZFO Permanent

ISG_1 Key=40QRC3BRIUPermanent

Defaults: Printer (root) User (eNTEGRA)
-------------------------- ------------------------------------------
TCR 0 TCR NOT SET
Gamma 1.00 Gamma 1.5
Antialias None Antialias NOT SET
Rotate Auto Rotate NOT SET
Scale Bilinear Scale NOT SET
MCM 1 MCM 12

6. Verify that:
a. The ISG_1 key is listed under keys.
b. The Defaults for User (eNTEGRA) are set to the values configured 

during installation (Section 3.10.8.5).
7. To quit the telnet session type: exit <Enter>.

The telnet session will display any communication between the eNTEGRA 
and the Codonics. It can also be used to look at the configuration parameters 
using the stat utility or verify which patches have been loaded. 
For complete details on using the telnet session for troubleshooting, refer to 
the Codonics Users Manual.
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8.2.6.1    Checking Status

The stat utility provides basic configuration information for the Codonics. 
This includes the printers software revision, license keys activated and default 
printer settings. To use:

1. Open a telnet session.

2. At the UNIX prompt type:

8.2.7    Releasing the System When it Gets Stuck
When the system is stuck:

1. Press <Alt> + <Ctrl> + <Del> to display the Windows NT Security 
window.

2. Click the [Task Manager] button.

3. Using the Down Arrow key, move the cursor to highlight the 
eNTEGRA.exe file and click the [End Task] button.

4. Restart eNTEGRA.

8.2.8    Restoring Pervious Configuration
When problems are encountered following any system configuration change, 
restore the previous configuration, as follows:

1. Click the [Config] button on the Patient Selector Control Panel.

2. Click the Archive tab.

3. Click the [Restore...] button.

4. In the Restore from dialog, click [Restore].

5. When prompted, insert the backup diskette labeled eNTEGRA 
Configuration Backup into the floppy drive and click [OK].
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8.2.9     Creating Problem Reports
In case of unsolved problems, create a problem report as described below and 
send it to your service office.

1. Double click on the Problem Report icon residing on the desktop.

2. In the opened Notepad window titled ProbReport.txt - Notepad, type 
in a description of the problem encountered, including the operations that 
preceded the problem, the expected results of these operations and the 
actual results.

3. Pull down the File menu and select the Save entry.
The program creates a compressed file called ProbReport.tar.z located 
in D:\Einstein. 

4. Pull down the File menu and select the Exit entry.

5. Mail the ProbReport.tar.z file to your service office.

ProbReport.tar.z consists of the following files:

• Your problem report (ProbReport.txt)
• The error log einstein.error.log located in:

D:\Einstein\Einstein_Project/exe
• All the files residing under

D:\Einstein\Einstein_User\Resources
• All the files residing under

D:\Einstein\Einstein_Project\Resources\Config\Connectivity
eNTEGRA P&R Service Manual 8-8 Rev. 5
Direction 2263784-100 June 17, 2001



Troubleshooting and Repair Replacement Procedures
8.3    Replacement Procedures

8.3.1    Hard Drive Swapping

8.3.1.1    Overview

The PC Tower FRU includes a hard drive. If the hard drive in the defective 
PC is not defective it can be swapped with the drive in the replacement unit. 
This eliminates having to do a load from cold on the system or reassigning the 
Host ID.

8.3.1.2    Tools Required

The following tools are required to perform the upgrade:

• Field ESD Kit
• A #2 Phillips Screw Driver

8.3.1.3    Time Required

This repair takes approximately 30 minutes to complete.

8.3.1.4    Procedure

1. Power down the GENIE.

2. Remove hard drive from defective PC. Refer to How to Install 
Accessories section of the PC User's Guide.

3. Install the hard drive from the defective PC into the replacement PC.

4. Install hard drive from the replacement PC into the defective PC.

5. Power up the system and verify proper operations.
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Troubleshooting and Repair Replacement Procedures
8.3.2    Hard Drive Replacement

8.3.2.1    Overview

A load from cold will need to be performed on the system once the drive is 
replaced. 

8.3.2.2    Tools Required

The following tools are required to perform the upgrade:

• Field ESD Kit
• A #2 Phillips Screw Driver

8.3.2.3    Time Required

This repair takes approximately 2.5 hours to complete.

8.3.2.4    Procedure

1. Power down the GENIE.

2. Remove the defective hard drive from PC. Refer to How to Install 
Accessories section of the PC User's Guide.

3. Install the replacement hard drive in to the PC. Refer to How to Install 
Accessories section of the PC User's Guide.

4. Power up the processor unit and perform Software Load from Warm 
described on page 6-26.

5. Verify proper operations.

6. Return the defective processor unit in the replacement unit's packaging.
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Chapter 9 -  Renewal Parts

The renewal parts are classified in three groups:
• Hardware on page 9-1 
• Software on page 9-2 
• Documentation on page 9-3 

9.1    Hardware
Table 9-1 and provides a list of the eNTEGRA hardware FRUs. To identify 
the components, please refer to Figure 5-1 on page 5-2.

Table 9-1.  Hardware FRU List

Description ELGEMS 
Part Number

GEMS
Part Number

FRU 
code Notes

Dell OptiPlex GX200 (replacing the Dell 
Precision 610 and the Kayak XU Pentium III)

DTP000119 1

3Com Ethernet Card (3C905B-TX) CP001133906 1 Applicable only for Dell 
Precision and HP Kayak 
computers.
Can be replaced by 
3C905C-TX
CP001100024

SCSI–III to SCIS–II Adapter Cable CBL000875 2

SCSI Flat Cable CBL000939 2

Sony Monitor 21” OPT000300 H3300TA 1

MAG Monitor 19” OPT000301 H3300TB

Sony Optical Disk Drive (4.1 GB) OPT000193 H2508LK 2

Isolation Transformer Non CE Version 2118082 1

Isolation Transformer CE Version 2118082-2 1

DASM/LCAM (self contained) OPT000076 1

US Robotics MODEM Check with local 
OLC for country specific models.

2135816-2 1

Power Cable 2119862 1

Modem Cable, RS232. 2123524 2

Monitor Cable VGA - BNC 2210828 1

CAT 5 UTP Cable (5m) 2215028-4 1

French Keyboard CP00024725F 1

Spanish Keyboard CP00024725E 1
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Renewal Parts Software
9.2    Software
Table 9-2 list the eNTEGRA software FRUs.

Portuguese Keyboard CP000247259 1

German Keyboard CP00024725D 1

Italian Keyboard CP00024725Z 1

Swedish Keyboard CP00024725S 1

Table 9-1.  Hardware FRU List (Continued)

Description ELGEMS 
Part Number

GEMS
Part Number

FRU 
code Notes

Table 9-2.  Software Parts List

Description ELGEMS 
Part Number

GEMS
Part 

Number

FRU 
code

eNTEGRA P&R Software Release 1.5X + 
English On-line Documentation CD

LSW000195 1

Windows NT package – English OPT000338 H2600NT 1

eNTEGRA Accessories SW CD for 
Spanish, Portuguese and French

LSW000154 2

eNTEGRA Accessories SW CD for 
German, Italian and Swedish

LSW000155 2
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Renewal Parts Documentation
9.3    Documentation

* The English on-line help files are provided on the eNTEGRA application 
SW CD.

Table 9-3.  eNTEGRA Documentation – English PN OPT000396

Description ELGEMS 
Part Number

GEMS
Part Number

eNTEGRA Operator’s Manual MAN000388 2266250-100

eNTEGRA Service Manual (this manual) MAN000377 2263784-100

eNTEGRA Site Preparation Manual MAN000381 2264704-100

eNTEGRA CIS MAN000529 2291227-100

Table 9-4.  eNTEGRA Documentation – French PN OPT000391

Description ELGEMS 
Part Number

GEMS
Part Number

eNTEGRA Operator’s Manual MAN000501 2266250-101

eNTEGRA CIS MAN000509 2267854-101

eNTEGRA On-line Help CD MAN000507

Table 9-5.  eNTEGRA Documentation – Spanish PN OPT000392

Description ELGEMS 
Part Number

GEMS
Part Number

eNTEGRA Operator’s Manual MAN000502 2266250-106

eNTEGRA CIS MAN000510 2267854-106

eNTEGRA On-line Help CD MAN000507

Table 9-6.  eNTEGRA Documentation – Portuguese PN OPT000395

Description ELGEMS 
Part Number

GEMS
Part Number

eNTEGRA Operator’s Manual MAN000505 2266250-127

eNTEGRA CIS MAN000513 2267854-127

eNTEGRA On-line Help CD MAN000507
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Renewal Parts Documentation
Table 9-7.  eNTEGRA Documentation – German PN OPT000393

Description ELGEMS 
Part Number

GEMS
Part Number

eNTEGRA Operator’s Manual MAN000503 2266250-108

eNTEGRA CIS MAN000511 2267854-108

eNTEGRA On-line Help CD MAN000508

Table 9-8.  eNTEGRA Documentation – Italian PN OPT000396

Description ELGEMS 
Part Number

GEMS
Part Number

eNTEGRA Operator’s Manual MAN000504 2266250-111

eNTEGRA CIS MAN000512 2267854-111

eNTEGRA On-line Help CD MAN000508

Table 9-9.  eNTEGRA Documentation – Swedish PN OPT000394

Description ELGEMS 
Part Number

GEMS
Part Number

eNTEGRA Operator’s Manual MAN000506 2266250-142

eNTEGRA CIS MAN000514 2267854-142

eNTEGRA On-line Help CD MAN000508

Table 9-10.  Vendor Supplied Manuals

Description

PC User Manual

Monitor User Guide

Modem User Manual
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Appendix A -  Upgrading to eNTEGRA

A.1    Upgrading From XPert Systems

1. Before beginning the upgrade procedure, ensure that all the studies from 
the local database were transferred to a remote station or an archiving 
device.

2. Prepare User Backup diskette(s), as follows:

a. Double click on XPert Tools icon in the desktop.
b. Double click on User BackUp icon and follow the screen instructions.

3. Review and record/update the information from the following XPert 
utilities in the System Information tables (refer to chapter 2 of XPert/
XPertView Software Installation).

• LAN Station List

• WAN Station List

• Printer Selection and Setup

• TCP/IP Configuration

4. Perform Low Level Format, as per Section A.3, below.

5. Install eNTEGRA software, starting from “Software Load From Cold For 
Dell OptiPlex GX200” on page 6-2

6. Configure the eNTEGRA Environment based on the data you collected in 
step 3, starting from “Site Configuration” on page 3-14

CAUTION
Leave the XPert Activator plugged into the computer. Its ID was included 
in the FDO, and the eNTEGRA software used for this upgrade matches this 
specific activator ID. Removing or replacing the activator will disable the 
upgrade. 

Note You will be prompted for blank diskettes to save user data.

   Important Keep the User Backup diskette for reference.
eNTEGRA P&R Service Manual -1 Rev. 5
Direction 2263784-100 June 17, 2001



Upgrading From GENIE P&R
A.2    Upgrading From GENIE P&R
1. Before beginning the upgrade you must ensure that all the studies from 

the local database were transferred to a remote station or an archiving 
device.

2. If you have Review Templates which you want to transfer to 
eNTEGRA, back them up to the optical disk, as follows:

a. Click the Archive tab.
b. In the Archive panel, click the [Job Options] button.
c. In the opened Archive/Retrieve dialog:

i. Check the Archive system data checkbox.

ii. Click [OK].

d. Archive any study to the optical cartridge, as follows:
i. Select any study.
ii. Click the [Archive] button on the Archive panel.
iii. In the opened warning, click [Yes].

All the system Review Templates will be stored under patient 
“CORRECTIONS DIRECTORY”. 

3. If you have any User Protocols which you want to transfer to 
eNTEGRA, back them up to the optical disk, as follows:

a. Activate the Aladdin Archive application from within the 
Housekeeping category.

b. From the Aladdin Archive Processing screen, click on the 
required database listed in the Select a Database panel on the left.
The name of the currently-selected database is displayed.

c. Click on the [Save a Script] button.
d. For each user protocol to be transferred to eNTEGRA:

i. Select the required protocol listed under Save a Protocol in the 
Protocol Archive dialog box.

ii. Click on the [OK] button.
The message Saving... appears in the upper left corner of the tab 
card.
When save is completed, the message Save Completed appears 
in the upper left corner of the tab card.
The database where the protocol was saved and the protocol 
name(s) are listed on the processing screen.
Each protocol saved is shown as a dataset within the Aladdin 
Protocols study.
If the protocol was already archived, a message box is opened 
indicating that an extension will be added to avoid confusion and 
providing the new name (for example, LungHeart_0).
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Upgrading From GENIE P&R
e. Archive the Aladdin Protocols study to the optical cartridge, as 
follows:
i. Select the Aladdin Protocols study.

ii. Click the Archive tab.

iii. In the Archive panel, click the [Job Options] button.

iv. In the opened Archive/Retrieve dialog:
a. Click Archive Current Dataset Selection.
b. Click [OK].

v. Click the [Archive] button on the Archive panel.

vi. In the opened warning, click [Yes].

4. Perform Low Level Format, as per Section A.3, below.

5. Install the eNTEGRA software from scratch, starting from “Software 
Load From Cold For Dell OptiPlex GX200” on page 6-2, or Appendix B -
Software Installation on HP Kayak, or Appendix C -Software Installation 
on Dell Precision 610, which ever applies to your PC.

6. Configure the eNTEGRA, starting from “Site Configuration” on page 3-
14

7. After eNTEGRA installation and configuration have been completed, 
import GENIE Review Templates (stored on the optical cartridge) into 
eNTEGRA, as follows:

a. Verify that the optical cartridge to which you archived the Review 
Templates and/or User Protocols is inserted in the optical drive.

b. Click the Archive tab.
c. Click the Device tab corresponding to the Optical Drive.
d. Click the [Attach] button.
e. Click the [Directory] button.
f. Select the patient “CORRECTIONS DIRECTORY” from the 

archived patients list.
g. For each system to which the Review Templates are to be restored:

i. Select the relevant database.

ii. Click on the [Retrieve] button.

8. Retrieve the User Protocols from the optical cartridge as follows:

a. Select the database you to which you want to restore the User 
Protocols.

b. Locate the Aladdin Protocols study within the optical directory and 
select it.

c. Click the [Retrieve] button to copy the Aladdin Protocols study to 
the selected database.

d. Activate the Aladdin Archive application from within the 
Housekeeping category.
eNTEGRA P&R Service Manual -3 Rev. 5
Direction 2263784-100 June 17, 2001



Upgrading From GENIE P&R
e. For each user protocol to be restored:
i. Click on the [Load a Script] button.

ii. From the opened list, select the database to which the user 
protocols will be restored.

iii. From the opened list, select the protocol you wish to load.

iv. Click on the [OK] button.

The message Loading... appears in the upper left corner of the 
tab card.
The message Load Completed appears in the upper left corner 
of the tab card.
The database from which the protocol was loaded (for example, 
‘local’) and the protocol name (for example, ‘CARDREVIEW’) 
are listed on the processing screen. 
The protocol name is added to the Protocol Open list within the 
Aladdin Card.
If a protocol of the same name already exists, an appropriate 
warning appears.

f. When all the User Protocols have been restored, install each user 
protocol under the relevant category as follows:
i. Click the Aladdin icon located below the Patient Selector.
ii. Pull down the File menu on the Aladdin card and open the 

relevant user protocol.

iii. Pull down the File menu on the Aladdin card and select the 
Install entry.

iv. In the opened Install dialog, select the protocol name and the 
relevant category, make sure that Publish is set to YES, then 
click [OK].

   Important Keep the GENIE backup optical cartridge for reference.
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Low-level Format
A.3    Low-level Format
1. Power up the system.

2. During the boot up sequence press <F6> to enter the SCSISelect utility.

3. Move the highlight to SCSI Disk Utilities and press <Enter>.

4. Highlight SCSI ID #0: SEAGATE and press <Enter>.

5. Highlight Format Disk and press <Enter>.

6. Move the highlight to Yes and press <Enter> to begin low-level format.

7. Move the highlight to Yes and press <Enter> to confirm low-level 
format.
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Appendix B -  Software Installation on HP Kayak

B.1    Overview
This appendix provides detailed instructions for installing the basic software 
of the eNTEGRA system on the HP Kayak computer, referred to as software 
load from cold.

For software load from warm and for installing the eNTEGRA software 
options and licences, refer to the related sections in Chapter 6. 

Software load from cold is used when the hard disk is corrupted or replaced, 
and the entire package must be installed from scratch.

B.1.1    Time Required
The time required to complete the installation of the basic software is 
1.5 hours (about 90 minutes).

CAUTION
Load from cold is a destructive procedure and all the data on the disk will 
be lost.
Verify that all patient data is backed up.
Back up the Archive Log Index directory (C:\ArcLog) before starting the 
software load from cold procedure.
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Overview
B.1.2    Procedure Overview
The load from cold procedure consists of the following steps, to be performed 
in the given order:

1. Installing the Windows NT Operating System on page B-3, including disk 
partitioning and formatting Drive C:

2. Installing Windows NT Networking on page B-4 
3. Installing Service Pack 6a on page B-7 
4. Installing the Display Driver & Adjusting the Display on page B-8 

5. Installing the Sound Driver on page B-9 

6. Installing the HP Multimedia Keyboard Utility on page B-9 

7. Installing Service Pack 6a on page B-10 

8. Setting System Options on page B-10 

9. Installing Internet Explorer 5 on page B-13 

10. Installing RAS, Modem, and TCP/IP for Printing on page B-14 

11. Installing the FTP Service on page B-15 

12. Formatting Drive D: as NTFS on page B-16 

13. Installing the eNTEGRA Application and Its Accessory Components on 
page B-17 

14. Configuring the system, as per Section 3.8 on page 3-14.
15. Configuring the Network, as per Section 3.9 on page 3-28.
16. Configuring the Hardcopy Devices, as per Section 3.10 on page 3-33.
17. Performing the Functional Checks detailed in Section Chapter 4 -.
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Installing the Windows NT Operating System
B.2    Installing the Windows NT Operating System
1. Turn ON the system and immediately insert the NT Installation CD.

2. When the HP Kayak opening screen appears, press <F8> for Boot Order.
3. From the opened Boot Menu, select ATAPI CD–ROM Drive and press 

<Enter>.
The setup program is loaded.

4. When prompted, press <Enter> to continue.
5. When prompted, press <Enter> to continue.
6. In the opened licence Agreement page, scroll down to the bottom 

using the <PgDw> key, and press <F8>.
7. If the displayed list matches your computer, press <Enter>.
8. Upon the message Create the following partitions in the (whole 

disk) unpartitioned space:
a. Press <C>, delete the number displayed. 
b. If Hard Disk size is > 9GB, type 3000 for drive C: and press 

<Enter>.
Otherwise (for 4 GB Hard Disks), type 1700 for drive C: and press 
<Enter>.

c. Press the <↓> key.
d. Press <C> and accept the defaults by pressing <Enter>.
e. While the 1st partition is highlighted, press <Enter> to install 

Windows NT on drive C:
9. Install Windows NT as follows:

a. In the opened dialog, use the <↓> key to highlight the line Format 
using NTFS and press <Enter>.
Drive C: will be formatted. It may take several minutes.

b. When prompted, press <Enter> twice to start copying the NT files.
c. Upon system prompt, remove the Windows NT CD.
d. When prompted, press <Enter> to reboot.

10. After reboot, the installation continues followed by another automatic 
reboot.

11. When prompted, insert the NT installation CD into the CD drive and 
click [OK].

12. Proceed to Installing Windows NT Networking on page B-4.
eNTEGRA P&R Service Manual -3 Rev. 5
Direction 2263784-100 June 17, 2001



Installing Windows NT Networking
B.3    Installing Windows NT Networking
1. In the Windows NT Setup window, click [Next] to continue.

2. In the opened Setup Options window, select Typical and click [Next].
3. In the opened Name and Organization window, type–in your 

site_name and organization_name and click [Next].
4. In the Registration window, type–in your product_ID (recorded on the 

provided manual) and click [Next].
5. When prompted, type–in your computer name, as defined in the pre–

installation checklist, and click [Next].
6. When prompted, type–in your password, as defined in the pre–

installation checklist (the following description will use the password 
elgems).

7. Retype the password and click [Next].
8. When prompted, select no, do not create an emerging repair disk, 

and click [Next].
9. In the opened Windows NT Components dialog, select “Install the 

most common components” and click [Next].
10. Upon the message “Installing Windows NT networking”, click 

[Next].
11. Check  “Do not connect this computer to a network at this time” 

and click [Next].
12. In the opened Date/Time Properties window:

a. Set the appropriate date and time in the Date & Time page.
b. Click the Time Zone tab, click on the down arrow to display the 

Time Zone list, select the appropriate Time Zone and click [OK].
c. Click [Close]. 

13. If the system finds the video adapter, click [OK], then click [Cancel] for 
Video card driver installation, which will be installed later. 

14. When asked to restart the computer, remove the windows NT CD and 
press the [Restart] button.

15. When prompted, press <Alt> + <Ctrl> + <Del> and login into the system 
with:

User Name: Administrator
Password: elgems (the password entered at Step 6 above)

16. For systems with 3Com adapters only:
a. Insert the eNTEGRA Application CD into the CD-ROM drive.
b. Select Start → Programs → Windows NT Explorer 

Note
As long as the display driver is not installed, an Invalid Display Settings error 
message will be displayed after each reboot. Click [OK] and ignore the message. 
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Installing Windows NT Networking
c. Browse to D:\Drivers and double click on Driver.exe 
For AMD PCnet network adapter, insert the Windows NT CD into the 
CD-ROM drive.

17. Click with the right mouse button on the Network Neighborhood icon 
on the desktop.

18. Click on the Properties entry.
19. Click [Yes] to confirm that networking is to be installed. 

20. Click [Next] 
21. In the Network window, click on Adapters tab.
22. Click [Add]: 

• For AMD PCnet network adapter, highlight the AMD PCNET 
Family Ethernet Adapter and click [OK].

• For 3Com 905B network adapter, click on [Have disk], type–in the 
path C:\Drivers\3Com and click [OK] twice.

23. In the Network window, click on Protocols tab.
24. Click [Add] and highlight TCP/IP Protocol and click [OK].
25. Upon the message “If there is a DHCP...” click [NO].
26. In the opened Microsoft TCP/IP Properties window, click the IP 

Address tab, and:
a. Type–in your IP address (as defined in the pre–installation 

checklist).
b. If relevant, type–in your Subnet Mask.
c. If relevant, type–in your Default Gateway address (as defined in 

the pre–installation checklist)
27. If relevant, click the DNS tab, and type–in the DNS IP address (defined 

in the pre–installation checklist)
28. If relevant, click the WINS tab, type–in the Windows Server primary and 

secondary IP addresses (defined in the pre–installation checklist), and 
click [OK] at the bottom of the page.

29. Upon system prompts, click [Next], [Next], [Finish].
30. Define the users as follows:

a. When prompted, press <Alt> + <Ctrl> + <Del> and login into the 
system with:

User Name: Administrator
Password: elgems (the password entered at Step 6 above)

b. In the opened Welcome window, click [Close].
c. In the Display Properties dialog, click [Cancel].
d. Click the [Start] button on the Task Bar at the bottom of the screen 

and select Programs → Administrative Tools → User 
Manager.
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Installing Windows NT Networking
e. In the User Manager window, click on User in the Menu Bar and 
select the New User entry.

f. Uncheck “User Must Change Password at Next Logon”.
g. Click the checkbox next to “Password Never Expires”.
h. Click the [Groups] button.
i. In the Group Memberships window, move the Administrators 

from the Not member list to the Member list by clicking 
Administrators (if not already highlighted) and then clicking the 
[<Add] button.

j. Click [OK]. The program reverts to the User Manager window.
k. Enter:

Username: entegra
Password: entegra
Confirm Password: entegra

l. Click [OK] again.
m. Close the User Manager window. 

31. Click the [Start] button on the Task Bar at the bottom of the screen and 
select Shutdown the system.

32. In the Shut Down window, click “Close all programs and log as a 
different user?”, then click [Yes]. 

33. When prompted, press <Alt> + <Ctrl> + <Del> and login into the system 
with:

Username: entegra
Password: entegra

34. Proceed to Installing Service Pack 6a on page B-7.
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Installing Service Pack 6a
B.4    Installing Service Pack 6a
This installation depends on the language being used.

1. For English version: Insert the eNTEGRA Application CD into the CD 
Drive and double click the My Computer icon located on the desktop.

For other languages: Insert the eNTEGRA Accessories Software CD into 
the CD Drive and double click the My Computer icon located on the 
desktop.

2. Double click the (D:) drive (CD–ROM Drive).
3. Double click the SP6 directory.
4. For the English version, skip to step 5, below.

For other languages, double click the applicable language directory.

5. Double click SP6ai386.exe.
6. Check the Accept License Agreement box, if requested.
7. Uncheck “Backup files necessary to uninstall service pack...”.
8. Click [Install].
9. When prompted, click on [Restart] to reboot the system and logon as before.
10. Proceed to Installing the Display Driver & Adjusting the Display on page 

B-8.
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Installing the Display Driver & Adjusting the Display
B.5    Installing the Display Driver & Adjusting the Display
The display card for the HP Kayak Xeon is Millennium G200. To install the 
Millennium G200 driver and adjust the display:

1. Ensure that the eNTEGRA CD is inserted into the CD drive.

2. Click the Right mouse button on an empty place on the desktop.
3. In the opened menu, select the Properties entry.
4. In the Display Properties window, click the Settings tab.
5. Click the [Display Type...] button.
6. Click [Change...] button.
7. Click on the [Have Disk] button.
8. Type–in the path: D:\drivers\Matrox and click [OK].
9. Select Matrox Graphics Millennium g200.
10. Click [OK], [YES], [OK].
11. Close the Display Type window.
12. Close the Display Properties window.
13. Click [YES] to restart the computer.
14. When prompted, press <Alt> + <Ctrl> + <Del> and login into the system 

with:
Username: entegra
Password: entegra

15. Click the with the Right mouse button on an empty place on the desktop.
16. In the opened menu, select the Properties entry.
17. In the Display Properties window, click the Settings tab.
18. Click the down arrow under the Color Palette, and select True Color.
19. Move the slider in the Desktop Area to display a resolution of 

1280 by 1024 pixels.
20. Click the down arrow under Font Size and select Small Fonts. 
21. Click the down arrow under Refresh frequency and select 75 Hertz.
22. Click the [Test] button.
23. Click [OK] to display the test screen.
24. In the testing Mode window, click [Yes] if you have seen the bitmap 

properly. 
25. In the Display Properties window, click the [OK].
26. Proceed to Installing the Sound Driver on page B-9.
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Installing the Sound Driver
B.6    Installing the Sound Driver
1. If necessary, insert the eNTEGRA CD-ROM to the CD-ROM drive.

2. Double click the My Computer icon on the Desktop.
3. Double-click Control Panel.
4. Double click Multimedia and click the Devices tab.
5. Click, [Add], select Unlisted or Updated Driver and click [OK].
6. Type in the path to the driver installation files D:\Utils\Audio\ and click 

[OK], where D: refers to the CD-ROM drive.
7. When the Analog Devices SoundComm Driver dialog appears, click 

[OK].
8. If the “Driver Exists” window appears, click on the [New] button.
9. Click [OK] in the “Configure Analog Devices SoundComm” 

Window.
10. Click [No] to avoid computer restart, and continue to Installing the HP 

Multimedia Keyboard Utility on page B-9. 

B.7    Installing the HP Multimedia Keyboard Utility
1. If necessary, insert the eNTEGRA CD-ROM to the CD-ROM drive.

2. Using Windows Explorer, locate the directory D:\utils\Keyboard\ 
where D: refers to the CD-ROM drive.

3. Double click on the Setup icon to initiate the installation (setup.exe).
4. Follow the instructions displayed on the screen.
5. Click on [Finish] to restart your computer and proceed to Installing 

Service Pack 6a on page B-10.
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B.8    Installing Service Pack 6a
This installation depends on the language being used.

1. For English version: Insert the eNTEGRA Application CD into the CD 
Drive and double click the My Computer icon located on the desktop.

For other languages: Insert the eNTEGRA Accessories Software CD into 
the CD Drive and double click the My Computer icon located on the 
desktop.

2. Double click the (D:) drive (CD–ROM Drive).
3. For the English version, skip to step 4, below.

For other languages, double click the applicable language.

4. Double click the SP6 directory.
5. Double click SP6ai386.exe.
6. Check the Accept License Agreement box, if requested.
7. Uncheck “Backup files necessary to uninstall service pack...”.
8. Click [Install].
9. When prompted, click on [Restart] to reboot the system and logon as before.
10. Proceed to Setting System Options on page B-10.

B.9    Setting System Options
Set the following operating system configurations in the given order:
1. Setting the Date Format on page B-11 
2. Setting the Application Event Viewer Loggings on page B-11 
3. Setting the Task Bar Properties on page B-11 
4. Setting the Virtual Memory on page B-12 
5. Setting the View Options on page B-12 
6. When done, proceed to Installing Internet Explorer 5 on page B-13.
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B.9.1    Setting the Date Format
1. Click left on the [Start] icon on the Tasks Bar, and select: Setting → 

Control Panel.
2. On the Control Panel window, double click on the Regional Settings icon.
3. Click on the Date tab.
4. Click the down arrow at the Short data style field, select the format:

MM/dd/yyyy and click [OK].

B.9.2    Setting the Application Event Viewer Loggings
1. Click left on the [Start] icon on the Tasks Bar, and select: Programs ➝  

Administrative Tools (common) ➝  Event Viewer.
2. Click the Log option in the Menu Bar, and select the Application entry.
3. Click the Log option in the Menu Bar, and select the Log settings... 

entry.
4. In the Event Log Settings window, check the Overwrite Events as 

Needed field Logs.
5. Click [OK].
6. Close the Event Viewer window.

B.9.3    Setting the Task Bar Properties
1. Click right on an empty place of the Task Bar, and select the Properties 

entry.

2. In the opened Task Bar Properties window, uncheck the Always on 
top option.

3. Click [OK] to close the Task Bar Properties window.
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B.9.4    Setting the Virtual Memory
1. Click right on My Computer icon and select the Properties entry.

2. Click on the Performance tab.
3. Click the [Change] button.
4. With Drive C: highlighted, change the Initial Size (MB) to 540.
5. Change the Maximum Size (MB) to 560.
6. Click the [Set] button.
7. Click [OK] and close the Virtual Memory window.
8. Close the System Properties window.
9. When prompted, click [Restart] to reboot the system.

B.9.5    Setting the View Options
1. When the system reboots and prompts, press <Alt> + <Ctrl> + <Del> 

and login into the system with:

Username: entegra
Password: entegra

2. Double click My Computer icon.
3. In the opened My Computer window, click the View option in the Menu 

Bar and select the Options entry.
4. In the Options window, click the Folder tab.
5. Click the radio button next to Browse folder by using a single 

window that changes as you open each folder, then click the 
[Apply] button.

6. Click the View tab in the Options window.
7. Click the radio button next to Show all files option.
8. Uncheck the option Hide file extensions for known file types, click 

[Apply] and close the Options window.
9. Close My Computer window.
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B.10    Installing Internet Explorer 5
1. For the English version, skip to Step 2, below.

For other languages, replace the eNTEGRA application CD with the 
eNTEGRA Accessories Software CD.

2. Double click on My Computer icon located on the desktop.
3. Double click the D:\ drive (CD–ROM Drive).
4. For the English version, skip to Step 5, below.

For other languages, double click the applicable language.

5. Double click the IE5 directory.
6. Double click install.bat.
7. When installation has been completed, the system will reboot.
8. Proceed to Installing RAS, Modem, and TCP/IP for Printing on page B-

14.
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B.11    Installing RAS, Modem, and TCP/IP for Printing
Installation of the Remote Access Service (RAS) is required for DICOM Part 10.

1. When the system comes up, press <Alt> + <Ctrl> + <Del> and login into 
the system with:

Username: entegra
Password: entegra

2. Click [OK].
3. Insert the Windows NT Workstation CD-ROM and close the opened 

Windows CD window.
4. Click right on the Network Neighborhood icon on the desktop and 

select the Properties entry.

5. In the opened Network window, select the Services tab to display the 
currently installed services.

6. In the Services tab click [Add], select Microsoft TCP/IP Printing .

7. Click [OK], type D:\i386 <Enter>, where D: is your CD-ROM drive and 
click [Continue].

8. In the Services tab click [Add], select the Remote Access Service 
entry and click [OK].

9. If needed, change the path displayed to D:\i386 where D is your
CD-ROM drive, and click [Continue]. 

10. The Remote Access Service files will be copied. 
11. When the following message appears: There are no RAS...., click 

[Yes] to invoke Modem Installer.
12. In the opened Install New Modem dialog, check the Don’t detect my 

modem... and click [Next].
13. For systems with a modem installed, select the modem manufacturer and 

model from the scrollable list and click [Have Disk].
For systems with no modem installed, select Standard type, click 
[Next], select COM2 and click [Next], [OK], [Continue]. 

14. If required, insert the manufacturer’s installation diskette into the floppy 
drive, browse to the appropriate directory using the [Browse] button, 
then click [OK].
The modem drivers are copied to the hard disk.

15. Click the [Properties] button and enter the modem properties.
16. Remove the Windows NT CD from the drive.

17. Close the Network Properties window and click [Yes] to restart the system.

18. Proceed to Installing the FTP Service on page B-15.
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B.12    Installing the FTP Service
1. Insert the Windows NT CD into the CD drive.

2. Right click the Network Neighborhood icon on the desktop, and select 
Properties to display the Network dialog.

3. Click the Service tab and click the [Add] button.
4. From the opened Select Network Service list, select Microsoft Peer 

Web Server and click [OK].
5. In the Installed from: input field, enter D:\i386 (where D: is your CD 

drive), and click [OK].
6. On the opened Microsoft Peer Web Services Setup dialog, click 

[OK].
7. In the opened Options list, deselect all options except FTP Service and 

Internet Service Manager, then click [OK].
8. Click [Yes] to create the prompted directory.
9. In the FTP Publishing Directories input field type C:\Insite and click 

[OK]. If required, acknowledge by clicking [Yes] to create the Insite 
directory.

10.  When the installation has been complete successfully, click [OK].
11. Click [Close] in the Network dialog.
12. Click [Start] on the task bar and select Programs → Microsoft Peer 

Web Services → Internet Service Manager. 
13. Double click the Computer Name entry to open the FTP Service 

properties for entegra dialog.
14. On the Service tab, uncheck Allow only anonymous connections, 

and confirm by clicking [Yes].
15. Click the Directories tab, select the displayed entry, click [Edit 

Properties...], check (click) the Write property, then click [OK].
16. Click [Add], enter C: in the Directory field, enter /C in the Alias field, 

click the Write checkbox located at the bottom of the screen, and click 
[OK].

17. Click [Add], enter D: in the Directory field, enter /D in the Alias field, 
click the Write checkbox located at the bottom of the screen, and click 
[OK].

18. Click [OK] and close the Microsoft Internet Service Manager 
dialog.

19. Proceed to Formatting Drive D: as NTFS on page B-16.
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B.13    Formatting Drive D: as NTFS
1. Click on the [Start] button in the Task Bar, and select: Programs → 

Administrative Tools (common) → Disk Administrator.
2. Click [OK].
3. In the Disk Administrator dialog, click right on the letter assigned to 

the CD-ROM, and select Assign Driver Letter... 
4. From the Assign drive letter drop-down list, select E: and click [OK].
5. In the confirm window, click [Yes].
6. In the Disk Administrator dialog, click right on Free Space., and in 

the pop-up window click [Create].
7. When asked, click [Yes], [OK] and [Yes].
8. In the Disk Administrator dialog, select Exit from the Partition drop-

down menu.
9. When asked, click [Yes] to save the partition, then click [OK] twice.
10. Double click on My Computer icon located on the desktop.
11. Right click on D: drive icon.
12. Select the Format... entry.
13. Click the down arrow in the File System field and select NTFS entry.
14. Click the [Start] button.
15. The following warning will be displayed:

WARNING: formatting will erase all data on this disk. 
Select OK to format the disk, Cancel to abort.

Click OK.
The disk will be formatted.

16. Upon system prompt Format Complete, click [OK].
17. Click [Close].
18. Proceed to Installing the eNTEGRA Application and Its Accessory 

Components on page B-17.
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B.14   Installing the eNTEGRA Application and Its Accessory 
Components

1. Insert the eNTEGRA CD-ROM to the CD-ROM drive.

2. Double click on My computer icon located on the desktop.

3. Double click the (E:) drive (CD–ROM Drive).
4. Double click Install.vbs.
5. Click on [OK].
6. When prompted, insert the licences diskette into the floppy drive, attach 

the Activator onto the parallel port on the back panel of the computer and 
click [OK].

7. Click [Yes] and wait for the installation of the HASP Device Driver 
Setup program to complete.

8. On the Warning window displayed, click [Yes] to continue with the 
setup program.

9. In the HASP Device Driver status dialog, click [Next].
10. In the Setup Option window, click [Typical].
11. In the Confirm Your Selection window, click [Next].
12. When the message The HASP Device Driver has been 

successfully installed appears, click [OK], [Finish].
13. In the Acrobat installation, click [Next], [Next].
14. Select [No] when asked to reboot.
15. From the eNTEGRA CD, double click eNTEGRA_LFC.vbs.
16. In the QGS installation, click [Next], [Finish].
17. In the Demo Database installation, click [Next], [Next], [Next] and 

then [Finish].
18. In the eNTEGRA Application installation, click [Next], [Next], 

[Next].
19. When asked, click the radio button next to the applicable language, then 

click [Next], [Next].
20. If requested, replace the eNTEGRA Application CD with the eNTEGRA 

On-line Help CD.
Otherwise, skip to step 22, below.

21. Click [Next], [Next] and then [Finish].
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Appendix C -  Software Installation on Dell Precision 610

C.1    Overview
This appendix provides detailed instructions for installing the basic software 
of the eNTEGRA system on the Dell precision 610 computer, referred to as 
software load from cold.

For software load from warm and for installing the eNTEGRA software 
options and licences, refer to the related sections in Chapter 6. 

Software load from cold is used when the hard disk is corrupted or replaced, 
and the entire package must be installed from scratch.

C.1.1    Time Required
The time required to complete the installation of the basic software is 
1.5 hours (about 90 minutes).

CAUTION
Load from cold is a destructive procedure and all the data on the disk will 
be lost.
Verify that all patient data is backed up.
Back up the Archive Log Index directory (C:\ArcLog) before starting the 
software load from cold procedure.
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C.1.2    Procedure Overview
The load from cold procedure consists of the following steps, to be performed 
in the given order:

1. Installing the Windows NT Operating System on page C-3, including disk 
partitioning and formatting Drive C:

2. Installing Windows NT Networking on page C-5 
3. Installing Service Pack 6a on page C-8 
4. Installing the Display Driver on page C-8 
5. Adjusting the Display Properties on page C-9 

6. Installing the Sound Driver on page C-10 
7. Setting System Options on page C-10 
8. Installing Internet Explorer 5 on page C-12 
9. Installing RAS, Modem, and TCP/IP for Printing on page C-13 
10. Installing the FTP Service on page C-14 

11. Formatting Drive D: as NTFS on page C-15 

12. Installing the eNTEGRA Application and Its Accessory Components on 
page C-16 

13. Configuring the system, as per Section 3.8 on page 3-14.
14. Configuring the Network, as per Section 3.9 on page 3-28.
15. Configuring the Hardcopy Devices, as per Section 3.10 on page 3-33.
16. Performing the Functional Checks detailed in Section Chapter 4 -.
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C.2    Installing the Windows NT Operating System
1. Turn ON the system and immediately insert the NT Installation CD.

2. When the words Windows NT Setup appear at the top of the screen, 
press <F6> repeatedly until the full Windows NT Setup screen appears 
and the white line at the bottom of the screen shows the option 
S=Specify Additional Device.

3. Press <S>. The SCSI Adapter list appears with Other selected.

4. Press <Enter> and insert the diskette labeled SCSI Driver 2940U2 for 
NT 4.0 into the floppy drive.

5. Press <Enter> again. The list of SCSI Adaptec AHA adapters appear 
with the last item selected (Adaptec AHA-294xU2/295xU2/AIC-789x PCI 
SCSI Controller).

6. Press <Enter> once again. The system loads the driver and it is added to 
the list of mass storage devices whose support is to be loaded.

7. Press <Enter> to initiate file loading. 

8. When the ’Welcome to Setup’ screen appears, press <Enter> to continue.
9. When prompted, press <Enter> twice to continue.
10. In the opened licence Agreement page, scroll down to the bottom 

using the <PgDw> key, and press <F8>.
11. If the disk does not have NT installed, a message is displayed, press 

<Enter>.

Otherwise (the disk already has NT installed) a message is displayed. 

a. Press <N> = New, to reinstall NT. 
b. Press <Enter>
c. Press <D> = Delete to delete the current partition.
d. Press <Enter>
e. Press <L> = Delete.
f. If there is an additional partition, press the <↓> key to highlight it 

and repeat the procedure to delete this partition (press D then press 
<Enter> and press L).

12. Upon the message Create the following partitions in the (whole 
disk) unpartitioned space:
a. Press <C> to create a new partition
b. Delete the number displayed by pressing <Backspace>.
c. Type 3000 and press <Enter>.
d. Press the <↓> key.
e. press <C> and accept the defaults by pressing <Enter>. 
f. While the 1st partition is highlighted, press <Enter> to install 

Windows NT on drive C:
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13. Install Windows NT as follows:
a. In the opened dialog, use the <↓> key to highlight the line Format 

using NTFS and press <Enter>.
Drive C: will be formatted. This may take several minutes.

b. When prompted, press <Enter> twice to start copying the NT files.
c. Upon system prompt, remove the Windows NT CD and the floppy.
d. When prompted, press <Enter> to reboot.

14. After reboot, the installation continues followed by another automatic 
reboot.

15. When prompted, insert the NT installation CD into the CD drive and 
click [OK].

16. Proceed to Installing Windows NT Networking on page C-5.
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C.3    Installing Windows NT Networking
1. In the Windows NT Setup window, click [Next] to continue.

2. In the opened Setup Options window, select Typical and click [Next].
3. In the opened Name and Organization window, type–in your 

site_name and organization_name and click [Next].
4. In the Registration window, type–in your product_ID (recorded on the 

provided manual) and click [Next].
5. When prompted, type–in your computer name, as defined in the pre–

installation checklist, and click [Next].
6. When prompted, type–in your password, as defined in the pre–installation 

checklist (the following description will use the password elgems).
7. Retype the password and click [Next].
8. When prompted, select no, do not create an emergency repair 

disk, and click [Next].
9. In the opened Windows NT Components dialog, select “Install the 

most common components” and click [Next].
10. Upon the message “Installing Windows NT networking”, click 

[Next].
11. Check  “Do not connect this computer to a network at this time” 

and click [Next].
12. Click [Finish] to finish setup.
13. In the opened Date/Time Properties window:

a. Set the appropriate date and time in the Date & Time page.
b. Click the Time Zone tab, click on the down arrow to display the 

Time Zone list, select the appropriate Time Zone and click [OK].
c. Click [Close]. 

14. If the system finds the video adapter, click [OK], then click [Cancel] for 
Video card driver installation, which will be installed later, as described in 
the next section – Procedure Overview on page C-8. 

15. When asked to restart the computer, remove the Windows NT CD and 
press the [Restart] button.

16. When prompted, press <Alt> + <Ctrl> + <Del> and login into the system 
with:

User Name: Administrator
Password: elgems

17. Click <OK>.
18. In the Welcome screen that is opened, click [Close].

Note
As long as the display driver is not installed, an Invalid Display Settings error 
message will be displayed after each reboot. Click [OK] and ignore the message. 
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19. Insert the eNTEGRA Application CD into the CD-ROM drive.
20. Double click: My computer → (D:) drive (CD-ROM Drive) → Drivers 

→ Drivers.exe.
21. Click [OK]
22. Click right on the Network Neighborhood icon on the desktop.
23. Click on the Properties entry.
24. Click [Yes] to confirm that networking is to be installed. 
25. Click [Next] 
26. Click on [Select From List...].
27. In the Select Network Adapter window, click on [Have Disk...]
28. Type–in the path C:\Drivers\3Com
29. Click [OK] twice.
30. Click [Next] 4 times. 
31. Remove the eNTEGRA CD and insert the Windows NT CD. 
32. Wait for the Windows NT CD window to open and close it.
33. In the Windows NT Setup window, type in the path: E: and click 

[Continue]. 
34. Upon the message “If there is a DHCP...” click [NO].
35. In the opened Microsoft TCP/IP Properties window, click the IP 

Address tab, and:
a. Type–in your IP address (as defined in the pre–installation checklist).
b. If relevant, type–in your Subnet Mask.
c. If relevant, type–in your Default Gateway address (as defined in 

the pre–installation checklist)
36. If relevant, click the DNS tab, and type–in the DNS IP address (defined 

in the pre–installation checklist)
37. If relevant, click the WINS tab, type–in the Windows Server primary and 

secondary IP addresses (defined in the pre–installation checklist)
38. Click [OK] at the bottom of the page.
39. Upon system prompts, click [Next], [Next], [Next] and [Finish].
40. When queried whether to shutdown, remove Windows NT CD from the 

drive and click [Yes].
41. When prompted, press <Alt> + <Ctrl> + <Del> and login as follows:

User Name: Administrator
Password: elgems

42. Click [OK].
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43. Define the users as follows:
a. Click the [Start] button on the Task Bar at the bottom of the screen 

and select Programs → Administrative Tools → User 
Manager.

b. In the User Manager window, click on User in the Menu Bar and 
select the New User entry.

c. Uncheck “User Must Change Password at Next Logon”.
d. Click the checkbox next to “Password Never Expires”.
e. Click the [Groups] button.
f. In the Group Memberships window, click Administrators (if 

not already highlighted) and then click the [<Add] button. The    
Administrators entry moves from the Not member of list to the 
Member of list.

g. Click [OK]. 
h. In the New User window enter:

Username: entegra
Password: entegra
Confirm Password: entegra

i. Click [OK] again.
j. Close the User Manager window. 

44. Click the [Start] button on the Task Bar at the bottom of the screen and 
select Shutdown the system.

45. In the Shut Down window, select “Close all programs and log as a 
different user?”, then click [Yes]. 

46. When prompted, press <Alt> + <Ctrl> + <Del> and login into the system 
with:

Username: entegra
Password: entegra

47. Click [OK].
48. Close the Welcome window.
49. Proceed to Installing Service Pack 6a on page C-8.
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C.4    Installing Service Pack 6a
This installation depends on the language being used.

1. For English version: Insert the eNTEGRA Application CD into the CD 
Drive and double click the My Computer icon located on the desktop.

For other languages: Insert the eNTEGRA Accessories Software CD into 
the CD Drive and double click the My Computer icon located on the 
desktop.

2. Double click the (D:) drive (CD–ROM Drive).
3. Double click the SP6 directory.
4. For the English version, skip to step 5, below.

For other languages, double click the applicable language directory.

5. Double click SP6ai386.exe.
6. Check the Accept License Agreement box, if requested.
7. Uncheck “Backup files necessary to uninstall service pack...”.
8. Click [Install].
9. When prompted, click on [Restart] to reboot the system and logon as before.
10. Proceed to Installing the Display Driver on page C-8.

C.5     Installing the Display Driver
1. When prompted, press <Alt> + <Ctrl> + <Del> and login into the system 

with:

Username: entegra
Password: entegra

2. Click [OK].
3. In the opened Welcome window, click on the checkbox for "Show this 

Welcome..." to deselect it and click [Close].
4. In the opened Welcome window uncheck “Show this welcome...” if it is 

shown, and click [Close].

5. Insert the eNTEGRA CD into the CD drive.

6. Double click: My computer → (D:) → Drivers → G400 → Setup.exe.

7. In the Setup window select the installation language, and click [Next], 
then [Typical], then [Next] again and then [Finish].

8. Proceed to Adjusting the Display Properties on page C-9.
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C.6    Adjusting the Display Properties
1. When the system comes up, press <Alt> + <Ctrl> + <Del> and login into 

the system with:

Username: entegra
Password: entegra

2. Click [OK].
3. If the Invalid Display Settings window is opened, click [OK].
4. The Display Properties window is opened to the Settings tab.
5. Click the down arrow under the Color Palette, and select True Color.
6. Move the slider in the Desktop Area to display a resolution of 

1280 by 1024 pixels.
7. Click the down arrow under Font Size and select Small Fonts. 
8. Click the down arrow under Refresh frequency and select 75 Hertz.
9. Click the [Test] button.
10. Click [OK] to display the test screen.
11. In the testing Mode window, click [Yes] if you have seen the bitmap 

properly. 
12. In the Display Properties window, click [OK].
13. Proceed to Installing the Sound Driver on page C-10.
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C.7    Installing the Sound Driver
1. If necessary, insert the eNTEGRA CD-ROM to the CD-ROM drive.

2. Double click the My Computer icon on the Desktop.
3. Double-click Control Panel.
4. Double click Multimedia and click the Devices tab.
5. Click, [Add], select Unlisted or Updated Driver and click [OK].
6. Type in the path D:\Drivers\Dell_Audio for the driver installation files 

and click [OK]

           where D: refers to the CD-ROM drive.

7. A dialogue box “Add Unlisted or Updated Drivers” appears. Click 
[OK].

8. If the “Driver Exists” window appears, click on the [New] button.
9. Click [OK] in the “CrystalWare(TM) Audio Driver” Window.
10. Click [Don’t Restart Now].
11. Close the multimedia properties dialogs.

12. Close the Control Panel window and proceed to Procedure Overview 
on page C-10. 

C.8    Setting System Options
Set the following operating system configurations in the given order:

1. Setting the Date Format on page C-11 

2. Setting the Application Event Viewer Loggings on page C-11 

3. Setting the Task Bar Properties on page C-11 
4. Setting the Virtual Memory on page C-11 
5. Setting the View Options on page C-12 
6. When done, proceed to Installing Internet Explorer 5 on page C-12.
eNTEGRA P&R Service Manual -10 Rev. 5
Direction 2263784-100 June 17, 2001



Setting System Options
C.8.1    Setting the Date Format
1. Click left on the [Start] icon on the Tasks Bar, and select: Setting → 

Control Panel.
2. On the Control Panel window, double click on the Regional Settings 

icon.
3. Click on the Date tab.
4. Click the down arrow at the Short data style field, select the format:

M/d/yyyy and click [OK].

C.8.2    Setting the Application Event Viewer Loggings
1. Click left on the [Start] icon on the Tasks Bar, and select: Programs ➝  

Administrative Tools (common) ➝  Event Viewer.
2. Click the Log option in the Menu Bar, and select the Application entry.
3. Close the Event Viewer window.

C.8.3    Setting the Task Bar Properties
1. Click right on an empty place of the Task Bar and select the Properties 

entry.

2. In the opened Task Bar Properties window, uncheck the Always on 
top option.

3. Click [OK] to close the Task Bar Properties window.

C.8.4    Setting the Virtual Memory
1. Click right on My Computer icon and select the Properties entry.

2. Click on the Performance tab.
3. Click the [Change] button.
4. With Drive C: highlighted, change the Initial Size (MB) to 540.
5. Change the Maximum Size (MB) to 560.
6. Click the [Set] button.
7. Click [OK] and close the Virtual Memory window.
8. Close the System Properties window.
9. When prompted, click [Don’t Restart].
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C.8.5    Setting the View Options
1. Double click My Computer icon.

2. In the opened My Computer window, click the View option in the Menu 
Bar and select the Options entry.

3. In the Options window, click the Folder tab.
4. Click the radio button next to Browse folder by using a single 

window that changes as you open each folder, then click the 
[Apply] button.

5. Click the View tab in the Options window.
6. Click the radio button next to Show all files option.
7. Uncheck the option Hide file extensions for known file types, click 

[OK] to close the Options window.
8. Close My Computer window.

C.9    Installing Internet Explorer 5
1. For the English version, skip to Step 2, below.

For other languages, replace the eNTEGRA application CD with the 
eNTEGRA Accessories Software CD.

2. Double click on My Computer icon located on the desktop.
3. Double click the D:\ drive (CD–ROM Drive).
4. For the English version, skip to Step 5, below.

For other languages, double click the applicable language.

5. Double click the IE5 directory.
6. Double click install.bat.
7. When installation has been completed, the system will reboot.
8. Proceed to Setting the View Options on page C-13.
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Installing RAS, Modem, and TCP/IP for Printing
C.10    Installing RAS, Modem, and TCP/IP for Printing
Installation of the Remote Access Service (RAS) is required for DICOM Part 10.

1. When the system comes up, press <Alt> + <Ctrl> + <Del> and login into 
the system with:

Username: entegra
Password: entegra

2. Click [OK].
3. Insert the Windows NT Workstation CD-ROM and close the opened 

Windows CD window.
4. Click right on the Network Neighborhood icon on the desktop and 

select the Properties entry.

5. In the opened Network window, select the Services tab to display the 
currently installed services.

6. In the Services tab click [Add], select Microsoft TCP/IP Printing .

7. Click [OK], type D:\i386 <Enter>, where D: is your CD-ROM drive and 
click [Continue].

8. In the Services tab click [Add], select the Remote Access Service 
entry and click [OK].

9. If needed, change the path displayed to D:\i386 where D is your
CD-ROM drive, and click [Continue]. 

10. The Remote Access Service files will be copied. 
11. When the following message appears: There are no RAS...., click 

[Yes] to invoke Modem Installer.
12. In the opened Install New Modem dialog, check the Don’t detect my 

modem... and click [Next].
13. For systems with a modem installed, select the modem manufacturer and 

model from the scrollable list and click [Have Disk].
For systems with no modem installed, select Standard type, click 
[Next], select COM2 and click [Next], [OK], [Continue]. 

14. If required, insert the manufacturer’s installation diskette into the floppy 
drive, browse to the appropriate directory using the [Browse] button, 
then click [OK].
The modem drivers are copied to the hard disk.

15. Click the [Properties] button and enter the modem properties.
16. Remove the Windows NT CD from the drive.

17. Close the Network Properties window and click [Yes] to restart the system.

18. Proceed to Installing the FTP Service on page C-14.
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Installing the FTP Service
C.11    Installing the FTP Service
1. Insert the Windows NT CD into the CD drive.

2. Right click the Network Neighborhood icon on the desktop, and select 
Properties to display the Network dialog.

3. Click the Service tab and click the [Add] button.
4. From the opened Select Network Service list, select Microsoft Peer 

Web Server and click [OK].
5. In the Installed from: input field, enter D:\i386 (where D: is your CD 

drive), and click [OK].
6. On the opened Microsoft Peer Web Services Setup dialog, click 

[OK].
7. In the opened Options list, deselect all options except FTP Service and 

Internet Service Manager, then click [OK].
8. Click [Yes] to create the prompted directory.
9. In the FTP Publishing Directories input field type C:\Insite and click 

[OK]. If required, acknowledge by clicking [Yes] to create the Insite 
directory.

10.  When the installation has been complete successfully, click [OK].
11. Click [Close] in the Network dialog.
12. Click [Start] on the task bar and select Programs → Microsoft Peer 

Web Services → Internet Service Manager. 
13. Double click the Computer Name entry to open the FTP Service 

properties for entegra dialog.
14. On the Service tab, uncheck Allow only anonymous connections, 

and confirm by clicking [Yes].
15. Click the Directories tab, select the displayed entry, click [Edit 

Properties...], check (click) the Write property, then click [OK].
16. Click [Add], enter C: in the Directory field, enter /C in the Alias field, 

click the Write checkbox located at the bottom of the screen, and click 
[OK].

17. Click [Add], enter D: in the Directory field, enter /D in the Alias field, 
click the Write checkbox located at the bottom of the screen, and click 
[OK].

18. Click [OK] and close the Microsoft Internet Service Manager 
dialog.

19. Proceed to Formatting Drive D: as NTFS on page C-15.
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Formatting Drive D: as NTFS
C.12    Formatting Drive D: as NTFS
1. Double click on the [Start] button in the Task Bar, and select: Programs 

→ Administrative Tools (common) → Disk Administrator.
2. Click [OK].
3. In the Disk Administrator dialog, click right on the letter assigned to 

the CD-ROM, and select Assign Driver Letter... 
4. From the Assign drive letter drop-down list, select E: and click [OK].
5. In the confirm window, click [Yes].
6. In the Disk Administrator dialog, click right on Free Space., and in 

the pop-up window click [Create].
7. When asked, click [Yes], [OK] and [Yes].
8. In the Disk Administrator dialog, select Exit from the Partition drop-

down menu.
9. When asked, click [Yes] to save the partition, then click [OK] twice.
10. Double click on My Computer icon located on the desktop.
11. Right click on D: drive icon.
12. Select the Format... entry.
13. Click the down arrow in the File System field and select NTFS entry.
14. Click the [Start] button.
15. The following warning will be displayed:

WARNING: formatting will erase all data on this disk. 
Select OK to format the disk, Cancel to abort.

Click OK.
The disk will be formatted.

16. Upon system prompt Format Complete, click [OK].
17. Click [Close].
18. Proceed to Installing the eNTEGRA Application and Its Accessory 

Components on page C-16.
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Installing the eNTEGRA Application and Its Accessory Components
C.13   Installing the eNTEGRA Application and Its Accessory 
Components

1. Insert the eNTEGRA CD-ROM to the CD-ROM drive.

2. Double click on My computer icon located on the desktop.

3. Double click the (E:) drive (CD–ROM Drive).
4. Double click Install.vbs.
5. Click on [OK].
6. When prompted, insert the licences diskette into the floppy drive, attach 

the Activator onto the parallel port on the back panel of the computer and 
click [OK].

7. Click [Yes] and wait for the installation of the HASP Device Driver 
Setup program to complete.

8. On the Warning window displayed, click [Yes] to continue with the 
setup program.

9. In the HASP Device Driver status dialog, click [Next].
10. In the Setup Option window, click [Typical].
11. In the Confirm Your Selection window, click [Next].
12. When the message The HASP Device Driver has been 

successfully installed appears, click [OK], [Finish].
13. In the Acrobat installation, click [Next], [Next].
14. Select [No] when asked to reboot.
15. From the eNTEGRA CD, double click eNTEGRA_LFC.vbs.
16. In the QGS installation, click [Next], [Finish].
17. In the Demo Database installation, click [Next], [Next], [Next] and 

then [Finish].
18. In the eNTEGRA Application installation, click [Next], [Next], 

[Next].
19. When asked, click the radio button next to the applicable language, then 

click [Next], [Next].
20. If requested, replace the eNTEGRA Application CD with the eNTEGRA 

On-line Help CD.
Otherwise, skip to step 22, below.

21. Click [Next], [Next] and then [Finish].
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